Teamcenter 10.1

Getting Started with Teamcenter
Proprietary and restricted rights notice

This software and related documentation are proprietary to Siemens Product Lifecycle Management Software Inc.

© 2013 Siemens Product Lifecycle Management Software Inc. All Rights Reserved.

Siemens and the Siemens logo are registered trademarks of Siemens AG. Teamcenter is a trademark or registered trademark of Siemens Product Lifecycle Management Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks, or service marks belong to their respective holders.
# Contents

**Proprietary and restricted rights notice** .......................... 2

**Overview of Teamcenter** .......................... 1-1

Overview of Teamcenter ................................................. 1-1
Before you begin ..................................................... 1-2
Starting Teamcenter sessions .......................................... 1-2
Using preferences ..................................................... 1-6

**Using Teamcenter interfaces** .......................... 2-1

Teamcenter interfaces ................................................. 2-1
Using the rich client interface ...................................... 2-1
Managing your thin client interface ................................. 2-24
Business Modeler IDE interface ....................................... 2-31
Teamcenter Client for Microsoft Office ................... 2-31

**How Teamcenter supports product life cycle phases** .......................... 3-1

How Teamcenter supports product life cycle phases .................. 3-1
Systems engineering and requirements ............................... 3-2
Managing design data and product structures ...................... 3-2
Manufacturing process management .................................. 3-4
Workflow and change management ..................................... 3-4
Document management basics ......................................... 3-5
Content management .................................................. 3-8
Managing contract data ............................................... 3-8
Vendor management ................................................... 3-10
Product visualization .................................................. 3-10
Classification and reuse ............................................... 3-11
CAE Data Management ................................................ 3-11
Repeatable Digital Validation ........................................ 3-12
Maintenance, repair, and overhaul .................................... 3-12
Teamcenter solutions .................................................. 3-16
Dimensional Planning and Validation (DPV) ......................... 3-19
Electronic Design Automation (EDA) ................................ 3-19
Data sharing .......................................................... 3-20

**Common Teamcenter tasks** .......................... 4-1

Common Teamcenter tasks ............................................. 4-1
Viewing online help .................................................... 4-1
Working with data objects ............................................ 4-10
Working with folders ................................................... 4-14
Managing basic data .................................................... 4-15
Using 4th Generation Design ......................................... 4-31
Managing product structures ......................................... 4-33
Managing changes ...................................................... 4-38
Chapter

1 Overview of Teamcenter

Overview of Teamcenter .......................................................... 1-1
Before you begin ........................................................................ 1-2
Starting Teamcenter sessions ..................................................... 1-2
  Logging on to Teamcenter ....................................................... 1-2
  Start a Teamcenter rich client session ..................................... 1-4
    Logging on to the Teamcenter rich client ............................. 1-4
  Start a Teamcenter thin client session ..................................... 1-5
  Teamcenter client user settings ............................................... 1-5
Using preferences ...................................................................... 1-6
Chapter

1 Overview of Teamcenter

Overview of Teamcenter

Teamcenter is a virtual gateway to your company's product information connecting all who need to collaborate with product and process knowledge. Teamcenter enables you to digitally manage your product and manufacturing data in the context of the product lifecycle. Using Teamcenter you can:

• Provide all users in your global organization access to data in real time.

• Manage product configuration.

• Control design changes and approvals.

• Provide information to downstream applications, such as enterprise resource planning (ERP) systems.

Getting Started with Teamcenter introduces Teamcenter and the Teamcenter documentation set:

• Introduces the basic concepts of product lifecycle management and Teamcenter administration.

• Provides links to the detailed information related to the concepts described in the guide.

• Provides instructions for performing tasks that are common to many of the Teamcenter applications, such as printing information about your data, changing your user settings, and managing your desktop.

This guide is for persons responsible for:

• Gathering, viewing, and reviewing data.

• Authoring data and completing work assignments.

• Creating, configuring, and managing complex product structures.

• Creating data and related manufacturing structures and processes.

• Administering Teamcenter.

Note Teamcenter administrators should also review the Application Administration Guide and the System Administration Guide.
Chapter 1  Overview of Teamcenter

Before you begin

**Prerequisites**
Some of the applications and features described in this guide are not included with the standard Teamcenter product and must be licensed separately. For more information, contact your Siemens PLM Software representative.

**Enable Teamcenter**
Teamcenter is installed using Teamcenter Environment Manager (TEM).

For more information about installation considerations and installation procedures, see the installation guides for the operating system on which you run Teamcenter (Installation on UNIX and Linux Servers Guide, Installation on Linux Clients Guide, Installation on Windows Servers Guide, or Installation on Windows Clients Guide).

For information about installing particular options with TEM, see Teamcenter Environment Manager Help.

**Configure Teamcenter**
Teamcenter is installed and initially configured using TEM. After Teamcenter is installed, you use configuration tools, such as the Business Modeler IDE to define business objects and rules that model your company’s business processes. You use administrative tools such as the Organization application to model your company’s organization in Teamcenter, Workflow Designer to define workflow processes to manage your data, and Access Manager to implement data security.

**Start Teamcenter**
You establish a Teamcenter session when you log on to Teamcenter.

For more information, see Starting Teamcenter sessions.

For information about hardware and software requirements, see the Siemens PLM Software Certification Database: http://support.industrysoftware.automation.siemens.com/certification/teamcenter.shtml

Starting Teamcenter sessions

When you log on to a Teamcenter client, you establish a Teamcenter session.

After the session is established and Teamcenter is running, you open the application perspectives (rich client) or applications (thin client) used to perform your tasks.

For more information about working in the rich client, see Rich client application perspectives.

For more information about working in the thin client, see Thin client applications.

Logging on to Teamcenter

The initial Teamcenter logon window can vary, depending on the security configuration at your site.
Your administrator configures Teamcenter client communication system (TCCS) and Security Services to satisfy requirements in your installation.

Supported capabilities include:

- The ability to log on to Teamcenter using Security Services in an applet-free mode.
- Support for logon authentication to Teamcenter using the Kerberos protocol.
- Support for zero sign-on for Windows systems using Kerberos.
- Support for logon authentication using soft certificate and smart card authentication.

**Note**  Smart card authentication is supported only on Windows systems.

**Note**  Kerberos is a network authentication protocol that allows nodes communicating over a nonsecure client-server network to verify identities in a secure manner.

For additional information about setting up Kerberos authentication for Security Services, see *Security Services Installation/Customization*.

For example, Kerberos authentication and the zero sign-on functionality is enabled during installation by clearing the **Always prompt for user ID** check box. In this case, a system user on a Windows host who is already logged on to the system through Kerberos can launch a Teamcenter client without being prompted to log on to Teamcenter.

If your site uses proxy servers, multiple environments, or Security Services components such as single sign-on, you may be required to select an environment or respond to one or more additional authentication dialog boxes.

When a site requires both a soft certificate and a smart card authentication to log on, you are initially prompted to select which certificate to use for authentication of a two-way Secure Sockets Layer (SSL) configured environment.

- In the rich client, when the soft certificate is selected the logon proceeds using the soft certificate, but if the smart card is not inserted in the reader the logon process may still prompt users to insert their smart card. Canceling this prompt causes it to display again, but canceling it a second time allows the logon to proceed successfully using the soft certificate.

- In the thin client, users may be prompted several times during single sign-on (SSO).
  - When both the SSO Login service configured for applet suppression and the Teamcenter Web tier are protected behind a two-way SSL server, the log on to the thin client may prompt the user for smart card credentials multiple times during logon. This is caused by the number of applets launched by the thin client; each applet requires an additional challenge.
  - When the SSO Login service is configured for applet mode (*tcsso.login_service.enable_session_agent_applet* is set to true) or the Teamcenter Web tier is not protected behind the two-way SSL security, the user may see two prompts for running in applet mode.
When you try to log on to an environment configured for smart card authentication when the smart card is not inserted, the logon fails. You may need to stop and restart Teamcenter client communication system (TCCS) to clear the error.

For more information about configuring SSL and smart card authentication for Teamcenter, see the *Security Services Installation/Customization* guide.

For more information about configuring SSL as part of TCCS configuration, see the *System Administration Guide*.

For general information about Teamcenter security, see the *Security Administration Guide*.

### Start a Teamcenter rich client session

- Choose **Start→All Programs→Teamcenter→Teamcenter** or double-click the Teamcenter icon on your desktop.

  **Note** Your Teamcenter client may be installed so the menu items include a version number, such as Teamcenter 10.1.

  **Tip** If you do not have a Teamcenter shortcut icon:

  1. Choose **Start→All Programs→Teamcenter→Teamcenter**, and right-click Teamcenter.

  2. Choose **Send To→Desktop (create shortcut)**.

For information about command line options for rich client startup, see the *Client Customization Programmer’s Guide*.

**Logging on to the Teamcenter rich client**

The rich client logon window has the following fields:

- **User ID**
  
  This is a required value. User accounts are created by administrators in the Organization application. You must provide a valid account ID to interact with Teamcenter.

- **Password**

  This is a required value. Passwords are created by administrators in the Organization application.

- **Group**

  This is an optional value. A group is an organizational collection of users who share data. A user account can belong to multiple groups and must be assigned to a default group. Groups are created by administrators in the Organization application. If you do not specify a group, the default group associated with the user account is used.
• **Role**
  This is an optional value. Function-oriented cluster of users that models skills and/or responsibilities. The same roles are typically found in many groups. Roles are created by administrators in the Organization application. If you do not specify a role, the default role associated with the group is used.

• **Server**
  Specify the server to provide database access for your rich client session. Servers are configured during installation.

For information about users, passwords, groups, and roles, see the *Organization Guide*.

**Note**
Depending on whether your site uses proxy servers, multiple environments, or Security Services components such as single sign-on, you may be required to select an environment or respond to one or more additional authentication dialog boxes.

### Start a Teamcenter thin client session

1. Open the Web browser and type the URL of the Web server in the **Address** box in the following format:

   http://machine_name:port_number/application_name/webclient

   *machine_name* is the network name of the system on which the Web server is running, *port_number* is the port on which it is configured to listen for requests, and *application_name* is the deployed application name (default is tc). For example:

   http://engserve01.ugs.com:7001/tc/webclient

   or

   http://engserve01.ugs.com:7001/app1/webclient

2. Press Enter.
   The Teamcenter logon page is displayed in your browser.

3. Type your Teamcenter user name and password and click **Login**.
   Teamcenter appears in your browser. You are automatically logged on using your default group and role.

**Tip**
You can change your group or role by clicking the **User Settings** link in the navigation pane.

### Teamcenter client user settings

The Teamcenter rich client and thin client let you modify user information for current and future sessions such as:

• **Group**

• **Role**


Chapter 1  Overview of Teamcenter

- Project
- Revision Rule
- Default Group
- Location Code

**Note**  You must have administrative privileges to change some settings.

**Tip**  You can also click the user information link in the client window application header to access the User Settings dialog box.

For information about changing user settings in the Teamcenter rich client, see the Rich Client Interface Guide.

For information about changing user settings in the Teamcenter thin client, see the Thin Client Interface Guide.

### Using preferences

*Preferences* are special environment variables stored in the Teamcenter database. Preference instances are used to control the behavior and display of Teamcenter applications.

- Teamcenter provides thousands of preferences that you can use to configure the product to your specific needs.

- Administrator and nonadministrator users can configure many aspects of a session, such as the checkout directory and how often Teamcenter checks for new system mail. Preferences can apply to the entire site, a specific user, a group, or a role.

Preferences control the behavior of Teamcenter clients and servers. The rich client provides an Options dialog box that lets you interactively select to specify behaviors. The thin client also provides an Options dialog box that lets you set a more limited group of preferences.

For more information about working with preferences and using options in the rich client, see the Rich Client Interface Guide.

For more information about working with preference setting through options in the thin client, see the Thin Client Interface Guide.

**Note**  In the rich client, another set of preferences are provided by the Window→Preferences menu command. These client preferences, which are displayed and edited in the Preferences dialog box, are local to the user. These preferences are documented in the context of the applications to which they apply.
Chapter

2 Using Teamcenter interfaces

Teamcenter interfaces ................................................................. 2-1
Using the rich client interface .................................................... 2-1
   Rich client interface .............................................................. 2-2
   Rich client perspectives and views .......................................... 2-5
      Opening application perspectives in the rich client ............... 2-6
         Rich client application perspectives .............................. 2-6
         Open a rich client perspective ..................................... 2-18
         Switch between open perspectives ................................. 2-19
         Save, reset, or close a rich client perspective .................... 2-19
   Working with the rich client navigation pane .......................... 2-19
   Configuring the display of applications .................................. 2-21
   Customizing the toolbar ..................................................... 2-22
      Configuring table data display in the rich client .................. 2-22

Managing your thin client interface ............................................ 2-24
   Thin client interface .......................................................... 2-25
   Open an application in the thin client ................................... 2-26
   Thin client applications ..................................................... 2-26
   Working with the thin client navigation pane ......................... 2-28

Business Modeler IDE interface .................................................. 2-31

Teamcenter Client for Microsoft Office ....................................... 2-31
Chapter 2  Using Teamcenter interfaces

Teamcenter interfaces

Teamcenter provides several interfaces, including a rich client interface, a Web-based thin client interface, a Business Modeler IDE, and Teamcenter Client for Microsoft Office.

The rich client interface is used by authors, manufacturing authors, administrators, and other users to:

• Manage the design and configuration of product data.
• Create and maintain processes and process structures.
• Configure and maintain Teamcenter.
• Access data stored in the Teamcenter database.

The thin client interface is used by consumers, manufacturing consumers, and reviewers to:

• View data, including product structure and variant information.
• Approve data attached to a workflow task.
• Visualize 2D drawings and 3D model.

The thin client interface is ideal for suppliers, production staff, and other users who do not require extensive authoring or administrative access to Teamcenter.

The Business Modeler IDE is used by administrators to customize the Teamcenter data model and configure basic functionality.

Client for Office allows you to access Teamcenter directly through Microsoft Office Word, Excel, PowerPoint, and Outlook.

Using the rich client interface

The Teamcenter rich client, a platform-independent client implementation (Java application) for users who interact frequently with Teamcenter, runs on client hosts and serves as a gateway to your company’s product information. You can integrate and run Teamcenter’s product data management perspectives along with applications such as Microsoft Office, custom applications, Java plug-ins, or CAD/CAM/CAE applications, all from a common platform. The rich client accesses Teamcenter databases using a remote or local server.
The rich client provides a broad selection of application perspectives and views to manage your product information.

You can use the rich client to:

- Create objects.
- Check in and check out items.
- Manage tasks.

**Rich client interface**

The rich client interface has a standard menu bar and toolbar with options that vary depending on the currently active application perspective. You can place the cursor over a rich client toolbar button to display a tooltip description.

1. **Back** and **Forward** buttons  
   The Back and Forward buttons allow you to move between loaded Teamcenter applications. The small arrows next to the buttons let you select from the list of currently loaded applications.

   For more information about moving between loaded applications, see *Switch between open perspectives*. 
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2</strong></td>
<td>Application banner</td>
<td>The application banner shows the name of the active application and lists the current user and role. You can double-click the user and role to display the User Settings dialog box in which you can change your current role if multiple roles are available to your user. For information about User Settings options, see Teamcenter client user settings.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>Search box</td>
<td>The Search box provides predefined quick searches using dataset, item ID, item name, keyword search, and advanced search features. For more information about the search feature in the rich client, see the Rich Client Interface Guide.</td>
</tr>
<tr>
<td><strong>4</strong></td>
<td>Navigation pane</td>
<td>The navigation pane provides quick access to the data you use most. In addition to finding, organizing, and accessing your data, you can configure the display of the Teamcenter perspective buttons in the navigation pane to display only those perspectives that you use regularly to perform your tasks. Click the reorder button above the Search box to display the Navigation Section Ordering dialog box that lets you hide sections or change the order of sections in navigation pane. For information about configuring the navigation pane, see the Rich Client Interface Guide.</td>
</tr>
<tr>
<td><strong>5</strong></td>
<td>Application pane</td>
<td>The application pane displays the application perspectives that are open in your Teamcenter session. By default, the Getting Started application perspective displays a single Getting Started view. Application perspectives are composed of views that can be moved elsewhere in the Teamcenter window, or can be dragged out to the desktop. Such detached views remain connected to Teamcenter and continue to function in concert with other views.</td>
</tr>
<tr>
<td><strong>6</strong></td>
<td>Getting Started application button</td>
<td>Provides access to the Getting Started application.</td>
</tr>
<tr>
<td><strong>7</strong></td>
<td>Primary applications</td>
<td>Primary application buttons provide access to your most frequently used Teamcenter application perspectives.</td>
</tr>
<tr>
<td><strong>8</strong></td>
<td>Secondary applications</td>
<td>Secondary application buttons provide access to Teamcenter application perspectives you use infrequently.</td>
</tr>
</tbody>
</table>
Chapter 2  Using Teamcenter interfaces

9  Clipboard button  The clipboard button displays the Clipboard Contents dialog box, which contains references to objects that have been cut or copied from your workspace. The total number of objects on the clipboard is displayed to the right of the symbol.

For more information about the clipboard in the rich client, see the Rich Client Interface Guide.

Note  The status message area on the lower-left side of the Teamcenter window is available to any application to indicate whether the client is ready for input or is working, so the user interface may not be accepting input at that time.

The status messages on the lower-right side of the Teamcenter window indicate the status or activity of background threads for any potentially long operations.

- The default message is Working, but other messages, such as Loading children, can be supplied by the application running the background thread.

- Information shown in this area can often be observed in more detail in the Progress view.

- In the Progress view, some operation messages have a Cancel button that can be useful in cases where an operation was started but is not wanted at that time, such as when a user is loading thousands of nodes but decides that operation is not needed.

Note  On Windows systems, operational status for the rich client interface and the Teamcenter server is provided by the Teamcenter icon in the system tray.

To display the running status dialog box, click the Teamcenter icon in the system tray.
The server and user interface condition symbols show the current status of the rich client interface and the Teamcenter server.

- The server status indicates the state of the Teamcenter server:
  - The server is ready, but there is no current communication between the client and the server.
  - The server is busy.
  - The server appears to be idle.
  - The server appears to be disconnected.

- The client status indicates the condition of the rich client:
  - The user interface is responsive.
  - The user interface is unresponsive.

**Rich client perspectives and views**

Within the Teamcenter rich client user interface, application functionality is provided in *perspectives* and *views*. Some applications use perspectives and views to arrange how functionality is presented. Other applications use a single perspective and view to present information.

**Note** Your administrator can use the **HiddenPerspectives** preference to prevent the display of some Teamcenter perspectives in the rich client.

For information about editing preference values, see the *Preferences and Environment Variables Reference*.

If your site has online help installed, you can access application and view help from the rich client **Help** menu or by pressing F1.
Chapter 2  Using Teamcenter interfaces

For more information about rich client perspectives and views, see the Rich Client Interface Guide.

Opening application perspectives in the rich client

In the rich client, you can open application perspectives several ways:

- Use the navigation pane to select a primary or secondary application or to include other available applications in the primary or secondary listings.

  Tip  If the navigation pane is not visible, use the Window→Navigation Pane menu command to display it or click the Navigation Pane icon in the toolbar.

- Select a perspective using the Window→Open Perspective menu command.

- Use the shortcut menu Send To command to open a selected object in another application.

Note  Not all perspectives may be installed or licensed at your site, and your site may have added or renamed perspectives after installation. Also, the order presented by the Window→Open Perspective menu command defaults to an automatic alphabetization that gives precedence to uppercase letters over lowercase letters. The order of presentation may vary at your site.

Rich client application perspectives

<table>
<thead>
<tr>
<th>Application</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4G Designer</td>
<td>![Image]</td>
<td>Lets you manage the design data of large products such as those found in the shipbuilding, automotive and aerospace industries. Use 4G Designer to create and manage collaborative designs, partitions, worksets, subsets, and design elements. For more information about 4G Designer, see the 4th Generation Design Guide.</td>
</tr>
<tr>
<td>4G Designer-MBOM Reconciliation</td>
<td>![Image]</td>
<td>Lets you build a manufacturing bill of materials by assigning design elements from a collaborative design into a product structure representing the MBOM. For more information about the 4G Designer-MBOM Reconciliation perspective, see the Manufacturing Process Planner Guide.</td>
</tr>
<tr>
<td>Application</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ADA License</td>
<td><img src="image" alt="Button" /></td>
<td>Allows you to access International Traffic in Arms Regulations (ITAR), intellectual property (IP), and exclusion license administration capabilities as a non-DBA group Teamcenter user. For more information about ADA License, see the <a href="#">Authorized Data Access License Guide</a>.</td>
</tr>
<tr>
<td>Access Manager</td>
<td><img src="image" alt="Button" /></td>
<td>Enables administrators to control access to data in Teamcenter using the Access Manager (AM) rule tree, which is a collection of rules available at your site. For information about Access Manager, see the <a href="#">Access Manager Guide</a>.</td>
</tr>
<tr>
<td>Appearance Configuration</td>
<td><img src="image" alt="Button" /></td>
<td>Enables administrators to configure the use of appearances, which cache data to improve performance when managing large product structures. Tasks include defining the appearance sets for which the site tracks appearances and configuring the mapping of occurrence notes into appearance attributes. For information about Appearance Configuration, see the <a href="#">Appearance Configuration Guide</a>.</td>
</tr>
<tr>
<td>As-Built Manager</td>
<td><img src="image" alt="Button" /></td>
<td>Lets you manage the as-built configuration of an asset realized from a product definition structure, such as a design or manufacturing structure. This is a separately licensed application installed as an optional overlay on the standard Teamcenter product. For more information about managing as-built configurations, see the <a href="#">As-Built Manager Guide</a>.</td>
</tr>
<tr>
<td>Audit Manager</td>
<td><img src="image" alt="Button" /></td>
<td>System administrators use Audit Manager to create and control audit logs that track selected properties for specified actions in the database. For information about Audit Manager, see the <a href="#">Audit Manager Guide</a>.</td>
</tr>
<tr>
<td>Application</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Authorization</td>
<td>![Image]</td>
<td>System administrators use Authorization to grant access to Teamcenter administrative applications and utilities to users based on their group membership or their role in a group.</td>
</tr>
<tr>
<td>CAE Manager</td>
<td>![Image]</td>
<td>Lets you identify product data for analysis and create and manage corresponding CAE data.</td>
</tr>
<tr>
<td>CAE Manager (Legacy) (formerly CAE Structure Editor)</td>
<td>![Image]</td>
<td>Provides CAE Manager and Inspector views to let you manage CAE processes and procedures, including definition of components for analysis, design validation, and analysis procedure verification.</td>
</tr>
<tr>
<td>CAE Structure Designer (formerly StructureMap Builder)</td>
<td>![Image]</td>
<td>Enables you to create and manage structure map rules that can be used to generate CAE model structures.</td>
</tr>
<tr>
<td>Change Manager</td>
<td>![Image]</td>
<td>Let you track changes to a product throughout its life cycle. You propose a change to a product and then manage the entire cycle of review, approval, and implementation of the change.</td>
</tr>
<tr>
<td>Classification</td>
<td>![Image]</td>
<td>Enables you to classify and categorize your product data based on predefined attribute values.</td>
</tr>
<tr>
<td>Application</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Classification Administration</td>
<td>![Icon]</td>
<td>Enables administrators to define the groups, classes, subclasses, and views that form the Classification hierarchy. For information about Classification Administration, see the Classification Administration Guide.</td>
</tr>
<tr>
<td>Command Suppression</td>
<td>![Icon]</td>
<td>Provides Applications, Suppress Commands, and Organization views to let administrators control the display of menu and toolbar commands within Teamcenter perspectives. You can suppress the display of commands for an entire group hierarchy or a specific role within the hierarchy, for entire groups of users, and for users who are assigned a role within a group. It also allows you to suppress the display of specific commands on a designated menu or to suppress the display of entire menus. For information about Command Suppression, see the Application Administration Guide.</td>
</tr>
<tr>
<td>Content Management</td>
<td>![Icon]</td>
<td>Enables you to manage SGML and XML information stored in a Teamcenter database in conjunction with SGML/XML authoring tools to create technical publications in multiple formats. For information about Content Management, see the Content Management Guide.</td>
</tr>
<tr>
<td>DPV Measurements</td>
<td>![Icon]</td>
<td>Allows Dimensional Planning and Validation data managers to view measurement data events based on their date or job serial number and to activate or deactivate selected events. For more information about DPV Measurements, see the Dimensional Planning and Validation Administration Guide.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>![Icon]</td>
<td>Shows the Reporting and Analytics dashboard. For more information about the Dashboard application, see the Report Builder Guide.</td>
</tr>
</tbody>
</table>
## Application | Button | Description
--- | --- | ---
Database Utilities | ![Database Utilities](image) | Used to access Teamcenter volume information and database user information. For information about using the Database Utilities application, see *Getting Started with Automotive Edition*.

DesignContext | ![DesignContext](image) | Lets you quickly focus on a particular work part in the Repeatable Digital Validation (RDV) environment and on any other parts affected within the context of a change to that part. RDV lets you accurately model specific product assembly configurations and use the results with analytical and visualization tools to facilitate learning and decision making. For information about DesignContext, see the *DesignContext Guide*.

Getting Started | ![Getting Started](image) | Provides a point from which you can quickly start working in Teamcenter. You can search for a part, open your worklist, view or edit product structure, or view or edit classification data. For information about the Getting Started application, see the *Rich Client Interface Guide*.

Issue Manager | ![Issue Manager](image) | Tracks problems, or issues, with a product by letting you manage the review, approval, and implementation of the issue. Also lets you view and manage requests for the penetration of structures that were generated in NX. For information about Issue Manager, see the *Issue Manager Guide*.

Launch Pad | ![Launch Pad](image) | Provides a visual desktop to place items and notes, called *nodes*, for quick reference in either a carousel or grid display mode. By default, the Launch Pad application is hidden unless an administrator removes it from the *HiddenPerspectives* preference value list. For information about using the Launch Pad application, see the *Rich Client Interface Guide*.  

---

*Note*
<table>
<thead>
<tr>
<th>Application</th>
<th>Button</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle Viewer</td>
<td>![icon]</td>
<td>Used for visualization of parts and assemblies, Lifecycle Viewer provides multiple views that let you display and work with design data typically stored in CAD-data formats. Lifecycle Viewer functionality is available in multiple product configurations along with a variety of optional software modules.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Teamcenter supports product visualization requirements in multiple ways, including:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Lifecycle Viewer – A Teamcenter application available in the rich client.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Embedded viewers – Viewers accessed within Teamcenter applications such as My Teamcenter and Structure Manager.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Stand-alone viewer – An application installed separately from Teamcenter, which supports both local and Teamcenter-managed data.</td>
<td></td>
</tr>
<tr>
<td>Manufacturing – 4D Scheduling</td>
<td>![icon]</td>
<td>Provides a Schedule Manager view alongside process and product views to enable 4D analysis of very large structures. This analysis allows a manufacturing planner to visualize what parts of a structure are already assembled by a specific date in a given area of the product.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about the Manufacturing – 4D Scheduling perspective, see the Manufacturing Process Planner Guide.</td>
<td></td>
</tr>
<tr>
<td>Manufacturing – BOM Reconciliation</td>
<td>![icon]</td>
<td>Provides two structure views with their accompanying Graphics views to help you align the engineering BOM with the manufacturing BOM.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Manufacturing Process Planner perspectives, see the Manufacturing Process Planner Guide.</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>Button</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Manufacturing – Process Sequencing</td>
<td>![Image]</td>
<td>Provides PERT and Process Gantt views to help you specify the process flow. For information about Manufacturing Process Planner perspectives, see the Manufacturing Process Planner Guide.</td>
<td></td>
</tr>
<tr>
<td>Manufacturing Process Planner (formerly Manufacturing Structure Editor)</td>
<td>![Image]</td>
<td>Enables you to design a process plan for manufacturing a product. The process plan describes the overall strategy used to manufacture the product and defines the specific processes and operations used in the plan. For information about Manufacturing Process Planner, see the Manufacturing Process Planner Guide.</td>
<td></td>
</tr>
<tr>
<td>Multi-Structure Manager (formerly called Collaboration Context)</td>
<td>![Image]</td>
<td>Enables you to manage any of the structure types compatible with Teamcenter, including product structures and manufacturing process structures. For information about Multi-Structure Manager, see the Multi-Structure Manager Guide.</td>
<td></td>
</tr>
<tr>
<td>My Teamcenter</td>
<td>![Image]</td>
<td>Provides Teamcenter Component, Summary, Details, Viewer, and Impact Analysis views you use to perform many basic tasks such as viewing and modifying your data, initiating and participating in a workflow process, and checking your data into and out of the Teamcenter database. For information about My Teamcenter, see the My Teamcenter Guide.</td>
<td></td>
</tr>
</tbody>
</table>
# Using Teamcenter interfaces

<table>
<thead>
<tr>
<th>Application</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td><img src="image" alt="Organization Button" /></td>
<td>Lets the Teamcenter administrator create and maintain your company's virtual organization within Teamcenter. This virtual organization is a way of organizing user accounts and their respective permissions and user groups. For information about Organization, see the <a href="#">Organization Guide</a>.</td>
</tr>
<tr>
<td>PLM XML/TC XML Export Import Administration</td>
<td><img src="image" alt="PLM XML/TC XML Export Import Administration Button" /></td>
<td>Enables administrators to create PLM XML import and export rules used to configure the import and export of data in PLM XML format. For information about PLM XML/TC XML Export Import Administration, see the <a href="#">PLM XML/TC XML Export Import Administration Guide</a>.</td>
</tr>
<tr>
<td>Part Planner</td>
<td><img src="image" alt="Part Planner Button" /></td>
<td>Enables you to design a plan that details how to manufacture a piece part product. For information about Part Planner, see the <a href="#">Part Planner Guide</a>.</td>
</tr>
<tr>
<td>Plant Designer (formerly called Factory Structure Editor)</td>
<td><img src="image" alt="Plant Designer Button" /></td>
<td>Enables you to author and view factory layouts. For information about Plant Designer, see the <a href="#">Plant Designer Guide</a>.</td>
</tr>
<tr>
<td>Platform Designer</td>
<td><img src="image" alt="Platform Designer Button" /></td>
<td>Provides a mechanism to plan and control the evolution of product structures at your site by building generic structures of your products that contain a high degree of variability. Platform Designer uses architecture breakdowns to create and disseminate design content and product variability. For information about Platform Designer, see the <a href="#">Platform Designer Guide</a>.</td>
</tr>
<tr>
<td>Product Configurator</td>
<td><img src="image" alt="Product Configurator Button" /></td>
<td>Lets you define and manage the variability of a product, including options, option values, option families, option rules, and constraints (rule checks). For more information about Product Configurator, see the <a href="#">Product Configurator Guide</a>.</td>
</tr>
<tr>
<td>Application</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Project           | ![image](image1.png) | Enables administrators to control access to a Teamcenter database that is used by multiple organizations, such as project teams, development teams, suppliers, and customers. Access to data is controlled on a project-by-project basis.  
For information about Project, see the Project and Program Guide. |  |
| Query Builder     | ![image](image2.png) | Enables administrators to create, modify, and delete saved queries that are made available to the Teamcenter user community.  
For information about Query Builder, see the Query Builder Guide. |  |
| Registry Editor   | ![image](image3.png) | Enables the editing of Teamcenter rich client registry files. This perspective is used only for editing registry files that are used for internationalization, dynamic class invocation, and configuration in the rich client framework.  
For information about Registry Editor, see the Registry Editor Guide. |  |
| Relation Browser  | ![image](image4.png) | Provides Relation Browser, Image Preview, Graph Overview, and Properties views you use to perform basic tasks such as browsing object relations, viewing 2D images, locating an object graphically in a map of relations, and examining the properties of a selected object.  
For information about Relation Browser, see the Relation Browser Guide. |  |
| Report Builder    | ![image](image5.png) | Enables administrators to build summary, item, and custom reports.  
For information about Report Builder, see the Report Builder Guide. |  |
| Report Generator  | ![image](image6.png) | Generates reports on products, manufacturing processes, and plant structures managed by Manufacturing Process Management.  
For information about Report Generator, see the Report Generator Guide. |  |
<table>
<thead>
<tr>
<th>Application</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirements Manager</td>
<td><img src="Image" alt="image" /></td>
<td>Enables the identification, allocation, and ongoing maintenance of product requirements.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Requirements Manager, see the <em>Systems Engineering Guide</em>.</td>
</tr>
<tr>
<td>Resource Manager</td>
<td><img src="Image" alt="image" /></td>
<td>Manages manufacturing resources, such as cutting tools, machine tools, fixtures, weld guns, robots, and related documents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Resource Manager, see the <em>Resource Manager Guide</em>.</td>
</tr>
<tr>
<td>Schedule Manager</td>
<td><img src="Image" alt="image" /></td>
<td>Enables you to define and manage schedules for your projects. These schedules can be shared with members of your team. You can allow team members to update specific tasks, schedule subsections of the project, or update the entire project schedule.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Schedule Manager, see the <em>Schedule Manager Guide</em>.</td>
</tr>
<tr>
<td>Service Manager</td>
<td><img src="Image" alt="image" /></td>
<td>Supports as-maintained structure management and service event management capabilities using the <em>Contains, Disposition History, Log Entries, Physical Part Usage History, Service Details, Service Editor,</em> and <em>Utilization</em> views.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Service Manager, see the <em>Service Manager Guide</em>.</td>
</tr>
<tr>
<td>Service Planner</td>
<td><img src="Image" alt="image" /></td>
<td>Lets you create and manage service plans, service requirements, work cards, activities, and other information to support the service planning process.Uses the <em>Service Planner</em> and <em>Plan Details</em> views.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Service Planner, see the <em>Service Planner Guide</em>.</td>
</tr>
<tr>
<td>Service Request Manager</td>
<td><img src="Image" alt="image" /></td>
<td>Supports service request management capabilities using the <em>Open Service Request, Request Home,</em> and <em>Service Request Status</em> views.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Service Request Manager, see the <em>Service Request Manager Guide</em>.</td>
</tr>
</tbody>
</table>
### Chapter 2  
*Using Teamcenter interfaces*

<table>
<thead>
<tr>
<th>Application</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Scheduler</td>
<td>![Icon]</td>
<td>Provides the capability to define, schedule, and implement service work using the <a href="#">Home</a>, <a href="#">Service Editor</a>, <a href="#">Service Scheduler</a>, <a href="#">Work Order Home</a>, and <a href="#">Summary</a> views.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Service Scheduler, see the <a href="#">Service Scheduler Guide</a>.</td>
</tr>
<tr>
<td>Setup Wizard</td>
<td>![Icon]</td>
<td>Facilitates postinstallation set up of a Teamcenter database using an input file to populate the information required to create the basic components of the Teamcenter organization. Using Setup Wizard, a system administrator can create user/person definitions, assign a group/role to a user, and optionally define a default volume for assigned groups.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Setup Wizard, see the <a href="#">Setup Wizard Guide</a>.</td>
</tr>
<tr>
<td>Software Parameter Manager</td>
<td>![Icon]</td>
<td>Lets you manage embedded software parameters and their location into hardware controller memory space. You can segregate controller memory into multiple segments that can be divided into blocks. Software Parameter Manager provides the framework to import parameter addresses and conversion rules as well as to generate the flash file for each memory segment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For more information, see the <a href="#">Embedded Software Solutions Guide</a>.</td>
</tr>
<tr>
<td>Specification Manager</td>
<td>![Icon]</td>
<td>Enables you to view and work with specifications that capture the complete definition of products and how to manufacture them.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about Specification Manager, see the <a href="#">Specification Manager Guide</a>.</td>
</tr>
<tr>
<td>Structure Manager (formerly called Product Structure Editor)</td>
<td>![Icon]</td>
<td>Enables you to create, edit, and configure product structures.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about using Structure Manager, see the <a href="#">Structure Manager Guide</a>.</td>
</tr>
<tr>
<td>Application</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subscription Monitor</td>
<td>![image]</td>
<td>Enables administrators to query subscriptions created in the database, to monitor and delete subscription events and actions, and to generate statistical reports related to subscriptions, events, and actions in either text or bar chart format. For information about Subscription Monitor, see the <em>Subscription Monitor Guide</em>.</td>
</tr>
<tr>
<td>Systems Engineering</td>
<td>![image]</td>
<td>Encompasses functional modeling and requirements management. Functional modeling lets you represent the functional breakdowns of a product and decompose your proposed design or product into functional subsystems. Systems Engineering lets you identify, allocate, and maintain product requirements. These capabilities are provided by the Requirements view and the Function view, respectively. For information about functional modeling and requirements management, see the <em>Systems Engineering Guide</em>.</td>
</tr>
<tr>
<td>Validation Manager</td>
<td>![image]</td>
<td>Provides a decision mechanism to let users ensure an item revision meets compliance before it is released. Once validation processes are configured, users can select an item revision from My Teamcenter and confirm its compliance with the business rules defined at your site. For information about Validation Manager, see the <em>Validation Manager Guide</em>.</td>
</tr>
<tr>
<td>Volume Management</td>
<td>![image]</td>
<td>Allows administrators to improve performance by creating migration policies that move lower priority files to either destination volumes or third-party storage systems. All data continues to appear online to users. Files stored on secondary and tertiary tiers can be read without moving them to the highest level. For information about Volume Management, see the <em>Volume Management Guide</em>.</td>
</tr>
</tbody>
</table>
**Chapter 2  Using Teamcenter interfaces**

| Application      | Button | Description                                                                                                                                                                                                 | For information about Web Browser, see the Application Administration Guide.
|------------------|--------|-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------| For information about Workflow Designer, see the Workflow Designer Guide.
| Web Browser      | ![image] | Provides access to Web pages from within the rich client framework. Web Browser lets you navigate to Web pages and view Web pages within the rich client rather than switching to a separate Web browser. Web Browser also provides the capability to access MIME (Multipurpose Internet Mail Extension) file types and to view files created in other applications, such as Microsoft Word and Excel, through the Web browser. |
| Workflow Designer| ![image] | Enables administrators to design workflow processes using predefined tasks and handlers.                                                                                                                      | For information about Workflow Viewer, see the Workflow Viewer Guide.
| Workflow Viewer  | ![image] | Enables you to view in-progress workflow processes and related data.                                                                                                                                              |

**Open a rich client perspective**

You open an application perspective in the rich client in any of the following ways:

- Click the application button in the navigation pane.
- Select the perspective from the **Window→Open Perspective** menu.
- Select an object in a navigation view and use the **Send To** shortcut menu command to select an application.
- Double-click an object in a navigation view to open the perspective associated with that object type.

For example, to open My Teamcenter in the rich client, click **My Teamcenter** in the navigation pane.

If you do not see My Teamcenter listed as a primary application, check for the **My Teamcenter** button in the secondary application button bar at the bottom of the navigation pane. You can use **Configure Applications ( )** at the bottom of the navigation pane to find and place the **My Teamcenter** button in the navigation pane.
You can configure the display of application buttons in the rich client interface by designating perspectives to be primary or secondary.

For more information, see Configuring the display of applications.

Switch between open perspectives

Use any of the following methods to change from the currently displayed open perspective to another open perspective:

- Use the Back button ☐ in the toolbar, its associated menu, ▼, or Ctrl+Shift+F8 to display an application opened before the current application.

- Use the Forward button ☐ in the toolbar, its associated menu, ▼, or Ctrl+F8 to display an application opened before the current application.

- Hold down Ctrl+F8 to display a Perspectives menu, and then release F8 and use your mouse or your keyboard arrows to select the perspective to display.

Save, reset, or close a rich client perspective

To save the currently active perspective when you have arranged a useful layout of views and view networks:

1. Choose Window→Save Perspective As.

2. Enter a new name for the perspective.

3. Click OK.

To restore a perspective to its default state, choose Window→Reset Perspective. This returns all default views to their original locations.

You close an application perspective in rich client in any of the following ways:

- Click the X in the application banner.

  Note If you click the X in a view tab, only the selected view is closed and the application perspective remains active.

- Select the application, and then select Window→Close Perspective.

Working with the rich client navigation pane

The rich client navigation pane provides quick access to the data you use most. You can use the rich client navigation pane to find and organize your data and to help you perform common tasks, such as creating a part, creating a dataset, or applying a status to a part.
Chapter 2  Using Teamcenter interfaces

1  Upper part of the navigation pane

- The reorder button above the Search box lets you display the Navigation Section Ordering dialog box to hide sections or change the order of sections in navigation pane.

- Quick-open Search provides predefined searches using dataset, item ID, item name, keyword search, and advanced search features.

- Quick Links provide access to your Home folder, worklist, saved searches, and web links.

For information about working with Quick Links, see the Rich Client Interface Guide.

- Open Items displays links to items that are open in an active perspective.
• **History** displays links to Teamcenter objects that you opened in the past. Links are displayed with the most recently closed object displayed at the top of the **History** list.

• **Favorites** displays links to Teamcenter objects that you have designated as favorites.

  For more information, see *Add favorites to organize your data*.

• **I Want To** provides links to the tools used to complete tasks that you perform repeatedly, such as initiating a process or change.

  For more information about working with **I Want To** tasks, see the *Rich Client Interface Guide*.

2 Primary application buttons
   Provide access to your most frequently used Teamcenter applications.

3 Secondary application buttons
   Provide access to the Teamcenter applications that you use infrequently.

4 **Configure Applications** button
   Provides access to the tools you can use to configure the display of primary and secondary applications.

   For information about specifying primary and secondary applications, see *Configuring the display of applications*.

**Note**
You can also show or hide the navigation pane.

To show or hide the navigation pane:

• Choose **Window → Navigation Pane**.

   For information about displaying the navigation pane, see the *Rich Client Interface Guide*.

**Configuring the display of applications**

You can configure the display of applications in the navigation pane by choosing a command from the **Configure Applications** menu at the bottom of the navigation pane. Menu commands include the following:

• **Show More Applications**

  Shows more applications in the listings for primary applications and secondary applications.

• **Show Fewer Applications**
Chapter 2  Using Teamcenter interfaces

Shows fewer applications to the listings for primary applications and secondary applications.

- **Navigation Pane Options**
  Specifies and organizes applications for listing as primary applications and secondary applications.

- **Add + or Remove −** buttons in the Navigation Pane Options dialog box.
  Moves applications between the primary applications and the secondary applications list.

  **Note** You can drag the sash up or down in the navigation pane to adjust the number of application buttons that appear in the primary and secondary application lists. If the secondary application area cannot contain all the applications, the applications that do not fit are displayed at the bottom of the Configure Applications menu.

For information about configuring the navigation pane, see the *Rich Client Interface Guide*.

**Customizing the toolbar**

You can add commands or remove commands from Teamcenter rich client perspectives.

- The Customize Toolbar ☑ shortcut menu command displays the Customize Toolbar dialog box.

- The Customize Toolbar dialog box lets you add commands to the toolbar or remove commands from the toolbar for each Teamcenter rich client perspective you use frequently.

- The Restore Defaults ⏅ shortcut menu command returns a perspective toolbar to its default state.

For more information about customizing the toolbar, see the *Rich Client Interface Guide*.

  **Note** Some Teamcenter options do not have symbols associated with them. When you add these options to the toolbar, the generic button is displayed and the command name is shown as a tool tip when you move the mouse cursor over the button.

**Configuring table data display in the rich client**

You can configure the way data is displayed in tables throughout the rich client interface. The method of configuring data display in application table panes, such as in Structure Manager, differs from the method of configuring data display in view tables, such as the Details view in My Teamcenter.
After you configure the table data display using either method, you can:

- Apply the configuration to the current table.
- Save the configuration and apply it another time you want to view data.

To configure the data display in an applications table pane, right-click a column header and choose the applicable command from the Table Function Menu.

To configure the data display in a view table, click the Menu button and choose the applicable command from the view menu.
Managing your thin client interface

The thin client home page is typically the default page that appears when you log on. It serves as a starting point to allow you to navigate to other functions.

When you log on, the home page initially displays the contents of your **Home** folder in the tree pane.

- The **Home** folder is the root object (topmost) on the page. You can subsequently navigate to any other object that you have permission to access and view this object as the root object on the page.

- Any children of the root object display below the object. The object may be, for example, a dataset, structure, or collaboration context.

When you click the link to an object in the home folder, Teamcenter displays the selected object with the object as the root and expanded by one level to show all of its immediate children.

The children of an object display differently, depending on the type of object you select, as follows:

<table>
<thead>
<tr>
<th>Object type</th>
<th>Visible children</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Folder contents</td>
</tr>
<tr>
<td>Item</td>
<td>Item revisions and all attachments arranged by relation type</td>
</tr>
<tr>
<td>Item revision</td>
<td>BOM view revision and all attachments arranged by relation type</td>
</tr>
<tr>
<td>All other workspace objects</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note** You can expand and collapse the root object with the expand (⁺) and collapse (⁻) buttons.
Thin client interface

The thin client interface has a standard menu bar and toolbar with options that vary depending on the currently active application. You can place the cursor over a thin client toolbar button to display a tooltip description.

1. **Menu bar and button bar**
   Provides access to menu and button commands and lists the current user name, group, role, revision rule, and server.

2. **Navigation pane**
   Provides search functionality, link groups, and application buttons.
   
   You can expand and collapse the entire pane and pane groups, select what is displayed in primary and secondary areas, and configure the display of applications.

3. **Component pane**
   Displays component hierarchies in a tree view. You can resize this pane to be wider or narrower.
Chapter 2  Using Teamcenter interfaces

4  Data pane  The data pane displays tabbed information.
   • Depending on the type of object selected and the configuration specified in your installation’s XRT style sheet, you may see tabs such as Overview, Details, Related Datasets, Attachments, History, Change History, Where Used, Structure, Impact Analysis, Available Revisions, and Viewer.
   • Groups of objects within a tab, called object sets, can be configured in the XRT style sheet. Each group of information can be configured to display in table, list, or thumbnail. Each group can also be supported by action command buttons such as Cut and Copy.
     For information about creating object sets, see the Client Customization Programmer’s Guide.
   • You can configure the columns in the Details tab.

The default layout for thin client applications has a header bar containing menus, command buttons, and session information above three panes, arranged vertically side-by-side. Some thin client applications arrange the component pane and the data pane horizontally.

The layout configuration for a thin client application can only be changed by customization.

**Note**  If instant messaging is configured, the data pane may also display the current Microsoft Office Communicator status of the owning and last modified users.

   For more information about configuring instant messaging, see the Application Administration Guide.

Open an application in the thin client
   • To open an application, click a primary or secondary application button in the navigation pane.

   For more information about the applications available in the thin client, see Thin client applications.

   For more information about working with the navigation pane, see Working with the thin client navigation pane.

Thin client applications
   The thin client interface can be used to perform many of the same tasks you can perform in the rich client interface. However, there are fewer distinct applications available in the thin client, and administrative tasks cannot be performed in this interface.
The following table describes the thin client applications and shows the button associated with each application.

<table>
<thead>
<tr>
<th>Button</th>
<th>Application name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![My Teamcenter icon]</td>
<td>My Teamcenter</td>
<td>Lets you perform basic tasks, such as searching for your work, viewing and modifying your data, initiating and participating in a workflow process, and checking your data in and out of the Teamcenter database.</td>
</tr>
<tr>
<td>![Structure Manager icon]</td>
<td>Structure Manager</td>
<td>Lets you create, edit, and configure product structures.</td>
</tr>
<tr>
<td>![Systems Engineering icon]</td>
<td>Systems Engineering</td>
<td>Lets you identify, allocate, and maintain product requirements.</td>
</tr>
<tr>
<td>![Manufacturing Process Planner icon]</td>
<td>Manufacturing Process Planner</td>
<td>Lets you view a process plan that you create in the rich client Manufacturing Process Planner application and use to manufacture a product. The process plan describes the overall strategy used to manufacture the product and defines the specific processes and operations used in the plan.</td>
</tr>
<tr>
<td>![Classification icon]</td>
<td>Classification</td>
<td>Lets you classify and retrieve your product data based on predefined attribute values.</td>
</tr>
<tr>
<td>![Adhoc Design Context icon]</td>
<td>Adhoc Design Context</td>
<td>Lets you configure assemblies, and then send them in PLM XML format to stand-alone Teamcenter's lifecycle visualization mockup or NX to view.</td>
</tr>
<tr>
<td>![Design Context icon]</td>
<td>Design Context</td>
<td>Lets you focus on a particular work part in the Repeatable Digital Validation (RDV) environment and any other parts affected within the context of a change to that part. RDV allows you to accurately model specific product assembly configurations and use the results with analytical and visualization tools to facilitate learning and decision making.</td>
</tr>
<tr>
<td>![Schedule Manager icon]</td>
<td>Schedule Manager</td>
<td>Lets you define and manage schedules for your projects. These schedules can be shared with members of your team. You can allow team members to update specific tasks, schedule subsections of the project, or update the entire project schedule.</td>
</tr>
</tbody>
</table>
Using Teamcenter interfaces

<table>
<thead>
<tr>
<th>Button</th>
<th>Application name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Issue Manager</td>
<td>Lets you track product problems, or issues, by letting you manage the review, approval, and implementation of the issue.</td>
</tr>
</tbody>
</table>

For information about using these applications in the thin client, see the *Thin Client Interface Guide*.

**Working with the thin client navigation pane**

The thin client navigation pane provides quick access to applications and to the data you use most.
1 Quick Search

- **Quick Search**
  Allows you to make a simple search for items and datasets by item ID, keyword, item name, or dataset name. Choose the search type from the list, type the search values, and click the Go button to begin.

  **Note** A progress dialog box is displayed for all searches lasting more than one second. A Cancel button in the progress dialog box is displayed for metadata-only queries.

- **Advanced Search**
  Allows you to initiate advanced queries with predefined criteria. You can save query criteria that you use frequently. Choose Advanced from the search menu to set up an advanced search.

  For more information about searches, see *Searching in Teamcenter*.

2 Link groups

Quick Links

- **Home**
  Returns to your home page from any other page.

- **My Worklist**
  Displays your worklist from any other page.

- **My Saved Searches**
  Displays your saved searches.

- **My Links**
  Creates a list of bookmarks.

- **My View Markup**
  Creates a list of your markups.

History

- Contains links to pages you have recently visited.

Favorites

- Contains links to pages you have bookmarked using the Actions→Add to Favorites menu command.

  For more information, see *Add favorites to organize your data*.

I Want To
Chapter 2  Using Teamcenter interfaces

- Contains shortcuts to common actions.

  Click Customize to change the list of actions.

3 Primary application buttons

  Provides access to your most frequently used Teamcenter applications.

4 Secondary application bar

  Provides access to your additional Teamcenter applications.

  The Configure Applications menu displays:

  - Available primary and secondary application commands.

    Choose a menu command to load the selected application.

  - The Navigation Settings command.

    Choose the Navigation Settings command to display the Navigation Settings dialog box.

    The Navigation Settings dialog box lets you add or remove applications from the primary and secondary areas, hide applications, reorder navigation pane items, organize favorites, and customize your I Want To list.

Note

You can also use the alternative Navigation Settings button at the top of the navigation pane to display the Navigation Settings dialog box, and you can use the Collapse button to hide the navigation pane.

Installed and configured applications that do not appear in the primary or secondary areas, but still appear in the Available Applications pane of the Navigation Settings dialog box, do not appear in the thin client user interface.

Note

Your browser also provides a Favorites bookmark capability.

You can save a URL bookmark using the browser Favorites feature. If you have the thin client configured with SSO (single sign-on) and SSL (secure socket layer), the browser does not return you to the expected location after you log off Teamcenter and log on again, while in the same browser session.

After you log off, but within the same browser session, selecting a browser Favorites bookmark link to a thin client location causes the SSO Login Service to prompt you to log on to the application using your user name and password; then the SSO Login Service redirects you to the thin client configured for the application during installation.

To use a browser Favorites bookmark link to access a specific location in the thin client after you log off, you must first end the current browser session (restart the browser). After you restart the browser, the Favorites bookmarked entry requires you to log on and then accesses the desired location.
Business Modeler IDE interface

The Business Modeler IDE (Integrated Development Environment) is a tool for configuring basic functionality and for customizing the data model of your Teamcenter installation. It is installed using Teamcenter Environment Manager (TEM).

The Business Modeler IDE is intended for business analysts who are responsible for tailoring Teamcenter for use at their companies. Users of the IDE must have a thorough understanding of how to perform end-user tasks with Teamcenter, and have some knowledge of the data model items used in Teamcenter.

Use the IDE to create:

- **Business objects**
  Business objects are the fundamental objects used to model business data. Create business objects to represent, for example, product parts, documents, and change processes. Business objects are also known as types.

- **Classes**
  Classes are the persistent representations of the data model schema, and provide attributes to business objects. Classes are also known as the persistent object model (POM).

- **Attributes**
  Attributes are item characteristics such as name, number, and description. Attributes are attached to classes and business objects. All children of a class or business object inherit their parents’ attributes.

- **Lists of values**
  Lists of values (LOVs) are pick lists of values. They are commonly accessed by end users from a menu at the end of a data entry field.

- **Options**
  Options are miscellaneous items such as change objects, units of measure, and notes.

- **Rules**
  Rules define the business rules that govern how objects are handled, including how they are named and what actions can be undertaken on them. Creating rules is also known as business modeling.

For more information about the Business Modeler IDE, see the *Business Modeler IDE Guide*.

Teamcenter Client for Microsoft Office

Manage Teamcenter data in real time with Teamcenter Client for Microsoft Office. Client for Office gives you access to Teamcenter directly through Microsoft Office Word, Excel, PowerPoint, and Outlook.
Client for Office adds a custom **Teamcenter** tab to the ribbon in Word, Excel, and PowerPoint. In Outlook, each open message contains the **Teamcenter** tab on the ribbon.

Client for Office is independent of the Teamcenter rich client. You can work in Client for Office while the rich client is running. Or, you can work solely through the Client for Office without running the rich client.

Authors, manufacturing authors, reviewers, and other users can use Client for Office to perform the following Teamcenter tasks:

- Save and edit Office documents in Teamcenter.
- Browse to and search for Office documents and other Teamcenter objects.
- Create folders, items, and item revisions in Teamcenter.
- Create and edit Teamcenter datasets.
- Insert Teamcenter object property values, search results, pictures, JT files, and hyperlinks in Office documents.
- Check out and check in Office documents in Teamcenter.
- Submit Office documents to Teamcenter workflows.
- Perform Teamcenter sign-offs.
- Import data from Excel to create and modify structures and objects in Teamcenter.
- Automatically synchronize property values between Office documents and Teamcenter datasets of the **MS Office** type.

For more information about Client for Office, see the *Client for Microsoft Office Guide*. 
Chapter

3 How Teamcenter supports product life cycle phases

How Teamcenter supports product life cycle phases ............................................. 3-1
Systems engineering and requirements .............................................................. 3-2
Managing design data and product structures .................................................... 3-2
  Product structure and configuration management ............................................. 3-3
  4th Generation Design ...................................................................................... 3-3
Manufacturing process management ................................................................. 3-4
Workflow and change management .................................................................... 3-4
Document management basics ............................................................................ 3-5
Content management ......................................................................................... 3-8
Managing contract data ....................................................................................... 3-8
Vendor management ............................................................................................. 3-10
Product visualization ........................................................................................... 3-10
Classification and reuse ..................................................................................... 3-11
CAE Data Management ....................................................................................... 3-11
Repeatable Digital Validation ............................................................................. 3-12
Maintenance, repair, and overhaul ...................................................................... 3-12
  As-Built Manager ............................................................................................. 3-12
  Service Manager ............................................................................................. 3-13
  Service Planner ............................................................................................... 3-14
  Service Request Manager ................................................................................ 3-15
  Service Scheduler ............................................................................................ 3-15
Teamcenter solutions .......................................................................................... 3-16
  Consumer Packaged Goods ............................................................................ 3-16
  Aerospace and Defense .................................................................................... 3-17
  Automotive Edition ......................................................................................... 3-17
  Materials Management ..................................................................................... 3-18
  Substance Compliance ...................................................................................... 3-18
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensional Planning and Validation (DPV)</td>
<td>3-19</td>
</tr>
<tr>
<td>Electronic Design Automation (EDA)</td>
<td>3-19</td>
</tr>
<tr>
<td>Data sharing</td>
<td>3-20</td>
</tr>
<tr>
<td>Data Exchange</td>
<td>3-20</td>
</tr>
<tr>
<td>Global Services</td>
<td>3-22</td>
</tr>
<tr>
<td>Multi-Site Collaboration</td>
<td>3-22</td>
</tr>
<tr>
<td>PLM XML</td>
<td>3-22</td>
</tr>
</tbody>
</table>
Chapter

3 How Teamcenter supports product life cycle phases

How Teamcenter supports product life cycle phases

Teamcenter is a suite of digital product life cycle management solutions built on an open PLM foundation.

The Teamcenter solution portfolio can be configured to achieve your PLM vision by:

- Integrating idea management and requirements planning into the digital life cycle management, product development, and manufacturing process.

- Linking partners and suppliers with secure global access to your product knowledge based on access rules.

- Enabling consistent, repeatable processes and commonality.

Teamcenter supports all phases of the product life cycle, including planning, development, execution, and support by providing tools for:

- Systems engineering and requirements
- Managing design data and product structures
- Manufacturing process management
- Workflow and change management
- Document management basics
- Content management
- Managing contract data
- Vendor management
- Product visualization
- Classification and reuse
- CAE Data Management
- Repeatable Digital Validation
- Maintenance, repair, and overhaul
Chapter 3  How Teamcenter supports product life cycle phases

- Teamcenter solutions
- Dimensional Planning and Validation (DPV)
- Electronic Design Automation (EDA)
- Data sharing

Systems engineering and requirements
You can use Teamcenter to represent the functional, logical, and physical breakdowns of a product. You can decompose your proposed design or product into functional subsystems with the Systems Engineering application. For example, the functional breakdown of a car may be decomposed into various functional subsystems, such as the music system and the braking system. In turn, the functional subsystems may contain various individual functions of the subsystems. In a functional model, components can be functions or functional subsystems. Once you identify the functional subsystems and components, you can assign requirements to them.

Teamcenter provides an integration with functional modeling tools such as MATLAB Simulink, which allows you to author model data in external tools but manage it in Teamcenter.

Requirements are the blueprint from which your company designs products. Systems Engineering connects requirements into product life cycle processes, driving design decisions and helping you to avoid problems. Product requirements are delivered to life cycle participants using the Web and through standard desktop tools like Microsoft Word, Excel, and Visio.

For more information, see Getting Started with Systems Engineering and the Systems Engineering Guide.

Managing design data and product structures
Teamcenter provides two alternative ways you can manage design data and product structures:

- Product structure and configuration management
  
  With this approach, you use:

  o Structure Manager to create and enhance a product structure and to configure your product structures using revision configuration, occurrence configuration, or variant configuration techniques.

  o Platform Designer to define baseline configurations and select the components that are variable and to which variations they are applied.

  o Multi-Structure Manager to share product structures and design components in context using existing geometry as background information.

- 4th Generation Design (4GD)
  
  This approach is particularly suitable for development teams working on large products that typically include millions of parts, for example, those found in the
shipbuilding industry. It allows users to check out and modify the individual parts that comprise the overall design of the product, without locking the entire product or major assemblies.

Product structure and configuration management

Using Structure Manager, you can create a product structure that can be viewed as an indented listing of assemblies and piece parts. You can attach CAD files, specification documents or other information to the top-level assembly (the product itself), or to any of the assemblies or piece parts. You can build, view, and manipulate the product structure in Teamcenter, or you can import it from an MCAD system such as NX.

You can further configure your product structures using revision configuration, occurrence configuration, or variant configuration techniques.

Teamcenter also enables you to establish product platforms using Platform Designer to define baseline configurations and then select the components that are variable and to which variations they are applied. This allows you to manage multiple product variations by tracking those components that are common to the platform and those that are specific to a variation.

Multi-Structure Manager enables you to share product structures and design components in context using existing geometry as background information. Sharing context allows you to evaluate form, fit, and function by leveraging existing spatial context.

For more information, see:

- Getting Started with Product Structure
- Structure Manager Guide
- Platform Designer Guide
- Multi-Structure Manager Guide

4th Generation Design

4th Generation Design (4GD) lets users of NX CAD or Lifecycle Visualization to cooperate in real time during the design cycle of a product.

- 4GD is particularly suitable for development teams working on large products that typically include millions of parts, for example, those found in the shipbuilding industry.

- 4GD allows users to check out and modify the individual parts that comprise the overall design of the product, without locking the entire product or major assemblies.

Users work in three main phases using the 4G Designer application:

- Product administration
  The system administrator configures the necessary customization of the default 4GD business objects to suit your enterprise’s working environment and data model.
Chapter 3  How Teamcenter supports product life cycle phases

• Product initiation

When you initiate a product, the configuration developer, design team leader or other expert user defines the main systems into which engineering provides solutions. In many cases, the initial design is created from a similar product or from an existing template for the product type. This initial framework is called the collaborative design.

• Product authoring

In this phase, design engineers populate the collaborative design with elements that describe the product design. It can contain CAD designs, product-specific geometry, and features such as welds and weld seams. The collaborative design can be populated directly or from within a workset that is realized into a subset in the collaborative design. Typically, the design team leader assigns tasks in various areas of the collaborative design to designers with appropriate skills and assigns worksets accordingly.

For more information about 4GD basic concepts, see the 4th Generation Design Guide.

Manufacturing process management

Manufacturing Process Management manages data created in the manufacturing planning stage of the product life cycle. It allows you to manage assembly and fabrication of products whose design is managed in Teamcenter.

Collaboration between design and manufacturing teams is realized using Manufacturing Process Planner. You can manage, relate, and consolidate product and process structures to compare as-designed, as-manufactured, or any other specific configuration. Accountability checks allow you to ensure that all components in the product structure are accounted for in the assembly process.

When you manufacture piece parts, Part Planner helps manage the step-by-step operations and associated documentation of your CAM software. In addition, you can use Resource Manager to create and manage tools, machine tools, fixtures, robots and other resources found at your manufacturing facility.

For more information, see:

• Getting Started with Manufacturing
• Manufacturing Process Planner Guide
• Part Planner Guide
• Resource Manager Guide

Workflow and change management

Teamcenter provides functionality that enables you to initiate, administer, review, approve, and execute product changes. By automating your change process, you can minimize change-related rework and coordinate tasks to be performed by individuals across your organization. Because Teamcenter change management
leverages product structure definitions, you can evaluate the impact of changes, track the status and completion of tasks, and maintain a comprehensive history of product changes throughout the lifecycle. Change management in Teamcenter is also tightly integrated with Schedule Manager and Workflow so you can schedule implementation activities and guide a change through its phases.

For more information, see the Change Manager Guide, Getting Started with Workflow, the Workflow Viewer Guide, and the Workflow Designer Guide.

In addition, if you have changes or issues that do not need to be addressed through an extensive, standardized change management process, such as the one that Change Manager supports, or you have highly visual information, you can use Issue Manager. Issue Manager automatically provides access to Siemens PLM Software design review and issue resolution tools, including NX, Lifecycle Visualization, and the Lifecycle Viewer.

You can use Issue Manager in both the rich client and the thin client. Use both clients to create, review, and manage issues, but use the rich client to administer your issue management process.

For more information about Issue Manager, see the Issue Manager Guide.

Document management basics

Document management functionality uses item revision definition configuration (IRDC) objects to simplify user interactions with information. This reduces the need to understand the Teamcenter data model and relationship model.

Based on your business processes, IRDC objects defined in the Teamcenter Business Modeler IDE application let you automate document creation, rendering of presentation formats, document markup, document batch printing, and document availability.

**Note** Document management functionality can be configured for any Teamcenter item, but some or all document management behaviors may be unavailable at your site.

Document management uses IRDC to specify behaviors for **Document** items, **DMTemplate** items, and **Dataset** items.

- An IRDC object is created by an administrator or a customizer using the Business Modeler IDE application. This object lets you standardize document behavior at specific times in the life cycle of the document. Document behavior can be managed for **New**, **Check In**, **Check Out**, **Copy (Save As)**, **Revise**, **View/Markup**, **Cancel Check-Out**, **Sign**, and **Cancel Signing** actions for a document.

Managed behaviors can include creation and naming of derived visualization datasets, markup rules, and the creation of specified relations.

**Note** Document management behavior configuration is designed primarily for **Document** items, but any of the behaviors can be used for any subtype of the **Item** type.

- The **Document** item is an object you create in Teamcenter. In document management, the document item is associated with one or more templates and dataset items in a manner configured to meet your business requirements. When
a document revision is sent to a workflow, a derived dataset can be created and attached to the document revision.

**Note** When you render an item, you create a derived dataset from a source dataset. The render action is initiated from a checkin or from a workflow task. Such derived datasets are typically used when content must be provided outside the authoring organization and the ability to make changes to the original content must be restricted.

For more information about rendering items, see *Getting Started with Document Management*.

- The **DMTemplate** item can be created by any user. A Teamcenter administrator can create an IRDC to associate a **DMTemplate** item with a specific item type and specific dataset types.

- The **Dataset** object represents an actual data file on the operating system or in Teamcenter. Datasets are typically authored content of some sort, such as Microsoft Office files or CAD data files.

- Markup access for documents is controlled by the **Markup** privilege, assigned by administrators in Access Manager.

  **Note** Markup is typically used for authoring with controlled iteration in the context of a change control object.

  - Documents used in markup are typically in Adobe PDF or Microsoft Word format. When Microsoft Word format is used, a markup summary can be extracted to Microsoft Excel.

  - Markup in document management is not the same as Lifecycle Visualization markup, which is used for marking up illustrations and Lifecycle Visualization output.

  - To perform markup in Adobe Acrobat or Adobe Reader, ensure the documents preference for **PDF/A View Mode** is set to **Never**.

- You can digitally sign a PDF file stored as a dataset named reference file with Adobe Acrobat and Adobe Reader.

  New style sheets let you configure create dialog boxes and summary display for **Document** objects.

  The **Digital Sign Dataset** ACL rule grants the owning user and owning group digital signing privileges for the dataset object.
Digital signing is supported only for PDF datasets created in Teamcenter 10.1 or later.

- In the Adobe Reader, the PDF file must have **Enable Usage Rights for Digitally Sign** enabled.
- Use Adobe Acrobat or Adobe LiveCycle Reader Extensions to enable usage rights for PDF files.
- To perform digital signing in Adobe Acrobat or Adobe Reader, ensure the documents preference for **PDF/A View Mode** is set to **Never**.

For information, see *Getting Started with Document Management*.

**Caution** When you create markups or update markups using Adobe Acrobat or Adobe Reader, the markups must be saved in Teamcenter or canceled before you begin the **Sign** action for the PDF dataset file.

- You can use create style sheets provided for **Document** objects to customize the New Business Object wizard in the rich client and thin client to streamline the document creation process.

Two user interface dialog boxes added to the New Business Object wizard support:

- Attaching files to a dataset for a new object.
- Submitting a new object to workflow.

Additional capabilities provided by document management batch printing include creating configuration objects to manage printer configuration and system stamp configuration. Batch printing lets you select workspace objects, such as items, item revisions, or datasets, and print the associated documents with system stamps and watermarks.

- A system stamp can include the user name, the date and time, and other specified business item attributes. You can also define optional additional user stamps, which can be appended to the system stamp, to select when printing documents. The stamp content and position is specified in a MetaDataStamp (MDS) file. System stamps can be placed on the first page or all pages of the output.

- A watermark is a recognizable image or pattern in paper that appears as various shades of lightness or darkness when viewed by transmitted light or when viewed by reflected light against a dark background. Watermark characteristics are specified in the MDS file.

For more information about working with MDS files, see the *Application Administration Guide*.

Document management also benefits from:

- The use of full-text search retrieval indexes.
- The production of thumbnail graphics.

For information about configuring document management functionality, see *Getting Started with Document Management*. 

---

*Note* Digital signing is supported only for PDF datasets created in Teamcenter 10.1 or later.
Content management

Content Management allows technical publication authors to manage SGML and XML information stored in a Teamcenter database. Content is managed by creating publications comprised of topic components and associated graphics. Content Management works in conjunction with several publishing and editing tools. Publications can be generated from the application for both online and print formats. There is support for multiple language versions and the ability to manage topic through release cycles.

For more information, see the Content Management Guide.

Managing contract data

Contracts are pivots that drive business across different industry sectors. A contract is a structured procurement document listing the milestones and the schedule dates of the contract event. This procurement document can be a list of data requirement items, such as design information, drawings, status reports, and so on.

After the contract is created, the data analyst creates a workflow schedule to collate the feedback and the review comments that are generated during the data item approval process. This is done by initiating correspondence related to the contract.

A graphical representation of managing contract data through Teamcenter is shown in the following figure.
The sequence of steps is as follows:

1. Create data item descriptions (DIDs).
   DIDs are predefined contract forms that specify data content, data format, and other specific instructions for the suppliers.
   You can maintain a DID repository to associate a data requirement item (DRI) to the contract.

2. Create a contract.
   The administrator or the data analyst creates a contract and contract revision in Teamcenter. You can also choose to create a contract event for scheduling the contract review and feedback process.

3. Create data requirement items.
   You must attach a data requirement item (DRI) to the contract. A DRI is a technical document or deliverable that forms the basis for structured procurement. It represents a single contractual data item as described in DID.

4. Define submittal delivery schedule for the deliverable.
   After the DRI is specified, you must initiate the review process. Submittal represents the data item submittal package or documentation that relates to the actual documents submitted.
5. Provide feedback.
   It is important to monitor the correspondence related to the data item submittal package between you and the supplier.

For more information, see the *Aerospace and Defense Solution Guide*.

**Vendor management**

Using Teamcenter vendor management, you can model vendor contributions to a product by capturing information about the vendors and the vendor parts they provide to satisfy the form, fit, and function of commercial parts.

Using vendor management objects, you can:

- Associate commercial parts with vendor parts.
- Navigate from a vendor object to commercial parts and vendor parts that are associated with the vendor object.
- Navigate from a commercial part or a vendor part to the vendor associated with the part.
- Navigate between commercial parts and vendor parts.
- Manage company locations and contacts.
- Display vendor parts in Structure Manager, including support for BOM compare.
- Create configurable business rules for vendor management actions.
- Change a vendor for a vendor part.
- Classify commercial and vendor parts.

**Note** Teamcenter vendor management is a prerequisite for the Teamcenter Aerospace and Defense solution.

For more information, see the *Getting Started with Vendor Management*.

**Product visualization**

The visualization tools available in Teamcenter, including the embedded viewer, the Lifecycle Viewer, and the standalone Lifecycle Visualization application, enable even nontechnical users to interpret design data, review product structure, and mark up issues for collaboration. Lifecycle Visualization is used to view documents, 2D drawings, 3D models, PCB layouts and animation playback, and provides virtual mockup, measurement, and spatial analysis capabilities in prototyping software for handling extremely large assemblies.

For information about product visualization, see the *Getting Started with Product Visualization*. 
Classification and reuse

Classification enables you to create a digital library of product definition data including information about your components, subassemblies and assemblies, documents, manufacturing tools and templates, work instructions, company policies, process definitions, standardized forms, data dictionary, and industry/government regulations. Hierarchical class definitions allow you to specify attributes and valid attribute values that are used to search for design elements for reuse in a new product or program.

For more information, see the Classification Guide.

CAE Data Management

CAE Data Management is a packaged solution that provides unique simulation process and data management capabilities for CAE engineers and CAE analysts performing analysis work. It includes:

- **CAE Manager**
  Enables you to create and manage engineering analysis data in Teamcenter.

- **CAE Structure Designer**
  Enables you to create and manage structure map rules, and generate and assemble filter, reuse, and include rules in a structure map file and save it as a dataset. You can reuse the structure map files or the filter, reuse, and include rules to generate consistent CAE model structures.

You can use CAE Data Management to manage and improve CAE processes by:

- Generating a CAE structure from a product structure including the complexity arising from multiple configurations or variants and solutions, or directly defining components and subsystems to be analyzed.

- Searching your existing knowledge base and enabling data reuse.

- Combining support for process workflows and program execution.

- Verifying the use of approved analysis procedures.

- Increasing access to performance information.

- Managing complex metadata associated with simulation including the solution parameters and results.

- Visualizing simulation results in a unique lifecycle simulation environment.

- Efficiently handling huge amounts of data associated with simulation.

For more information, see the Simulation Process Management Guide.
Repeatable Digital Validation

Repeatable Digital Validation (RDV) tools allow you to accurately model specific product assembly configurations and use the results with analytical and visualization tools to facilitate learning and decision making. You use these tools to create digital mockups of a product or part of a product, rather than having to create expensive physical models and mockups. You can filter product or product family data, so that the user only works in an area of interest and does not have to deal with the complexity of the full product.

For more information, see Getting Started with RDV.

Maintenance, repair, and overhaul

Teamcenter provides various applications to manage structure configurations and service process data:

- As-Built Manager provides the capability to manage the as-built configuration of an asset realized from a product definition structure.

- Service Manager supports as-maintained structure management and service event management capabilities within Teamcenter.

- Service Planner supports service planning capabilities within Teamcenter.

- Service Request Manager supports service request process management capabilities within Teamcenter.

- Service Scheduler provides the capability to define, schedule, and document service work.

As-Built Manager

As-Built Manager is a separately-licensed application that is installed as an optional overlay on top of the standard Teamcenter product. This application provides the capability to manage the as-built configuration of an asset realized from a product definition structure, such as a design or manufacturing structure, and extends the traditional lifecycle coverage beyond the manufacturing of a product. As-Built Manager provides the capability to:

- Capture as-built information, such as valid alternate or substitute parts, for the design or manufacturing structure.

- Create the as-built physical product instantiation for any configured product structure.

- Store and manage additional information about the as-built physical part structure that is not tracked on the product definition structure, such as serial numbers and lot numbers.

- Reconcile the as-built structure with a configured product definition structure to identify parts that are missing, alternate, or deviations.
How Teamcenter supports product life cycle phases

- Compare the as-built structure to the product definition structure or to another as-built structure.

- View the design product definition structure and the as-built physical structure configuration side-by-side through embedded visualization capability available in the rich client environment.

- Import an as-built structure from an external manufacturing execution system (MES) or an enterprise resource planning (ERP) system using PLM XML.

- Export an as-built structure to an Teamcenter maintenance, repair, and overhaul (MRO) system using data exchange.

For information about As-Built Manager, see the As-Built Manager Guide.

Service Manager

The Service Manager application supports as-maintained structure management and service event management capabilities within Teamcenter. As-maintained management is the base functionality of Service Manager and allows you to manage the as-maintained configuration of an asset over its lifetime. As-maintained structures are generated from, and validated against, product definition structures, such as design or planning structures. You can use the Service Manager as-maintained management to:

- Create the as-maintained physical product instantiation for any configured product definition structure.

- Store and manage additional information about the as-maintained physical part structure that is not tracked on the product definition structure, such as serial numbers and lot numbers.

- Reconcile the as-maintained structure with a configured product definition structure to identify parts that are missing, alternates, substitutes, or deviations.

- Track part utilization, part usage, and disposition history.

- Manage physical locations and the assets in those locations.

- Manually update the as-maintained structure with changes that occur over the lifetime of the physical asset.

- Compare the as-maintained structure to the product definition structure or to another as-maintained structure.

- View the as-designed product structure and the as-maintained physical structure configuration side-by-side or by using the embedded viewer available in the rich client.

- Import an as-maintained structure from an external manufacturing execution system (MES) or an enterprise resource planning (ERP) system in PLM XML.

- Manage as-maintained structures in a Multi-Site Collaboration environment.

For information about Service Manager, see the Service Manager Guide.
Service Planner

The Service Planner application supports service planning capabilities within Teamcenter. Service Planner is a separately licensed application that is installed as an optional overlay on top of the standard Teamcenter product. Service Planner lets users create and manage service plans, service requirements, work cards, activities, and other information to support the service planning process.

You can use Service Planner to:

- Create and manage service plans for a neutral product.
- Create service partitions within a service plan to organize service requirements.
- Create and manage service requirements to define the maintenance that can be performed on a product.
- Create service requirements to address particular fault codes.
- Define frequencies for service requirements to determine when the work needs to be done.
- Set up dependencies or relations between service requirements.
- Define applicability between service requirements and neutral parts.
- Create and manage work cards to determine how the work needs to be done.
- Manage the work process flow by sequencing work cards to be done in a particular order or determine work that can be done in parallel.
- Create and manage activities that provide more detailed information about the planned work.
- Create characteristic definitions and attach them to neutral parts, work cards, or activities to define data that should be recorded as part of the maintenance.
- Define the particular skill level needed to perform or sign off the service work.
- Define any expendable materials or tools needed to perform the service work.
- Create notices and attach them to work cards or activities to provide additional information, such as any notes, warnings, or cautions related to the planned work.
- Manage the time estimates for the planned work.
- Create and manage the work instructions.
- Import and export Service Planner data in PLM XML format.
- Manage Service Planner data in a Multi-Site Collaboration environment.

For information about Service Planner, see the Service Planner Guide.
Service Request Manager

The Service Request Manager application supports service request process management capabilities within Teamcenter. Service Request Manager lets service providers manage customer requests for service from initiation through completion. Service Request Manager is a separately licensed application that is installed as an optional overlay on top of the standard Teamcenter product and the Service Manager application.

You can use Service Request Manager to:

- Create and manage service catalogs and the individual standard service offerings contained in a service catalog.
- Capture service work requested by a customer through service requests.
- Define the scope of the service work by creating requested activities. Requested activities can be created from an existing service offering (catalog-based) or created as a stand-alone requested activity (noncatalog-based).
- Requalify a noncatalog-based requested activity to a service offering.
- Assign service work to roles by assigning participants.
- Assign work to external service organizations by delegating requested activities.
- Identify work that is a result of product or part discrepancy and capture details about those items through reported discrepancies.
- Manage approval and completion of service work through workflow and signoff process.
- Track estimated and actual time and cost of service work.
- Track status and history of service work.
- Manage service request processing in a Multi-Site Collaboration environment.

For information about Service Request Manager, see the Service Request Manager Guide.

Service Scheduler

The Service Scheduler application lets companies define, schedule, and implement service for their products. The maintenance scheduler can define a complete work scope including the schedule of work, breakdown of activities, the resources required, the work assignments, and the estimated cost and labor. After the work scope is defined, service technicians complete their activities. They can record required information identified within the work scope, request resources needed to do the work, record discrepancies found while completing the work, and sign off the work.

Using Service Scheduler, maintenance schedulers and service technicians can:

- Manually create work orders, schedules, job cards, and job tasks
- Assign people resources
Chapter 3  How Teamcenter supports product life cycle phases

- Schedule assignments
- Estimate cost and labor
- Manage schedules
- Define part requests for required materials, tools, and equipment
- Receive issued materials, tools, and equipment
- Complete work assignments and perform signoffs
- Capture start/stop times and work time
- Define part movement transactions to drive configuration updates
- Capture discrepancies discovered during implementation of service

For information about Service Scheduler, see the Service Scheduler Guide.

Teamcenter solutions

Teamcenter provides various products for specific industries:
- Consumer Packaged Goods
- Aerospace and Defense
- Automotive Edition
- Materials Management
- Substance Compliance

Consumer Packaged Goods

The Consumer Packaged Goods solution helps the consumer packaged goods and the food and beverage industries support the following areas:
- Brand management
  With brand management, you can classify and manage brands.
- Initiative management
  With initiative management, you can create and track initiatives such as package and artwork development.
- Finished product management
  Finished product management allows you to classify and manage finished products.
- Packaging and artwork
Packaging and artwork are the first things that a consumer notices on a product. Creating a package involves creating marketing briefs, design briefs, package roughs, copies, and so on (For a sample package and artwork design process, see *Getting Started with Consumer Packaged Goods*). With Teamcenter Consumer Packaged Goods solution, you can track and manage the steps in packaging and artwork creation.

- Interspec integration

Interspec is a specification management tool that can be integrated with Teamcenter. Using Specification Manager, you can view, query, and manage specifications created in Interspec.

For more information, see *Getting Started with Consumer Packaged Goods*.

**Aerospace and Defense**

The Aerospace and Defense solution provides data model extensions and features that you access through standard Teamcenter applications, such as My Teamcenter, Change Manager, Schedule Manager, and Structure Manager. The solution provides multiple industry-specific features that enable you to:

- Execute complex document-centric or part-centric development programs.
- Manage parts lists and standard parts.
- Use standard and custom notes to provide additional design details about parts and documents.
- Manage the program life cycle and its data, including program requirements, deliverable schedules, and related changes.
- Protect intellectual property and national security while promoting collaboration.

In addition, you can extend Teamcenter Aerospace and Defense solution with other Teamcenter capabilities including:

- Systems Engineering and Requirements Management
- Simulation Process Management
- Manufacturing Process Management
- Content Management
- Maintenance, Repair, and Overhaul

For more information, see the *Aerospace and Defense Solution Guide*.

**Automotive Edition**

Teamcenter Automotive Edition is a component of an industry-focused solution intended to meet the needs of design and manufacturing organizations within the automotive industry. Teamcenter Automotive Edition provides the GM Overlay installation that serves as a base implementation for automotive industry
users. Other customer-specific implementations can then be layered on top of the Teamcenter Automotive Edition overlay.

This guide provides an overview of the commercial Teamcenter Automotive Edition and GM Overlay features and how these are used by manufacturers and suppliers. This guide is for persons responsible for installing and configuring Teamcenter Automotive Edition and GM Overlay features and for those who use these features, specifically General Motors, its suppliers, and partners.

For more information, see Getting Started with Automotive Edition.

Materials Management

The Materials Management solution stores approved materials and substance information imported from a third-party database (for example, Granta, IMDS) into a materials library in the Teamcenter database. The materials and substances can also be created by a materials analyst.

By storing the materials in Teamcenter, the Teamcenter materials library is available for use by other Siemens PLM Software applications, rather than each application owning individual material libraries.

The Materials Management solution is required to support Substance Compliance. Materials Management provides the capability to designate the substance composition of materials, so that regulatory compliance reporting can be supported. For example, a Teamcenter part or BOM is sent to an external compliance checker to verify if the part or BOM is compliant with specific substance regulations.

For more information, see the Materials Management Solution Guide.

Substance Compliance

The Substance Compliance solution is an environmental compliance solution that enables companies to conform to environmental laws, regulations, standards, and other requirements for their own parts and for the parts manufactured or supplied from an external source.

Before sending a part or BOM for substance compliance check, the material and substance information must be available in the Teamcenter materials library. The material and substances are imported into Teamcenter by the materials analyst from an external materials library (for example, Granta, IMDS). Therefore, it is mandatory to install the Materials Management solution before installing the Substance Compliance solution.

For more information about managing materials, see the Materials Management Solution Guide.

The compliance officer role is provided in Substance Compliance to perform various tasks, such as requesting material substance declaration from suppliers, reviewing the material substance declarations received from the suppliers, and applying exemptions.

The compliance officer sends a request to the supplier for the material and substance declaration using the My Teamcenter user interface. The supplier enters the required information in the material and substance declaration and sends the declaration back to the compliance officer. On receiving the declaration from the supplier, the compliance officer reviews it. After reviewing the declaration, the
How Teamcenter supports product life cycle phases

compliance officer can either approve or reject the declaration. From Teamcenter, the compliance officer sends a part or BOM to the Compliance Process Manager (CPM) to verify if the part or BOM is environmentally compliant. The CPM sends the compliance result to Teamcenter.

For more information, see the *Substance Compliance Solution Guide*.

**Dimensional Planning and Validation (DPV)**

Siemens PLM Software provides Tecnomatix Dimensional Planning and Validation (DPV), a quality management solution you can easily integrate into your Teamcenter environment. DPV enables the extended enterprise to collect, manage, dimensionally analyze, and report on quality measurement information. This report generation solution provides rapid access to design and manufacturing information that directly influence's your enterprise's quality targets.

DPV provides you with:

- Enterprise-wide visibility to quality information.
- An integrated definition of your measurement process coordinated with product design, manufacturing planning, and plant layout.
- In-depth analysis of captured measurement information.
- Associative reporting, with initial and updated reports.
- Historical and summary measurement reporting.

For more information, see *Dimensional Planning and Validation Tutorial*.

**Electronic Design Automation (EDA)**

Teamcenter EDA (Electronic Design Automation) integrates ECAD (Electronic Computer Aided Design) applications with Teamcenter to allow designers to manage their ECAD design, BOM, and related library data in Teamcenter.

Teamcenter allows two types of EDA integrations:

- **ECAD design integration**

  This includes design tool integrations (Mentor Board Station, Cadence Allegro, Mentor PADS, Cadence OrCAD, Mentor Expedition, and Altium Designer).

- **ECAD part library integration**

  This includes library integrations (Mentor Board Station, Cadence Allegro, and Mentor Expedition).

Both these integrations are separate functionalities and run separately. They can be installed either together or separately depending on your requirement.
Note Teamcenter EDA is separately licensed and distributed.

For information about Electronic (EDA) Lifecycle Management documentation, contact the Global Technical Access Center (GTAC):


Data sharing

Teamcenter provides various capabilities to share data among the following products:

- Data Exchange provides data mapping, transfer, and synchronization between Teamcenter and Teamcenter Enterprise sites.

- Data Exchange provides data mapping, transfer, and synchronization between Teamcenter and Engineering Process Management sites.

- Data Exchange provides data transfers between OEM and supplier sites that:
  - Use Teamcenter (managed sites) but are not connected to the OEM Teamcenter environment through offline transfers of briefcase files.
  - Do not have Teamcenter (unmanaged sites) but use Briefcase Browser to access Teamcenter data in briefcase files.

- Global Services provides data transfers between various data sources, including third-party software such as JBDC databases.

- Multi-Site Collaboration provides data sharing and data synchronization between Teamcenter sites or between Teamcenter sites and Engineering Process Management sites.

- PLM XML data can be imported and exported for non-Teamcenter sites.

Additionally, Data Exchange supports exporting data in PDX format and can import and export to any system that supports TC XML format.

Data Exchange

Data Exchange allows you to transfer data between differing systems. This capability allows you to transition existing data from a different system to Teamcenter. The following terms are important in understanding transition between products.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transition</td>
<td>A high-level term for moving data and users from one solution platform to another.</td>
</tr>
<tr>
<td>Upgrade</td>
<td>Refers to updating a platform from one release level to another or to a new platform where the effort to transition is consistent with a release level upgrade.</td>
</tr>
</tbody>
</table>
How Teamcenter supports product life cycle phases

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coexistence</td>
<td>A deployment environment where business process solutions are split across one or more platforms, but share, reuse, or otherwise enable programs based on either platform.</td>
</tr>
<tr>
<td>Integration</td>
<td>The technical aspect of coexistence in the context of transition.</td>
</tr>
<tr>
<td>Migration</td>
<td>A method of rapidly transitioning from one solution platform to another. Time is the major discriminator as compared to coexistence.</td>
</tr>
</tbody>
</table>

Coexistence with Teamcenter Enterprise supports:

- Transfer of metadata, JT, and other files.
  - Bidirectional operation
  - Transfer of CAD from Teamcenter Enterprise to Teamcenter
  - Transfer of JT from Teamcenter to Teamcenter Enterprise

- Variability of data models on both ends.
- Transfer of ownership or modification rights.
- Batch and event based transfers that are scheduled, from a workflow, or user initiated.

Coexistence with Engineering Process Management supports:

- Adding new Teamcenter production sites or upgrading existing Engineering Process Management sites in a progressive fashion that shares data across these environments.
- Integrating Teamcenter into a supply chain where partners can use either Teamcenter or Engineering Process Management.

The Data Exchange Briefcase functionality supports:

- Non-networked Teamcenter to Teamcenter data sharing.
- Variability of data models on both ends.
- Transfer of metadata, JT, and CAD data (NX, CATIA, and Pro/ENGINEER).

Note: Data Exchange currently is not a full replacement of Multi-Site Collaboration for companies exchanging other types of CAD data or manufacturing data.

- Export of PDX data for use by applications supporting this format.
- For non-Teamcenter suppliers, data import and export in PLM XML format.
Data Exchange also provides online tracking of active and scheduled data transfers, graphical mapping between schemas, and process flow control using Business Process Execution Language (BPEL).

**Global Services**

Global Services is the foundation for Data Exchange support for coexistence. It also provides the following capabilities:

- Real-time data aggregation
- Data publishing across dissimilar systems (loosely coupled integrations such as Teamcenter to Teamcenter Enterprise)
- Replication and synchronization across like systems (Multi-Site object-level replication)

**Multi-Site Collaboration**

Multi-Site Collaboration enables you to share synchronized product information with geographically dispersed partners and suppliers who work with Teamcenter. Multi-Site Collaboration enables multiple sites that maintain different business rules to exchange product definitions while retaining their local autonomy, as well as allowing the exchange of data with users outside your enterprise.

A central database maintains a record of every information object that you intend to share across the Teamcenter network. This record indicates the database in which the objects reside, as well as attributes that you can reference to narrow your database searches. Objects are shared by publishing the object in the central database by indicating which sites are authorized to import the object.

For more information, see the *Multi-Site Collaboration Guide*, the *Preferences and Environment Variables Reference*, and the appropriate installation guide for your platform.

**PLM XML**

PLM XML supports the export and import of Teamcenter objects, such as items, datasets, BOMs, forms, and folders, as well as system data, such as business rules and organization data.

In PLM XML/TC XML Export Import Administration, you create transfer mode objects that define the import or export context by applying closure (traversal) rules, filter rules, action rules, and property set rules to the input or output of objects and system data. These rules can be a static set stored in the database or they can be applied only to a specific session. Rules stored in the database can be imported and exported.

PLM XML/TC XML Export Import Administration also references Extensible Stylesheet Language Transformations (XSLT) files that describe how to transfer the source tree or data structure of an XML document into the result tree for a new XML document, which may be completely different in structure, and can be stored with the transfer mode objects and applied as a post-export or pre-import operation.

**Note** The PLM XML framework does not support XSLT file validation; therefore, it is the implementor’s responsibility to ensure valid XSLT format.
A product data management (PDM) system is used to store and retrieve data within a certain context. The context helps define how the data is used, filtered, and transformed. To accomplish this, the PDM system must have the capability to export and import data. In Teamcenter, this is done using the PLM XML import export framework with the various applications written to capitalize on this layer.

One important aspect of data translation is that each translation has a unique purpose and scope. The purpose is associated to a business function and the application-specific interaction with the PDM system. Each instance of a translation is unique and different. A translation must be managed to support its mode of transfer, the traversal of data desired, the filtering of the data to be done and actions to apply to the translation. The PLM XML import export framework supports these unique translations. However, in Teamcenter-to-Teamcenter transfers, do not use PLM XML as a data synchronization mechanism to keep the structure modifications at both sites synchronized. PLM XML export cannot capture all of the edits made on a product structure at the source site. The exported PLM XML file only captures a snapshot of the product structure, so the repeated process of exporting from the source site and importing at the destination site causes unexpected results (the structures at both sites will not be synchronized). In these situations, use classic Multi-Site.

Another important aspect of data translation is managing the mapping between the PDM data and the PLM XML standard entity schema for reading the data in and out. In the PLM XML import export framework, data entities are mapped using a known set of correspondence, where most data is automatically translated by the PLM XML import export module. The PLM XML import export module supports application extensibility for additional data translations.

For the mapping between PLM XML entities and Teamcenter entities, see the PLM XML/TC XML Export Import Administration Guide.

PLM XML is the interoperability mechanism for many products (internal and external). There are a variety of PLM XML representations available to represent the same data. For example, product structure can be represented by normal PLM XML export files from Teamcenter (ProductView and ProductDef, for example). These files can be used to import the same product structure to another Teamcenter instance. They can also be used by files exported using the bomwriter utility (mainly used for Lifecycle Visualization; these files cannot be imported). Before attempting to import a file to Teamcenter, determine the source of the file. If it is exported by another Teamcenter site or an application that matches Teamcenter exported files, it is a good candidate for import to Teamcenter.

**Note** In a multiuser environment, when multiple users initiate import on the same data simultaneously (for example, multiple users updating the same assembly), only one is successful. The other users get a locking message (objects are locked by different user in different session).

**Note** PLM XML cannot be used to share organization objects that are shared through global organization (Multi-Site).

For more information, see the Multi-Site Collaboration Guide.
# Chapter 4 Common Teamcenter tasks

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common Teamcenter tasks</td>
<td>4-1</td>
</tr>
<tr>
<td>Viewing online help</td>
<td>4-1</td>
</tr>
<tr>
<td>What help formats are available?</td>
<td>4-2</td>
</tr>
<tr>
<td>Access the help library</td>
<td>4-3</td>
</tr>
<tr>
<td>Access information about Teamcenter</td>
<td>4-3</td>
</tr>
<tr>
<td>Access help for the current application</td>
<td>4-4</td>
</tr>
<tr>
<td>Navigating the help collection (HTML)</td>
<td>4-4</td>
</tr>
<tr>
<td>Access Teamcenter PDF files</td>
<td>4-6</td>
</tr>
<tr>
<td>Search the PDF collection</td>
<td>4-6</td>
</tr>
<tr>
<td>Viewing your Teamcenter PDF documentation on the iPad</td>
<td>4-7</td>
</tr>
<tr>
<td>Working with data objects</td>
<td>4-10</td>
</tr>
<tr>
<td>Teamcenter data objects</td>
<td>4-10</td>
</tr>
<tr>
<td>Working with folders</td>
<td>4-14</td>
</tr>
<tr>
<td>Home, Newstuff, and Mailbox folders</td>
<td>4-14</td>
</tr>
<tr>
<td>Managing basic data</td>
<td>4-15</td>
</tr>
<tr>
<td>Searching in Teamcenter</td>
<td>4-15</td>
</tr>
<tr>
<td>Creating data</td>
<td>4-16</td>
</tr>
<tr>
<td>Cutting, copying, pasting, and deleting data objects</td>
<td>4-17</td>
</tr>
<tr>
<td>Dragging and dropping data objects</td>
<td>4-18</td>
</tr>
<tr>
<td>Add favorites to organize your data</td>
<td>4-19</td>
</tr>
<tr>
<td>Using projects to organize data</td>
<td>4-20</td>
</tr>
<tr>
<td>Overview of object properties</td>
<td>4-20</td>
</tr>
<tr>
<td>Working with relation properties</td>
<td>4-21</td>
</tr>
<tr>
<td>Overview of checkout and checkin</td>
<td>4-22</td>
</tr>
<tr>
<td>Explicit checkout</td>
<td>4-22</td>
</tr>
<tr>
<td>Implicit checkout</td>
<td>4-23</td>
</tr>
<tr>
<td>Identify the checkout owner of an object</td>
<td>4-24</td>
</tr>
<tr>
<td>Check out an object</td>
<td>4-24</td>
</tr>
<tr>
<td>Check in an object</td>
<td>4-26</td>
</tr>
<tr>
<td>Transfer checkout to another user</td>
<td>4-27</td>
</tr>
<tr>
<td>Cancel a checkout request</td>
<td>4-27</td>
</tr>
<tr>
<td>View the checkout history of an object</td>
<td>4-28</td>
</tr>
<tr>
<td>Providing notification of changes in checkout status</td>
<td>4-28</td>
</tr>
<tr>
<td>View the notification list for an object</td>
<td>4-28</td>
</tr>
<tr>
<td>Managing object protection</td>
<td>4-29</td>
</tr>
<tr>
<td>Rules-based protection</td>
<td>4-29</td>
</tr>
<tr>
<td>Object-based protection</td>
<td>4-30</td>
</tr>
</tbody>
</table>

Using 4th Generation Design                                             | 4-31 |
Managing product structures ........................................... 4-33
  Repeatable Digital Validation ....................................... 4-34
  Managing manufacturing data ...................................... 4-35
  Managing Mechatronics data ....................................... 4-35
  Managing publications ............................................. 4-36
  Visualizing your product data ..................................... 4-36
    Translating documents to derived output formats ............. 4-37
    Previewing 2D and 3D images ................................... 4-37
    Classifying parts and components ............................... 4-38

Managing changes .................................................... 4-38

Using workflow processes ........................................... 4-39

Importing and exporting data ....................................... 4-39
  Importing objects ................................................ 4-40
    Import a Teamcenter object .................................... 4-41
    Import a STEP file ............................................. 4-41
    Import data from a PLM XML file ............................... 4-42
  Exporting objects ................................................ 4-43
    Export an object ................................................ 4-43
    Export objects in STEP format ................................. 4-43
    Export objects in PLM XML format ............................. 4-44
    Export objects using application interface mode ............ 4-44

Running reports ...................................................... 4-45

Using mail, e-mail, and instant messaging in Teamcenter ....... 4-46
  Sending and receiving Teamcenter mail ......................... 4-47
    Send a mail message ........................................... 4-47
    Receiving and reading mail .................................... 4-48
    Address lists .................................................. 4-48
      Create an address list ....................................... 4-49
      Modify an address list ...................................... 4-50
      Delete an address list ...................................... 4-50
Chapter

4 Common Teamcenter tasks

Common Teamcenter tasks

You perform Teamcenter tasks using a client. The most commonly used clients are the rich client and the thin client.

The Teamcenter thin client is a browser-based interface you can use to navigate to various Teamcenter objects and functions.

- Access is available to the same Teamcenter server and data as the rich client uses.

- No thin client software is required on a Teamcenter client.

You can use the thin client interface to perform many of the same tasks you can perform in the rich client interface. However, there are fewer distinct applications available in the thin client, and administrative tasks cannot be performed in this interface.

The Teamcenter rich client, a platform-independent client implementation (Java application) for users who interact frequently with Teamcenter, runs on client hosts and serves as a gateway to your company’s product information. It provides a broad selection of application perspectives and views to manage your product information.

Administrators can use the rich client to:

- Implement and manage data access and security.

- Configure behavior when objects are created, saved, and revised.

- Create workflow templates.

End users can use the rich client to:

- View and work with assemblies.

- Create, locate, revise, and save workspace objects.

- Check in and check out workspace objects.

- Perform and manage workflow tasks.

Viewing online help

Teamcenter provides help for each application, as well as a series of getting started guides.
Teamcenter help is provided as online help files in HTML format and in PDF format.

- The Teamcenter HTML help collection must be installed and configured before it can be viewed.

For more information about installing and configuring online help, see the appropriate server installation guide (for Windows or UNIX/Linux) and Teamcenter Environment Manager Help.

- The Teamcenter PDF help collection can be viewed from the documentation distribution media or installed on a Teamcenter host, and PDF files can be copied to a mobile device (such as an iPad or Android tablet) or printed for reading offline.

**What help formats are available?**

Teamcenter help is delivered in two formats: HTML and PDF. Each format has its own advantages.

- HTML (HyperText Markup Language) has the look and behavior typical to Web pages; small chunks of information extensively linked to other chunks of information. HTML lends itself to quickly reading, copying, and sharing smaller chunks of information, such as stepped procedures.

  The HTML directory on the documentation installation media contains HTML versions of the manuals.

  The Teamcenter online help requires a Web browser that supports Java for the search to work. The browser version and Java specification required for online help depends on the operating system you are using.

  For information about supported browsers and Java versions for your operating system, see the Siemens PLM Software Certification Database:

  http://support.industrysoftware.automation.siemens.com/certification/teamcenter.shtml

**Note** Several features of the online help system require the display of popup windows; for example, searching the online help collection and viewing graphics. If a popup blocker utility is installed on the Web server or client workstation, you must configure the utility to allow popup windows from the online help domain. Otherwise, the online help system does not function correctly.

- The advantage of PDF (Portable Document Format) is its portability. Readers can easily e-mail entire deliverables to others and save the PDFs to other devices (such as an iPad or Android tablet) for use in locations without Internet connectivity. It is also easy to print chapters or entire documents with PDF.

  The PDF directory on the documentation distribution media contains Adobe PDF versions of the Teamcenter online help. From this directory, open the index.htm file in a Web browser to view the Teamcenter PDF Help Collection. You can view, search, and print individual guides or selected pages from within your Web browser.

  To search the entire PDF collection, click the Search button in the Teamcenter PDF Help Collection page. This launches Adobe Reader and loads
the search index for the collection. In the Search dialog box in Adobe Reader, type the text you want to find.

You can view these guides using Adobe Acrobat Reader, which you can download free from Adobe at http://www.adobe.com.

If you want to share the PDF collection on your network, extract the PDF.zip from the documentation distribution media to a network location and set file permissions as necessary to allow viewing.


- If you share the Teamcenter PDF Help Collection on a Web (HTTP) server, you cannot search the entire PDF collection. The collection search functionality works only when you share the PDF collection from a file system location. For collection search capability, access the PDF collection in a Web browser using a URL with FILE protocol, for example:
  - Local host: file:///D:/PDF/index.htm
  - Network host (UNC path): file:///host/PDF/index.htm

- If you want to open PDF files directly, browse the PDF\pdf directory (Windows systems) or the PDF/pdf directory (UNIX/Linux systems) on the documentation distribution media. To open the PDF collection search, open the PDF index file, tchelp.pdx, in this directory. This launches Adobe Reader and loads the search index for the collection.

For a demonstration of the help interface features, see the Teamcenter Help Tour.

For more information about viewing Teamcenter PDF files on the iPad, see Viewing your Teamcenter PDF documentation on the iPad.

Access the help library

- The Teamcenter HTML help collection must be installed and configured before it can be viewed.

For more information about installing and configuring online help, see the appropriate server installation guide (for Windows or UNIX/Linux) and Teamcenter Environment Manager Help.

- In the rich client, choose Help→Help Library or press Ctrl+F1 to access the full library.

- In the thin client, choose Help→Help Library to access the full library.

Access information about Teamcenter

- In the rich client, choose Help→About.
The system displays information about Teamcenter, including information about plug-ins and configuration details.

- In the thin client, choose **Help→About Teamcenter**.

**Access help for the current application**

- In the rich client, choose **Help→Current Application** or press the F1 key to display help for the currently active view in the current application.

- In the thin client, choose **Help→Current Application** to access help for the thin client current application.

  **Note** You can also choose **Help→Thin Client Interface Guide** to access the *Thin Client Interface Guide*.

**Navigating the help collection (HTML)**

The Teamcenter help system includes:

- Toolbars for navigating and searching the help collection and for providing feedback about information in the help topics.

- A search results page in the same browser to reduce window clutter.

- Breadcrumb links on each page to help you track your location.

- A **Topics** (table of contents) pane that lists all help deliverables and provides sequential navigation through the topics and access to all specific topics in the help collection.

  - To move through topics page-by-page, click an entry in the table of contents and then press the down arrow. This displays the next topic and expands collapsed hierarchies as you proceed.

  - To hide or show the **Topics** pane, click the **Show/Hide topics** button.

- A topic content pane that displays topic information.

- Links to related information.
1 Navigation toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📚</td>
<td>Displays the table of contents.</td>
</tr>
<tr>
<td>🏠</td>
<td>Returns you to the home page.</td>
</tr>
<tr>
<td>➡️</td>
<td>Lets you navigate back through the hierarchy of help categories.</td>
</tr>
<tr>
<td>🎨</td>
<td>Prints the current page.</td>
</tr>
</tbody>
</table>

2 Search toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔍</td>
<td>Displays search results. The <strong>Search</strong> box is available on every page.</td>
</tr>
<tr>
<td>🔻</td>
<td>Displays previous search terms.</td>
</tr>
</tbody>
</table>

**Advanced Search** Displays the advanced search page.

- Type text for your search in the **Search** box.
- Click **Advanced Search** to set search behaviors and filter search areas. Search tips are available in the advanced search page.
Chapter 4  Common Teamcenter tasks

• To return to the search results page, use your browser’s Back button or click Search again.

Note  To search within an extensive topic, such as the glossary, use the browser Find command, for example, Ctrl+F in Windows Explorer or Cmd+F in the Safari browser.

3  Feedback toolbar

Was this information useful?  

✔️  ❌  ❌  Lets you send feedback about content.

Access Teamcenter PDF files

You can access Teamcenter PDF files directly from the documentation distribution media or from the location where you installed the PDF files using Teamcenter Environment Manager (TEM).

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unzip PDF files from the PDF.zip file</td>
<td>Locate the PDF.zip file in the documentation distribution media and extract it to a directory on your hard disk.</td>
</tr>
<tr>
<td>(This is required if you have not installed the PDFs using TEM.)</td>
<td></td>
</tr>
<tr>
<td>Access PDF files from the Teamcenter PDF launch page</td>
<td>Open the index.htm file in a browser to launch the PDF collection.</td>
</tr>
<tr>
<td>Access a PDF file directly</td>
<td>Locate the guide you want and open the PDF file.</td>
</tr>
</tbody>
</table>

Search the PDF collection

You can search individual PDF files or search the entire Teamcenter PDF collection. The procedure you use depends on how you are accessing the PDF files.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search individual PDF files</td>
<td>Use the search feature within Acrobat when you are accessing a PDF file from the PDF collection launch page or directly from the storage location.</td>
</tr>
</tbody>
</table>
To | Do this
---|---
Search all PDF files | When you are accessing a PDF file from the PDF collection launch page, the full search feature is available only if your access is based on a file system location (rather than a Web (HTTP) server location):
   - Click the Search button in the Teamcenter PDF Help Collection page.

   This launches Adobe Reader and loads the search index for the collection. In the Search box in Adobe Reader, type the text you want to find.

When you are accessing PDF files directly from the installed location or from the documentation distribution media:

1. Open the PDF index file, `tchelp.pdx`.
   This launches Adobe Reader and loads the search index for the collection.

2. Type the text you want to find in the Search box in Adobe Reader.

Using Acrobat Full Text Search | 1. Click the arrow next to the search text box and choose Open Full Reader Search, or type Ctrl+Shift+F to open Full Reader Search.

2. At the bottom of the Search dialog box, click Show More Options.

3. Under Look in, choose Select Index.

4. In the Index selection dialog box, click Add.

5. Browse to the PDF\pdf directory, select the `tchelp.pdx` file, and then click OK.

6. Type the text you want to find.
   Search results are displayed in the Results box.

   The steps may vary if you use Full Reader Search in an Adobe Acrobat product other than Acrobat Reader.

Viewing your Teamcenter PDF documentation on the iPad

You can view your Teamcenter PDF documentation using Apple’s iBooks mobile application on the iPad. iBooks allows you to:

- Perform searches.
• Bookmark pages.
• Change the size of the page.
Working with data objects

Teamcenter uses data objects to represent your product data, such as parts, assemblies, processes, product changes, requirements, and specifications. These objects are stored in one or more database and can be shared with users across your enterprise.

- Access to your data is controlled by access rules that are applied to the data objects.

- The integrity of your data is protected by the managed check-in/check-out features that allow you to lock other users out of work that is in process, allowing them to view but not modify the information.

Teamcenter data objects

The following table describes the most commonly used Teamcenter objects. This list is not exhaustive; data objects are introduced in other guides throughout the Teamcenter library.
For information about working with objects in a Teamcenter client, see the appropriate client guide.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folders</td>
<td>Folders are data objects that you use to organize product information. Folders can contain any other information object, including other folders.</td>
</tr>
<tr>
<td>Items and item revisions</td>
<td>Items and item revisions are the fundamental objects used to manage information in Teamcenter. Items can be single parts or structures that represent a product, part, or component. Items can contain other data objects, including other items and folders. Item revisions are used to manage changes (revisions) to your product information.</td>
</tr>
<tr>
<td>Relations</td>
<td>Relations associate objects. For example, datasets (secondary objects) are associated with item revisions (primary objects) using relation objects. The meaning of the secondary object can vary from one context to another.</td>
</tr>
<tr>
<td>Item and item revision relations</td>
<td>Enterprises typically use many pieces of information that in some way describe or relate to an item or item revision. Relations define the relationship between the item or item revision and the attached data.</td>
</tr>
<tr>
<td>Relation properties</td>
<td>Relation properties record information specific to the association or context in which the object is used.</td>
</tr>
<tr>
<td></td>
<td>• You can create relations between objects, modify the properties of those relations, delete relations, and create saved queries based on relation business object attributes.</td>
</tr>
<tr>
<td></td>
<td>• Your administrator can create custom attributes (properties) to apply to relation business objects in the system. A single item can be associated to multiple items or contexts. Objects are associated by relations, and the meaning of the relation can vary from one context to another.</td>
</tr>
<tr>
<td>Datasets</td>
<td>Datasets are data objects that manage data files created by other software applications. Each dataset references at least two other objects: a dataset type that contains a list of tools that can operate on the dataset, and a tool that is used to create or modify the dataset. Each dataset can manage multiple operating system files. Each type of operating system file is called a named reference.</td>
</tr>
</tbody>
</table>
Object Description

Dataset relations Datasets are typically related to part and assembly items and item revisions, and an assembly in Teamcenter can have many related datasets.

For example, an assembly can have any of the following dataset relations, among others:

- Requirements criteria are related through the Requirements relation. Criteria specify maximum weight or specific dimensions, for example, but not how the assembly is constructed.

- Design instructions are related through the Specification relation. These datasets describe methods, designs, processes, or procedures used to satisfy the requirements.

- Test plans are related through the Attaches relation. Test plans specify the test details exercised against the assembly before it is production ready.

- Assembly instructions are related through the attaches relation. These provide instructions for assembling components to create a part.

- CAD parts are related through an IMAN_Drawing relation. This dataset is created by a CAD tool such as NX.

- 3D visualization models are related through the 3DMarkup relation. This file is typically created in a third-party CAD tool like NX.

- Field reports are related through the Reference relation. These reports can provide various kinds of information, such as how the assembly is performing in production.

In My Teamcenter in the rich client, use the Details view to see related items; the Relation column displays the name of the relation for each related dataset.

You can also sent objects to the Relation Browser application to explore relations graphically and to use the Properties view to list object attributes.

Forms and master forms Forms and master forms are data objects that display specific product information (properties) in a predefined template. Forms are often used to create a digital facsimile of an existing hard copy form. Master forms are used to display specific product information in a standardized format.
<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOM view and BOM view revisions</td>
<td>BOM views are used to manage product structure information related to items. BOM view revisions are used to manage product structure for item revisions.</td>
</tr>
<tr>
<td>Address lists</td>
<td>An address list is any combination of valid users, groups, and/or external e-mail addresses.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelopes are objects used to represent Teamcenter mail messages sent to you from other Teamcenter users. Envelopes can be used to send object references as well as simple text messages to other Teamcenter users. This is useful for throughout your enterprise.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The capability to send an envelope is available in Teamcenter in the rich client but not in the thin client.</td>
</tr>
<tr>
<td>Aliases</td>
<td>Alias objects allow you to store items and item revisions in the Teamcenter database according to the naming conventions used by non-Teamcenter user communities.</td>
</tr>
<tr>
<td>Alternate identifiers</td>
<td>Alternate identifiers store information about part numbers and attributes of the same part from different perspectives. They allow different user communities to identify and display an item or item revision according to their own rules rather than according to the rules of the user who created the object.</td>
</tr>
<tr>
<td>Design element</td>
<td>A design element is a representation of a component in the context of the product. Design elements typically include geometric data and are authored by CAD users in NX.</td>
</tr>
<tr>
<td>Subset</td>
<td>A subset is collection of design elements and a search recipe that, when configured, yield a precise definition of those design elements. The search recipe contains one or more search terms that locate the content of the subset definition.</td>
</tr>
<tr>
<td>Workset</td>
<td>A workset is a composition of design content from collaborative designs and item structures. A workset provides local references to subset definitions and assemblies in an isolated space to update in a location that is unaffected by updates other users may make. It may contain subsets or item assemblies as its direct children.</td>
</tr>
</tbody>
</table>
# Chapter 4  
*Common Teamcenter tasks*

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition</td>
<td>A partition is an element in a collaborative design that organizes and groups other elements as part of a hierarchical breakdown. Partitions are organized hierarchically into schemes and each partition scheme references a partition breakdown. Partitions are then added in the context of a selected scheme. Administrators use partition schemes to control the types of child partition that you can add to a partition.</td>
</tr>
<tr>
<td>Changes</td>
<td>Change objects, including change orders and change requests, allow you to manage changes to a product definition and configuration.</td>
</tr>
<tr>
<td>Collaboration contexts</td>
<td>A collaboration context is a project folder or directory that contains shared data. This data may be shared between Teamcenter users or between Teamcenter itself and an external application. It can contain references to any other item in Teamcenter and to shared items that may be modified by Teamcenter or an external application.</td>
</tr>
<tr>
<td>Structure contexts</td>
<td>A structure context is a BOM or assembly structure contained in a collaboration context. The structure context can contain occurrence groups, items, and item revisions.</td>
</tr>
</tbody>
</table>

## Working with folders

Folders are a flexible way to organize your product information. Folder objects can contain references to other objects and/or other folders.

Use Teamcenter to:

- Create a new folder.
- Rename a folder.
- Move a folder.
- Print a folder.
- Delete a folder.

## Home, Newstuff, and Mailbox folders

The My Teamcenter application always contains the three default folders: **Home 🏡**, **Mailbox 📩**, and **Newstuff 📦**. These folders are automatically created by the system.
• **Home 🏡**
  The objects you want to work with in the My Teamcenter application can be placed within your **Home** folder or within some folder structure beneath the **Home** folder.

• **Mailbox 📬**
  The **Mailbox** folder is the receiving point for any Teamcenter mail that has been sent to you. When you receive new Teamcenter mail, you see an envelope object in your **Mailbox** folder.

  For information about using Teamcenter mail, see the **My Teamcenter Guide**.

• **Newstuff 🌟**
  The **Newstuff** folder is the default folder for newly created database objects. You can designate other folders as the default location for newly created database objects. Objects remain in a folder until you move or remove them.

  **Note** You can move through topics in a page-by-page manner by clicking an entry in the table of contents, and then pressing the down arrow. This displays the next topic, and even expands collapsed hierarchies as you proceed.

### Managing basic data

You can use Teamcenter to manage basic data, such as searching for your work, navigating the user interface, creating and printing data, running reports, and classifying parts and components.

**Searching in Teamcenter**

The Teamcenter search functionality lets you find data in the Teamcenter database and, optionally, in a related Autonomy index search engine database.

The **Quick Search** feature in the navigation pane lets you search for data by specifying the dataset name, item ID, item name, or a keyword.

**Note** Quick search results cannot be saved to your saved searches list.

You can use saved queries to search for your work in the Teamcenter database or in databases that are part of a Multi-Site Collaboration network. Saved queries are grouped into three categories:

• **My Saved Searches**
  This category contains queries that you ran previously and chose to save for later use.
You can save the results of a search and add the search to your **My Saved Searches** list. In both the rich client and thin client, you can share a saved search. In the rich client, you can restrict sharing to specified groups of users.

- **System Defined Searches**
  This category contains both standard queries and custom queries defined by your Teamcenter administrator. Standard queries allow you to search by common parameters such as item identifier. Custom queries allow you to search for data that is unique to your site or company.

- **Search History**
  This category contains the most recently run queries. By default, the last eight queries are listed, but you or the administrator can change the number of queries shown.

In the rich client:

- The **Search** view lets you use queries created in the Query Builder application to search Teamcenter databases for metadata and full-text search indexes.

- The **Simple Search** view lets you create searches based on business object property values.

- In the **Impact Analysis** view in My Teamcenter, you can perform *where-used* searches and *where-referenced* searches. Where-used searches enable you to identify all assemblies that contain a particular item or item revision. Where-referenced searches determine where a part or component is referenced within the Teamcenter database.

  **Extended Multi-Application Search** lets you run *classification searches* to search a classification hierarchy by using familiar criteria, such as name or ID. If you classify parts or equipment into hierarchies with the Classification application, you can search in a particular hierarchy or to search through all hierarchies.

For more information about performing searches in the rich client, see the *Rich Client Interface Guide*.

For more information about performing searches in the thin client, see the *Thin Client Interface Guide*.

For more information about Classification searches, see the *Classification Guide*.

### Creating data

Data managed in Teamcenter is represented by:

- **Items**
  Represent parts, components, documents, or products.

- **Item revisions**
  Iterations of items that reflect a change in the form, fit, or function of the part, component, or product.

- **Datasets**
Manage files created by other software applications, for example visualization files, text files, and Word documents.

- **Design elements**
  Represent CAD designs.

Forms associated with items and item revisions enable you to store information about your data that can be used by people throughout your organization.

Teamcenter supports document creation and management using item revision definition configuration objects (IRDC) configured by your Teamcenter administrator. The IRDC specifies behavior when a new item is created, including whether a document management template is applied. The IRDC also specifies behavior when an item is checked in, checked out, copied, or revised.

You can render and translate document revisions and datasets for Microsoft Office dataset types, such as **MSWord**, **MSExcel**, **MSPowerPoint**, and **MSPProject**, to a variety of other derived visualization formats, such as Adobe PostScript, Adobe PDF, and TIF. Translation can be configured to be activated by events, workflow steps, or user actions.

For information about rendering dataset files, see the *My Teamcenter Guide*.

For more information about configuring document translation, see the *Business Modeler IDE Guide*.

**Cutting, copying, pasting, and deleting data objects**

You can use cutting, copying, and pasting to move data in your workspace by:

- Cutting an information object from one application and pasting it into another Teamcenter application.

- Copying data to the clipboard and pasting it into another Teamcenter application.

- Copying data to the clipboard and pasting it into an application outside the Teamcenter environment.

If you have delete permission for an object, you can also delete data from the Teamcenter database, but you cannot delete an object from the database if that object is referenced in multiple locations.

To delete an object from the database, you may need to:

- Perform a where-referenced search to locate all references to the object.

- Contact all the owners of the references and ask them to delete their references to the object.

- When there are no remaining references, you can delete an object for which you have delete permission.

**Note** An object contained in multiple folders can be deleted by a single action if the object is not referenced by other nonfolder objects.
Drag and dropping data objects

In situations where drag-and-drop capabilities are supported by the current application, you can move data in the Teamcenter rich client by:

- Dragging a data object from one location to another.

  For example, you can add an item to your favorites list by selecting it in My Teamcenter and dragging it to the **Favorites** area in the navigation pane.

  **Note** When you drag and drop an object in a structure management application such as Structure Manager, the system makes a copy of the object in the new location and does not move the original object.

  When you drag and drop an object in a manufacturing application such as Manufacturing Process Planner, the system moves the object to the new location and does not make a copy of the original object.

- Dragging a data object from one application to another application.

  For example, you can add an item revision to an assembly structure. Select the item revision in My Teamcenter and drag it to the appropriate position in an assembly structure open in a Structure Manager pane.

  **Note** Drag-and-drop capabilities vary by rich client application. For example:

  - In the My Teamcenter **Summary** view, you can drag and drop a dataset file on the view header to attach the dataset to the currently selected item revision object.

  - In the My Teamcenter **Viewer** view, drag-and-drop capabilities are not available for dropping dataset files on the view header.

  - In Structure Manager, if you drag and drop a dataset onto a BOM line, the dataset is not attached, although it is created in the **Newstuff** folder.

  - In the **Systems Engineering** view, drag-and-drop capabilities are not available for dropping dataset files onto a BOM line.

You can also open applications by dragging an object and dropping it on the application button in the navigation pane.

For example, you can drag an item revision representing a subassembly from the My Teamcenter tree and drop it on the Structure Manager button in the navigation pane. The system opens the Structure Manager application and shows the subassembly structure.

You can select multiple files and use drag and drop to link them to a business object. For each file a dataset is created and linked to the item revision.

- When you drop files on an item in Teamcenter, the **Multiple Drag and Drop** dialog box displays file information in a table.

- The table populates the most suitable **Dataset Type**, **Tools**, and **Reference** based on the **Default_dataset_type** preference for each file dropped.
• The **Dataset Type** list is populated with the type which is suitable for the file dropped by the user. This is driven by **Dataset Type Definition** specified in the Business Modeler IDE.

In the rich client you can drop multiple files on following types of object and their subtypes:

• **Items and item revisions**
  The relation between the item or item revision and the dataset is automatically selected, based on the default paste relation for the item or item revision type.

• **Folders**
  Datasets are pasted in corresponding folders.

• **BOM line objects**
  Created objects are pasted in the user **Newstuff** folder.
  To attach datasets to underlying objects for a BOM line, you must drop the files into the Structure Manager **Attachments** data pane.

  **Note** Set the following environment variables to specify behavior for drag and drop actions:

  **DRAG_AND_DROP_Default_dataset_type**
  Specifies the default dataset types for files added to objects by drag and drop actions.

  **DRAG_AND_DROP_file_limit**
  Specifies the number of the files that can be dragged and dropped by each drag and drop action.

  **DRAG_AND_DROP_SWING_dialog_enable**
  Specifies whether to show or hide the multiple file drag-and-drop dialog box for single-file drag-and-drop operations.

  For information about environment variables, see the *Preferences and Environment Variables Reference*.

**Add favorites to organize your data**

You can use favorites to track objects you access frequently, such as parts, forms, or processes.

In the rich client, use either of the following methods to add the objects to your **Favorites** list in the navigation pane:

• Right-click the object and choose **Add to Favorites**.

• Select the object in any hierarchy or detail view and drag it to a folder in the **Favorites** list in the navigation pane.

In the thin client, use the following method to add the objects to your **Favorites** list in the navigation pane:
1. Hold the cursor over the object to display the action menu ▼.

2. Choose **Add to Favorites ★**.

To display the object, click the link in the **Favorites** list. The file is opened in the application associated with the object or data type. For example, clicking a link to a Word document opens the file in Microsoft Word. Clicking a link to an item revision opens the item revision in My Teamcenter.

**Note** You can organize your favorites into folders using the **Organize Favorites** dialog box. Click the **Organize** button in the **Favorites** section to access the **Organize Favorites** dialog box.

**Using projects to organize data**

Teamcenter allows you to assign data to projects that are created with the Project application. A project typically represents a new product, product release, or design program, and you can assign relevant items, parts, and documents to it. Access privileges to the project can be given to project teams, development teams, suppliers, and customers who need to view or edit the data.

My Teamcenter includes a smart navigator that allows you to categorize data assigned to projects into functional areas using folders. Two types of folder are available—abstract folders and data-driven folders that can be used to filter the displayed project objects. The Teamcenter administrator creates the hierarchy of folders and adds projects to it with the Business Modeler IDE.

For more information about administering and using projects, see:

- **Security Administration Guide**
- **Project and Program Guide**
- **My Teamcenter Guide**

**Overview of object properties**

Objects have properties.

The properties associated with your data objects can be viewed in the **Details** table or in the **Properties** dialog box.

- Object properties, such as ownership, description, and unit of measure, can be viewed and modified, either for a single object or for multiple objects, using the **Properties** dialog box.
  - Click **Check-Out and Edit** or press Alt+E to check out the objects.
  - Click **Cancel** or press Alt+C to cancel changes and close the dialog box.
- Property modifications can automatically be propagated to related objects using type and relation filters.

For object properties, the **Properties** dialog box can incorporate a **Check-Out and Edit** button that lets you quickly check out an object and edit applicable information in an **Edit Properties** dialog box.
You can then:

- Click **Save and Check-In** or press Alt+I to save changes, check in the object, and close the dialog box.

- Click **Save** or press Alt+S to save the changes and retain the dialog box.

  **Note** If you click **Save** or press Alt+S, and then click **Cancel Check-Out** or press Alt+O, the changes are reverted and the checkout status for the object is canceled.

- Click **Cancel Check-Out** or press Alt+O to cancel the checkout without saving the changes and close the dialog box.

- Click **Close** or press Alt+C to close the dialog box.

  **Note** If any revision of an item has been released, the unit of measure cannot be modified.

  You can also find and replace string property values and add prefixes and suffixes to values.

For information about viewing and modifying object properties in the rich client, see the *My Teamcenter Guide*.

**Working with relation properties**

Your administrator can create custom attributes (properties) to apply to relation business objects in the system. A single item can be associated to multiple items or contexts. Objects are associated by relations, and the meaning of the relation may vary from one context to another.

Properties on relations let you record information specific to the association or context in which the item is used.

- You establish relationships between objects by pasting a secondary object to a primary object and choosing the relation by which the objects are associated. Property values are then defined for the selected relation.

- You can update property values, query for objects based on property values, and delete relations and property values.

- When you use a **Paste Special** command in the rich client or **Paste As** in the thin client to create a relation between objects, if there are properties defined for the relation that need values, the system displays the **Enter the Values for Properties on Relation** dialog box. To view or edit such properties, you can select the secondary object and choose **Edit→Properties on Relations**.

- Teamcenter administrators can define and deploy properties on the relation in the Business Modeler IDE.

For information about creating relation business objects and adding properties to relations, see the *Business Modeler IDE Guide*. 
Overview of checkout and checkin

You can check objects into and out of the Teamcenter database, reserving exclusive access and preventing the data from being modified by other users.

- The Check-Out option locks an object in the database so that only you can modify it.
- The Check-In option releases the lock, allowing other users to access the object.
- Only your administrator can circumvent the security that the checkout function provides.

A checkout is either explicit or implicit.

- Explicit checkout occurs when you use a menu command or button to check out an object. You must then choose to check in the object when you are finished with your modifications.

- Implicit checkout occurs when you double-click to open a dataset from the rich client or click Edit beside a dataset file in the thin client. Implicit checkout only occurs if the object is not already checked out. Checkin occurs automatically when you close the document.

The following objects can be checked into and out of the database:

- Folders
- Items and item revisions
- Datasets
- Forms
- BOM views and BOM view revisions

Explicit checkout

When you check out an object by using the Check-In/Out commands on the Tools menu, or when you use the Check-Out and Edit button in a view, you explicitly check
out the object from the database. Explicit checkout ensures exclusive modification access to an object.

You define the checkout directory by choosing Edit→Options and setting the General Check-In/Check-Out options.

You can set the Export files on checkout option to YES to lock the dataset for everyone, including the person who holds the checkout.

• When a dataset is checked out during export, the named references are downloaded to a local operating system directory and can be modified locally outside of the Teamcenter environment.

• When the dataset is checked into the database, any modifications to the named reference files are automatically uploaded to the database.

Note If your site has the TC_Auto_Checkout preference set to OFF, you must use Export files on checkout to save modifications to a dataset named reference. The downloaded named reference can be modified outside Teamcenter. When modification is complete, the dataset must be checked in through Teamcenter.

To explicitly check out an object, the following conditions must be met:

• The object must not be checked out by another user.

• You must have write access to the object.

• The object cannot be archived.

Implicit checkout

When you double-click a dataset object in Teamcenter, the system automatically creates an implicit checkout to ensure that two processes are not allowed to simultaneously update the dataset.

Implicit checkout differs from explicit checkout in the following ways:

• Implicit checkout is automatic and occurs when you open a dataset for modification. When the modifications are completed, the dataset is automatically checked back into the database.

• You cannot use a menu command to initiate an implicit checkout operation.

• Implicit checkout actions are not logged in a history file.

• Users included on notification lists are not notified when implicit checkout takes place.

• An implicit checkout in the Viewer view is released when you select a different object while the Viewer view is active. The checkout lock is not released if you only select another view such as the Summary or Details view.

Note The implicit checkout lock is released automatically when you return to Viewer and close the object, or select another object to open in the Viewer view.
• Implicit checkout of datasets other than UGPART and UGMASTER datasets can be customized by setting the TC_Auto_Checkout user preference. Implicit checkout of UGPART and UGMASTER datasets is controlled entirely by Teamcenter Integration for NX.

The TC_Enable_Implicit_CO preference specifies whether implicit checkout, save, and checkin are enabled in My Teamcenter in the Properties dialog box, form dialog boxes, Viewer view, and the Summary view. The Details view supports implicit checkout for editing, regardless of the TC_Enable_Implicit_CO preference value.

On the Viewer view and Summary view, click the Save Changes button to perform the implicit checkout.

**Note** Explicit checkout occurs when you use a menu command or button to check out an object.

Implicit checkout occurs when you open an object from Teamcenter, typically by selecting the object when the Summary view or Viewer view is active, by double-clicking a form object, or by displaying properties for a selected object. Implicit checkout does not occur when the object is already checked out or when multiple objects are selected.

When the TC_Enable_Implicit_CO preference is set to true, implicit checkout is available in the Summary view, Viewer view, properties dialog boxes, and in form dialog boxes in My Teamcenter. For example, with the TC_Enable_Implicit_CO preference enabled:

• When an object is checked in, the Properties dialog box displays OK, Apply, and Cancel buttons, and you can make modifications in this dialog box.
  o Click Apply to automatically check out the object, save it, and check it in.
  o Click OK to automatically check out the object, save it, check in the object, and close the dialog box.

• When you already have the object checked out, the Properties dialog box displays the Save, Check-in, Cancel Check-out, and Close buttons.

• When an object is checked out by another user, the Properties dialog box displays the Close button.

**Identify the checkout owner of an object**

1. Right-click the object and choose Properties.
   The Properties dialog box appears.

2. Click the Reservation link located in the lower-left portion of the dialog box.
   The Checked Out by box displays the name and site of the user who has checked out the object.

**Check out an object**

1. Select objects in the My Teamcenter tree or a BOM line in Structure Manager.
Note If you use this option to check out a replica item revision from a remote site and add data to the item revision prior to checking it back in, the system perceives the new data as being owned by the site that owns the item revision rather than being owned by the local author.

2. Choose Tools→Check-In/Out→Check-Out.
The system displays the Check-Out dialog box.

3. If you want to check out only those objects displayed in the dialog box (no attachments or component objects), go to step 5.

4. (Optional) Check out component objects or attachments along with the selected objects.
   a. Click Explore Selected Component(s)  .
      The system displays the component structure of the selected object in the Explore dialog box along with a pane for defining rules that determine which related objects are included.
   b. Select the related objects, using one of the following methods:
      • By individual selection
         Select the check box corresponding to the component in the tree.
      • By selecting all components
         Click Select all component(s)  located beneath the tree.
      • According to user-defined rules
         The right pane of the Explore dialog box lists type and relation combinations that can be used to select components, as defined by your preference settings. Both the Type and Relation lists include the Any option, which allows you to select all instances of a specific object type, regardless of relation, or to select all instances of a specific relation, regardless of object type.
         Apply rule filters, as follows:
         A. Click Add a rule (+) to add a rule to the table.
         B. Choose a type and relation combination by double-clicking the boxes and selecting a value from the Type and Relation lists.
         C. Click Update the selection in the tree based on rules to update the selections in the tree.
            Note Rules can be removed from the table by selecting the row and clicking Remove selected rules.
         D. Click OK to apply the filters to the objects in the Explore tree.
            The system closes the Explore dialog box and displays the pane related to the original operation.
Chapter 4  Common Teamcenter tasks

Note  The selection rules are saved as a user preference.

E. Click OK to accept the related objects and return to the original operation.

5. Click Yes (in the Check-Out dialog box) to check out the selected objects.
   The button in the right margin of the dialog box (opposite the object) indicates whether the process was successfully completed. If an error occurs during the process, the error button is displayed for that object. You can double-click the error button to display details about the error.

Check in an object

1. Select one or more objects that are currently checked out or select a checked-out part or assembly represented by a BOM line in Structure Manager.
   The Check-In option unlocks objects in the database, including assemblies in Structure Manager, that were previously checked out.

   Note  If you use this option to check in a replica item revision and have added data to the item revision prior to checking it back in, the system perceives the new data as being owned by the site that owns the item revision rather than being owned by the author at the local site.
   For more information, see the Multi-Site Collaboration Guide.

2. Choose Tools→Check-In/Out→Check-In.
   The Check-In dialog box appears.

3. If you want to check in only those objects displayed in the dialog box (no attachments or component objects), go to step 5.

4. (Optional) Check in component objects or attachments along with the selected objects.

   a. Click Explore Selected Component(s).
      The system displays the component structure of the selected object in the Explore dialog box along with a pane for defining rules that determine which related objects are included.

   b. Select the related objects, using one of the following methods:
      - By individual selection
        Select the check box corresponding to the component in the tree.
      - By selecting all components
        Click Select all component(s) located beneath the tree.
      - According to user-defined rules
        The right pane of the Explore dialog box lists type and relation combinations that can be used to select components, as defined by your
preference settings. Both the **Type** and **Relation** lists include the **Any** option, which allows you to select all instances of a specific object type, regardless of relation, or to select all instances of a specific relation, regardless of object type.

Apply rule filters, as follows:

A. Click **Add a rule** (+) to add a rule to the table.

B. Choose a type and relation combination by double-clicking the boxes and selecting a value from the **Type** and **Relation** lists.

C. Click **Update the selection in the tree based on rules** to update the selections in the tree.

   **Note** Rules can be removed from the table by selecting the row and clicking **Remove selected rules**.

D. Click **OK** to apply the filters to the objects in the **Explore** tree.

   The system closes the **Explore** dialog box and displays the pane related to the original operation.

   **Note** The selection rules are saved as a user preference.

E. Click **OK** to accept the related objects and return to the original operation.

5. Click **Yes** (in the **Check-In** dialog box) to check in the selected objects.

   The button in the right margin of the dialog box (opposite the object) indicates whether the process was successfully completed. If an error occurs during the process, the error button ✗ is displayed for that object.

   You can double-click the error button to display details about the error.

**Transfer checkout to another user**

1. Select an object that has been checked out of the database.

2. Choose **Tools→Check-In/Out→Transfer Check-Out**.

   The system displays the **Transfer Check-Out** dialog box.

3. Select a user name from the **New User** list.

   The user is designated as the **New User** to whom checkout will be transferred.

4. Click **Yes** to transfer checkout.

**Cancel a checkout request**

1. Select the object in the tree or **Details** table.

2. Choose **Tools→Check-In/Out→Cancel Checkout**, or right-click to choose **Check-In/Out→Cancel Checkout**.
The system displays the **Cancel Check-Out** confirmation dialog box.

3. Click **Yes** to cancel the checkout, or click **No** to stop the cancellation operation.
   - The checkout is canceled immediately.
   - The **Details** table **CO- Checked Out** column entry changes to blank.
   - If the checkout cannot be cancelled, a **Cancel Check-Out** dialog box displays an appropriate message.

**Note**

The **Cancel Checkout** command cancels checkout for most objects.

You cannot cancel the checkout of an item, a schedule item, or BOM view revision.

**View the checkout history of an object**

1. Select the object in the tree and choose **Tools→Check-In/Out→Check-Out History**.

   The system displays the **Check-Out History** dialog box containing the following information:
   - Date and time of each checkout transaction
   - User ID of the user who performed the checkout
   - Site name and user ID of remote users who have checked the object out of the database
   - Status of each transaction: checkin, checkout, transfer checkout, or cancel checkout
   - Change ID and comments

2. Click **Close** to exit the **Check-Out History** dialog box.

**Providing notification of changes in checkout status**

You can notify users when a specific object is checked in to or out of the Teamcenter database.

- When the checkout status of an object is modified, a **CICO Notification** envelope is delivered to the mailbox of each user whose name appears in the notification list. Click the envelope to display the contents in the **Details** table.

- A check mark in the **CO** column indicates that the object is checked out. If the column is blank, the object has been checked in.

**Note**

You can add yourself to the notification list for any object; however, you must have administrative privileges to add or remove other users from a notification list.

**View the notification list for an object**

1. Select the object in the tree or **Details** table.
2. Choose **Tools→Check-In/Out→Notification List**.

3. To add yourself to the list, click the **Add** button ➕. To remove yourself from the list, click the **Remove** button —.

4. Click **OK**.

**Managing object protection**

and ownership is crucial in a distributed-computing environment. Because workspace objects represent actual product information in the database, they must be protected from unauthorized or accidental access, modification, and deletion. Teamcenter implements two different tiers of data protection:

<table>
<thead>
<tr>
<th>Rules-based protection</th>
<th>Rules-based protection is configured by your administrator and includes conditions or rules that control access to objects. These rules affect your entire Teamcenter site and are enforced by the Access Manager (AM).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object-based protection</td>
<td>Object-based protection uses access control lists (ACL) to create exceptions to rules-based protection on an object-by-object basis. Object ACLs are most useful for either granting wider access or limiting access to a specific object.</td>
</tr>
</tbody>
</table>

Note: Rules and ACLs do not control the creation of objects. They only determine what operations can be performed on existing objects. An administrator controls which objects a user can create using the Command Suppression application, which suppresses the display of menus and commands. An administrator can also use the Business Modeler IDE to create display rules that hide specific types when creating new objects using the **File→New** menus.

- For more information about command suppression, see the *Application Administration Guide*.
- For more information about creating business object display rules, see the *Business Modeler IDE Guide*.

You can classify data to restrict object access based on intellectual property and international distribution requirements.

For information about using classification functionality, see the *Classification Guide*.

Teamcenter provides mechanisms for rules-based and object-based protection, and for authorized data access (ADA) for intellectual property (IP) and international traffic in arms regulation (ITAR).

For more information about functionality for ADA and ITAR support, see the *Security Administration Guide*.

**Rules-based protection**

Rules provide security for your Teamcenter data by:

- Controlling access to data on a global basis.
• Determining whether a user has permission to view or perform an action on an object.

• Filtering data according to the attributes of the data.

• Granting privileges to the data according to the users’ IDs and their session context (the group and role they used to log on).

**Note**  Rules do not control the creation of objects. They only determine what operations can be performed on existing objects.

Rules are defined by a combination of:

• A condition.

• A value for the condition.

• An access control list (ACL) that grants privileges to accessors.

The condition and value identify the set of objects to which the rule applies; the ACL defines the privileges granted to users (accessors).

User actions against objects cause the rule tree to be evaluated to dynamically build an access control list for the object. The ACL controls permissions for the object and determines who (accessors) can do what (actions) to the object.

**Object-based protection**

Object-based protection uses access control lists (ACLs) to create exceptions to rules-based protection on an object-by-object basis.

Object ACLs are most useful when you need to:

• Grant wider access to a specific object.

• Limit access to a specific object.
Teamcenter uses ACLs to determine access to an object. Users with proper permissions can override the ACL for an object to grant or deny permissions for certain users but only when the rule tree allows.

For example, the rule tree does not allow object-based access rules to override the rules-based protection when:

- An object has an assigned status.
- The object access rule is granted in a workflow.

**Note** ACLs do not control the creation of objects. They only determine what operations can be performed on existing objects.

- Each ACL contains a list of accessors and the privileges granted, denied, or not set for each accessor.
- Each individual pairing of an accessor with their privileges is considered a single access control entry (ACE).

### Using 4th Generation Design

4th Generation Design (4GD) allows users of NX CAD and Lifecycle Visualization to cooperate in real time during the design cycle of a product. It is particularly suitable for development teams working on large products that typically include millions of parts, for example, ships and automobiles. It allows users to check out and modify individual parts or subassemblies in the structure without locking the entire structure or major assemblies.

4GD end users work in two main phases:

- **Product or program initiation**
  
  When you initiate a product or program, the design team manager or other expert user defines the main systems into which Engineering will provide solutions. In many cases, the initial design is created from a similar product or from an existing template for the product type. This initial framework is called the collaborative design.

- **Design authoring**
  
  In this phase, design engineers populate the collaborative design with elements that describe the product’s design. It can contain CAD designs, product-specific geometry, and features such as datum points, welds, and weld seams. The collaborative design can be populated directly or from within a workset that is
Chapter 4  Common Teamcenter tasks

instanced into a subset of the collaborative design. Typically, the design team manager allocates tasks in various areas of the collaborative design to designers with appropriate skills and assigns worksets accordingly.

A collaborative design is a model of a product that is developed by a team of contributors. The elements of the model are arranged in a hierarchy that allows team members to collaborate and author common product information in an efficient manner.

Users are assigned tasks through worksets. A workset is conceptually similar to a user sandbox. It allows you to check out local copies of subsets and assemblies and then make updates. Only one user at a time can check out a workset, and changes are not shared with other users until they are checked in.

Model elements in a collaborative design can include:

- Design elements
  A design element is an occurrence of a standard part design, a design component, or a design assembly. Design elements are the basic building blocks with which the users populate the collaborative design.

- Partitions
  Partitions logically organize large sets of design elements into a hierarchy that permits CAD users to easily find their assigned data. Partitions can also expand into other partitions. They can represent functional divisions of the product (for example, propulsion systems or avionics), or they can represent physical divisions (for example, an engine room or electronics bay).

- Subsets
  A subset is a collection of model elements from a single collaborative design that is created by a search recipe or manually by a user.

- Product specific geometry
  Positionable model geometry that is associated with the current collaborative design, not with a reused design part. It is related to a DirectModel dataset containing JT and TruShape files. Teamcenter uses the JT file when rendering the positioned geometry and the TruShape data for refining spatial searches.

- Welds and weld seams
  4GD supports individual welds of several types, for example, spot weld or arc weld. A weld seam is a set of individual welds that may also control access to those welds. Adhesive joins may also be modeled as welds. Weld data is authored in NX, managed in Teamcenter, and consumed in Manufacturing Process Management.

- Datum points
  Datum points are typically used in the manufacturing process to help position parts in fixtures or to specify measurement points used by quality assurance processes. Weld data is authored in NX, managed in Teamcenter, and consumed in Manufacturing Process Management. By default, only pin and surface datum points are available.

- Routing
Routing represents piping or electrical cabling.

In addition to creating model elements in the CAD system, you can also realize BOM lines, BOM view revisions (BVRs), items, or items revisions into a collaborative design, for example, items that represent standard or bought assemblies. The realized objects are referred to as reuse design elements.

You can configure a collaborative design by status, revision rule, variant rule, intent, date effectivity, or unit effectivity.

Users manage 4GD data with the 4G Designer rich client application. You cannot currently manage 4GD data with the thin client.

The 4GD solution must be specifically selected during server installation. When you install the 4GD solution and other required features, Teamcenter provides four Business Modeler IDE installation templates—4GD, Application Model, Realization, and Partitions. Additional templates are required if you want to use the integrations with Manufacturing Process Management and NX.

For more information about 4th Generation Design, see the 4th Generation Design Guide.

Managing product structures

Teamcenter enables you to define a single generic product structure from which an entire range of product variants can be derived. You can use variant conditions and constraints to configure your product structure. Variant conditions enable you to define the components that can be configured to create specific product variants. Constraints enable you to reduce the number of variants that your platform can support on a temporary or permanent basis. In addition, option compatibility constraints can be used to specify that certain combinations of option values are not offered.

Revision rules can also be applied to configure your product structure. Revision rules enable you to manage changes to the structure resulting from new revisions of subassemblies and components. For example, you can define revision rules that configure the structure based on a specific effective date or based on the release status of the components.

In addition, you can use incremental changes or the Change Manager application to manage revisions to the product or its components.

Use case example: product variation and derivatives

A company offers personal computers by enabling customers to choose:

- 8 processor options
- 3 chassis options
- 4 video options
- 2 audio options
- 2 bay options
- 4 memory options
In this scenario, the company has 1,536 possible product variations and you can use classic or modular variants to avoid the need to create 1,536 individual product structures. An example of a variant condition would be the configuration of a Pentium 4 as a fast processor and Celeron as a standard processor. An example of a hard constraint would be the company’s decision not to offer a “premium” audio system on any of its low-end PCs.

Typical tasks related to defining and configuring product structures include:

- Browsing product structures.
- Building and editing product structures.
- Managing occurrence notes.
- Creating revision rules and applying them to your product structures.
- Configuring structures by occurrence effectivity.
- Configuring structures using variants.
- Comparing product structures.
- Managing incremental changes to your products.

For more information about creating and managing product structures, see *Getting Started with Product Structure*.

**Repeatable Digital Validation**

Repeatable Digital Validation (RDV) enables designers to make design changes, validate the complete product for packaging, CAE, process simulation, manufacturability, cost and function, and compare the validation results to other design alternatives. You can rapidly configure, visualize, analyze and compare a new part design in all usages in all products to fully understand the impact of your changes.

RDV is continuously repeatable with a new configuration or an alternative design configuration, and it enables the validation process to be repeated at different sites or by different individuals or suppliers. In addition, RDV synchronizes CAD, visual and product structure data based on business rules captured in a company-specific workflow. Product configurations are always kept up to date with the latest changes.

The Repeatable Digital Validation process incorporates the use of a number of Teamcenter applications to configure, visualize, and validate your designs, including Structure Manager, Appearance Configuration, Platform Designer, and DesignContext.

*Use case example: Repeatable Digital Validation*

A typical car has over 10,000 parts. On average, 2500 parts change during any given week. Trying to pull all these changes can take two to three weeks. After a change is initiated, it must be validated and its impact on overall weight, cost, and supplier schedule must be analyzed. This is a time consuming, resource-intensive task. While knowledge workers are pulling the changes together, more design changes will invariably need to be initiated. This cycle is repeated every two to three weeks during the product development process, which lasts 12 to 18 months.
The second problem faced by the design team is that even when it brings up the whole product containing 10,000 parts, it can take hours to zero in on the part and surrounding area that needs to be analyzed. Because of this complexity, many engineers try to only work with a few parts at a time. This creates a risk of not envisioning the change in the context of the entire product or the entire surrounding environment impacted by the change.

Typical tasks in the RDV process include:
- Configuring background parts.
- Configuring product contexts.
- Performing tolerance and clearance analysis.
- Viewing RDV data in the Teamcenter thin client.

For more information about performing Repeatable Digital Validation tasks, see Getting Started with RDV.

Managing manufacturing data

Manufacturing Process Management enables you to manage your processes, plants, tools, and resources in a seamless integration with product definitions managed and configured in Teamcenter using a common data and process model.

Typical manufacturing data management tasks include:
- Creating a factory structure.
- Creating a manufacturing process.
- Creating a preliminary data indicator (baseline).
- Creating manufacturing reports.
- Publishing manufacturing work instructions.

You can exchange manufacturing data with the Tecnomatix Process Designer and Process Simulate applications for detailed planning and simulation activities. For more information, see Getting Started with Manufacturing.

Managing Mechatronics data

The term Mechatronics Process Management refers to the incorporation of mechanical, electrical, electronics and embedded software technologies into a single electromechanical product. Teamcenter includes several applications and integrations that allow you to manage all the related data in a single product structure, including Wiring Harness Design Tools Integration, ClearCase Integration, Embedded Software Solutions, Structure Manager, My Teamcenter, and Multi-Structure Manager.

Typical Mechatronics Process Management tasks include:
- Creating an electrical functional model.
Chapter 4  Common Teamcenter tasks

- Creating an electrical logical model.
- Creating an electrical physical model.
- Building a view.
- Working with a wiring harness.
- Defining a route.
- Creating allocations.
- Interacting with external ECAD applications.
- Visualizing wiring harnesses, printed circuit board designs, and schematics in the rich client embedded viewer or a third-party external viewer.

For more information, see Getting Started with Mechatronics Process Management.

Managing publications

Content Management enables you to manage SGML and XML information stored in the Teamcenter database. It works in conjunction with several publishing and XML editing tools. Publications can be generated from the application for both online and print formats. Content Management includes support for multiple language versions and includes the ability to manage topics through release cycles.

Using Content Management, you can:
- Create and manage publications containing XML content and graphics.
- Manage translations of publications.
- View, print, and publish PDF and HTML output for publications.
- Manage publication versions.

For more information, see the Content Management Guide.

Visualizing your product data

Lifecycle Visualization is a software suite developed by Siemens PLM Software for enterprise-wide product visualization. You can visualize product data in two ways—in the embedded viewer pane available in several of the Teamcenter rich client applications, including My Teamcenter and Structure Manager, or in the stand-alone Lifecycle Visualization application. Full support for PLM XML also provides a lightweight, extensible mechanism for sharing product data with other Siemens PLM Software and supported third-party applications.

Typical visualization tasks include:
- Working with 2D images, including measurement and markup and image comparison.
- Visualizing product structure, part and assembly properties, and layer information.
• Visualizing PMI.
• Working with 3D models, including:
  o Part selection.
  o Dynamic highlighting.
  o Part visibility control.
  o Measurement and cross-sectioning.
• Visualizing printed circuit board layouts and schematics.
• Translating CAD files.
  Teamcenter includes the Dispatcher solution that allows you to translate commonly encountered MCAD and ECAD files into a neutral format for visualization; MCAD files are translated to JT format, while ECAD files are translated to XFATF format. When you install this solution, you select only those translators that are necessary for your site. For example, if you use only I-deas, you only need install the I-deas to JT translator. File translations may be scheduled in batch mode, or they can be initiated manually from the Translate menu in My Teamcenter. An administrative client can also be started from My Teamcenter that allows an administrator to monitor and adjust the load on the translation scheduler.
  For more information, see the Getting Started with Product Visualization and the Getting Started with Dispatcher (Translation Management).

Translating documents to derived output formats
  Teamcenter documentation management supports translation of Microsoft Office document file types, such as Word, Excel, PowerPoint, and Project, to render a variety of derived output file formats, such as Adobe Postscript, Adobe PDF, and TIF. Administrators can configure translation based on events, steps in workflow processes, or user action.
  For information about rendering document dataset files, see the My Teamcenter Guide.
  For more information about configuring document translation, see the Business Modeler IDE Guide.

Previewing 2D and 3D images
  You can display 2D raster images and JT parts in the Image Thumbnail Preview and the JT Preview views. When you select compatible objects associated with items, item revisions, and datasets within the My Teamcenter tree or the trees of other applications, the associated image or JT part is displayed in the appropriate preview viewer. These views are displayed by default with appropriate applications such as My Teamcenter. 2D dataset types, reference types, and the relation search order are specified in the tcgbr.properties file. 3D dataset types, reference types, and the relation search order are specified in the tctdv.properties file.
  For information about configuring the Image Thumbnail Preview and JT Preview views, see Application Administration Guide.
Classifying parts and components

Classifying parts and components in digital libraries enables design engineers to reuse product definitions and enables manufacturing engineers to evaluate alternate or substitute parts before designs are finalized. Using Classification, you can manage a wide variety of product definition data.

You can create catalogs that design engineers can access and search using the rich client or the web-based thin client. Design engineers can access these catalogs when searching for designs, parts, or tools that match their criteria or fit into a desired range of parameters.

Typical classification tasks include:

• Adding classification objects (ICOs) to the hierarchy.

• Classifying parts, technology data, and manufacturing equipment.

• Finding and retrieving parts for reuse based on classification attributes.

For more information about classifying your data, see the Classification Guide.

Managing changes

Teamcenter provides two best-practice approaches to initiate, administer, review, approve, and execute product changes: A formal process to manage change repeatedly and systematically and a single-stage process that uses a less formal methodology. These processes leverage product structure definitions, enabling you to:

• Evaluate the impact of product changes in terms of work tasks.

• Audit the completion of assigned tasks.

• Maintain a history of product changes executed during the product lifecycle.

• Track both planned and actual impact to product information associated with design changes.

Use case example: model-driven change management

ABC Company uses Teamcenter to gain immediate access to graphical and textual product data. They can search the database for a particular part number and view the part graphically either alone or within the context of nearby parts. Changes to a part can also be seen graphically instead of as line items on a BOM, and changes to a CAD model automatically update all related BOMs, eliminating the need to manually keep BOMs synchronized.

ABC’s Engineering Change process was re-engineered from a paper-based process to an automated process using Teamcenter change management and workflow features.

Typical change management tasks include:

• Viewing change forms, processes, references, BOM changes, 4GD design data changes, and effectivity.
Common Teamcenter tasks

- Creating change requests.
- Monitoring tasks to perform and tasks to track.
- Creating change notices.

For information about performing these tasks, see the Change Manager Guide.

In addition, if you have changes or issues that do not need to be addressed through an extensive, standardized change management process, such as the one that Change Manager supports, or you have highly visual information, you can use Issue Manager. Issue Manager automatically provides access to Siemens PLM Software design review and issue resolution tools, including NX, Lifecycle Visualization, and the Lifecycle Viewer.

Using workflow processes

Workflow stems from the concept that all work goes through one or more processes to accomplish an objective. Workflow is the automation of those business processes. Using workflow, documents, information, and tasks are passed between participants during the completion of a particular process. In Teamcenter, workflow processes are built based on tasks which are then assigned to users for completion.

Workflow tasks are typically completed in My Teamcenter or Workflow Viewer and include:

- Viewing workflow processes, audit logs, reviewer requirements, and task attachments.
- Completing tasks.
- Modifying workflow processes.
- Overriding task actions.

For more information about these tasks, see Getting Started with Workflow, the Workflow Viewer Guide, or the My Teamcenter Guide.

Importing and exporting data

You can import objects from other sites in to your database even if you do not have a direct network connection to the site; however, you must have a directory containing data that was exported from the other site. This directory must be the output of an object export operation (as opposed to simple file export operation) using one of the following object export methods:

- Object export
  
  Objects can be exported in either of the following formats:
  
  - Teamcenter
  - STEP
  - PLM XML export
Chapter 4  Common Teamcenter tasks

• Briefcase export

When you export an object in Teamcenter or STEP format, you move all internal data associated with that object. For example, if you export an item, you export all of its related data (for example, item revisions, BOM view revisions, item master, and any exportable requirement, specification, manifestation, or reference objects) in one operation.

When you export objects in PLM XML format, the transfer mode determines what data is exported.

For more information about transfer modes, see the PLM XML/TC XML Export Import Administration Guide.

Note While exporting workflow templates from a site using PLM XML, some of the associated objects, such as named ACLs, saved queries, and release statuses do not get exported for security reasons. Therefore, when the exported file is imported at another site, these associated objects are not imported/created.

Named ACLs must be manually created and synchronized between sites. Saved search and release status objects can be exported/imported separately using PLM XML, and this method should be used to synchronize these objects between sites. During PLM XML import, if the process encounters these object types, a warning message is written to the log file indicating that these objects must be synchronized independently. The log file is named plmxml_log_#.log and is located in the log directory.

Briefcase files are exported in TC XML format. This is the format normally used to transfer files to suppliers who do not have Teamcenter installed. These sites are known as unmanaged sites. Briefcase files can also be used for transfers to suppliers who have Teamcenter installed (managed sites) or to other Teamcenter sites in your enterprise that do not have a direct network connection or are offline for other reasons.

For information about briefcase file transfers, see the Data Exchange Guide.

You can also export files to other Teamcenter directly if you have a network connection or you have Web access to a Global Services site.

For information about system behavior when you import and export data between Teamcenter sites with either a direct network connection or through HTTP, see the Multi-Site Collaboration Guide.

For information about importing and exporting data using Global Services, see the Data Exchange Guide.

Importing objects

You can import objects in to the database from sites that are not part of a Multi-Site Collaboration network.

Note When sharing form data between multiple sites, ensure that the form storage class is properly defined at the importing site and is compatible with the form storage class at the exporting site.
Import a Teamcenter object

1. Select the container object into which the objects will be imported.

2. Choose Tools→Import→Objects.

3. In the left pane of the Import dialog box, click the Teamcenter button.

4. In the Importing Object box, click the Browse button to locate and select a folder or file from the system directory.

5. If you selected a directory or file containing Teamcenter objects, the objects are displayed in the Object List. Select the objects that you want to import using one of the following methods:
   - Click the check boxes to select individual objects in the list.
   - Click the Select All button to select all importable objects in the folder.
   - Click the All But button to select all objects except those that are currently selected.
   - Click the Select None button to clear all object selections.

6. (Optional) Choose from the following report options:

   **Note** The report options are offered in addition to the operation log file.

   - **Generate Import Report**: Generates a report listing the objects that were imported. The system displays the report after the successful completion of the import operation.
   - **Preview Import Report**: Performs a dry run of the import operation. The resulting report lists the objects that would be imported, as well as any problems that are encountered.
   - **Continue on Error**: Allows the import operation to continue if errors are encountered while importing optional objects. All objects are considered optional except those with the following relation types:
     - **Requirement**
     - **Specification**
     - **Item Master**
     - **Item Revision Master**

     If errors are encountered, a completion report is generated even if you do not select the Generate Import Report option.

7. Click Apply to start the import operation and retain the dialog box, or click OK to start the import operation and exit the dialog box. When the import operation has successfully completed, you can review the log file.

Import a STEP file

1. Select the container object into which the objects will be imported.
Chapter 4  Common Teamcenter tasks

2. Choose **Tools→Import→Objects**.

3. In the left pane of the **Import** dialog box, click the **STEP** button.

   **Note** When you import product data into Teamcenter from a STEP AP203 or AP214 physical file, it is always imported as a complete item structure.

4. Type the path to the folder containing the STEP file that you want to import in the **Importing Object** box, or click the **Browse** button *** to locate and select a folder from the system directory.

   After you select a STEP file, the directory path of the selected file is displayed in the **Importing Object** text box. The STEP file and all included references are displayed in the **Include Reference** section of the dialog box.

5. Review the objects selected for import, and perform one of the following steps.
   - If the list accurately reflects the objects that you want to import, click **Apply** or **OK**.
   - If the list does not accurately reflect the objects that you want to import, click **Cancel**.

**Import data from a PLM XML file**

1. Choose **Tools→Import→From PLMXML**.

2. In the **PLM XML** dialog box, click the **Browse** button *** to the right of the **Importing Object** box.

   The system displays the **Select Object** dialog box.

3. Select **PLM XML File (.xml)** from the **Files of type** list.

4. Navigate to the directory containing the file, and select the file.

5. Click the **Select** button.

6. Select the transfer mode to be used to configure the import operation.

   For more information about transfer modes, see the **PLM XML/TC XML Export Import Administration Guide**.

7. (Optional) Check the **View Log File** box to view the log file when the data translation is complete.

8. (Optional) Create or select an incremental change object into which BOM components contained in the XML file will be imported.

   Importing BOM components into an incremental change object allows you to view changes in Structure Manager prior to making them effective.

   For more information about creating and managing incremental change objects, see the **Structure Manager Guide**.
BOM components imported into an existing incremental change object are appended to the list of incremental change components.

9. Click **Apply** or **OK**.

The system imports the data in to your Newstuff folder.

**Note** If object names or IDs are encountered that exceed the character limit for those attributes in Teamcenter, the name and/or ID is truncated when imported in to Teamcenter.

**Exporting objects**

You can export data from Teamcenter in either Teamcenter, STEP, or PLM XML format. You can also use **Application Interface** mode to export data in PLM XML format and track those exports. Application interface objects store parameters required to share data in PLM XML format, allowing you to repeatedly share data with other sites without defining the parameters each time you export the data. For more information on STEP or PLM XML format, see the *PLM XML/TC XML Export Import Administration Guide*.

**Export an object**

1. Select the objects to be exported.

2. Choose **Tools→Export→Objects**.

3. In the left pane of the **Export** dialog box, click the **Teamcenter** button.

4. Type the path to the directory containing the objects to be exported in the **Parent Directory** box or click the **Browse** button to locate the directory.

5. Type the name of the export directory in the **Export Directory** box.

6. (Optional) Type comments related to the export operation in the **Reason** box.

7. Use the buttons to the right of the **Target Sites** list to select the Multi-Site Collaboration export destinations for the objects.

8. (Optional) Set the export preferences by clicking the **Export Settings** button 🔄.

9. Click **OK** to export the objects.

**Export objects in STEP format**

1. Select the objects to be exported.

2. Choose **Tools→Export→Objects**.

3. In the left pane of the **Export** dialog box, click the **STEP** button.

4. Type the path to the directory containing the objects to be exported in the **Export Directory** box or click the **Browse** button to locate the directory.
Chapter 4  Common Teamcenter tasks

5. Type the name of the export file in the Export Filename box.

6. (Optional) Type comments related to the export operation in the Export box.

7. Select an Export Format option: AP 203 or AP 214.

8. (Optional) Select the View Log File option to view the log file when the export operation is complete.

9. (Optional) Set the export preferences by clicking the Export Settings button.

10. Click OK.

Export objects in PLM XML format

1. Select the objects to be exported.

2. Choose Tools→Export→To PLMXML.

3. In the Export Directory box, select the directory in which to place the PLM XML file. Click the Browse button to locate the directory.

4. Type the name of the export file in the Export Filename box.

5. Choose a transfer mode from the Transfer Mode Name list. For more information about transfer modes, see the PLM XML/TC XML Export Import Administration Guide.

6. (Optional) Choose a Revision Rule to configure the assembly to be exported.

   Note  If you do not apply a revision rule, only the parent item revision is exported.

7. (Optional) Select the Open PLM XML File box to view the file when the export operation is complete.

8. (Optional) Check the View Log File box to view the log file when the data translation is complete.

9. Click OK.

Export objects using application interface mode

An application interface lets you exchange data between Teamcenter and an external application using the Application Interface (AI) service functionality.

1. Select the objects to be exported.

2. Choose Tools→Export→Objects.

3. In the left pane of the Export dialog box, click the AppInterface button.
4. Choose an application interface by clicking the **Find Application Interface** button or create a new application interface by clicking the **Create Application Interface** button and entering information in the following fields:

- **Name**
  Specifies the name of the application interface.

- **Description**
  Describes the application interface (optional).

- **Import Transfer Mode Name**
  Specifies the transfer mode used when objects are imported in to your database.

  For more information about transfer modes, see the *PLM XML/TC XML Export Import Administration Guide*.

- **Export Transfer Mode Name**
  Specifies the transfer mode used when objects are exported from your database.

  For more information about transfer modes, see the *PLM XML/TC XML Export Import Administration Guide*.

- **Target Sites**
  Specifies the sites to which objects are exported when this application interface is used.

- **Active Incremental Change**
  Specifies the incremental change into which objects are imported. The buttons to the right of the **Active Incremental Change** box enable you to create an incremental change object, search for an existing change, or select from the most recently used changes. In addition, the **Information** button allows you to view or modify the active change.

  For more information about incremental changes, see *Getting Started with Product Structure*.

5. (Optional) Choose the **Is Partial Export** option.

6. (Optional) Choose the **Open on Export** option.

7. Click **OK**.

**Running reports**

Teamcenter provides a number of standard report designs that you can use to extract information and generate reports based on saved queries of the database. For example, you can generate a report to show:

- All items of a specified type that have achieved a particular release status.
Chapter 4  Common Teamcenter tasks

- Information, such as name, address, and employee number for specific users in your organization.

The report generation wizard in My Teamcenter guides you through the steps required to generate a report including:

- Selecting a design format.
- Specifying the information you want to extract from the database.
- Choosing an output format.

In addition to the standard report designs, Teamcenter administrators can create custom reports using Report Builder.

Reporting and Analytics is a stand-alone reporting application. When it is installed and deployed in a Teamcenter environment, it integrates with Report Builder and displays reports in the TcRA Reports folder. A separate application is added to Teamcenter which shows contents of the Teamcenter Reporting and Analytics (TcRA) dashboard.

For more information about the TcRA embedded dashboard, see the Report Builder Guide.

For more information about generating reports, see the My Teamcenter Guide.

For information about building custom reports, see the Report Builder Guide.

Note  Teamcenter manufacturing process management provides a Report Generator application, which is intended for building reports of data that is managed in Manufacturing Process Planner and Part Planner. Do not use this application for creating reports of other data.

Using mail, e-mail, and instant messaging in Teamcenter

Teamcenter provides an internal mail facility, called Teamcenter mail, as well as the capability to use external e-mail programs, such as Microsoft Outlook, and the capability to use instant messaging.

Note  The My Worklist view has an Inbox associated with workflow tasks you must perform or you can track. These are not mail or e-mail.

- Teamcenter mail lets you to send mail from within the Teamcenter interface, including attachments and links, to other Teamcenter users. You can also send e-mail from Teamcenter to recipients who are not Teamcenter users by specifying a valid SMTP address.

  Teamcenter mail is delivered to the Mailbox in your Home view in My Teamcenter.

- Your administrator can configure Teamcenter to use external e-mail programs, such as Microsoft Outlook, to send subscription and workflow notification using external mail programs.
An administrator can configure the EPM-notify and EPM-notify-report workflow handlers to send Teamcenter mail and e-mail.

- Teamcenter rich client and thin client users can see when other users are available for instant messaging with Microsoft Office Communicator. Teamcenter users can view the current status of the owning and last modified users and can click the Microsoft Office Communicator symbol in Teamcenter to initiate communication.

For information about configuring Teamcenter instant messaging with Microsoft Office Communicator, see the Application Administration Guide.

For information about configuring Teamcenter mail and about configuring external e-mail for subscription notification, see the Application Administration Guide.

### Sending and receiving Teamcenter mail

Teamcenter mail enables you to send mail from within the Teamcenter interface, including attachments, to other Teamcenter users. In addition, you can send mail from Teamcenter to people who are not Teamcenter users by specifying a valid SMTP address.

- The ability to send operating system e-mail from Teamcenter can be disabled by setting the Mail_OSMail_activated preference to false.

### Send a mail message

1. (Optional) Select attachments from the navigation tree.
   
   **Tip** You can also copy attachments to the clipboard and insert them in the Attachments box.

2. Choose File→New→Envelope.

3. Use one of the following methods to enter the addresses in the To box:
   - Type the addresses of the users, groups, address lists, or external recipients in the To and/or CC boxes.
     - **Note** To send external mail, you must specify a valid SMTP address.
   - Search for recipients by performing the following steps:
     a. Click the To button.
        
        The system displays the Select Recipients dialog box.
     b. Type search criteria in the Search box to search by user ID, group, or address list.
Chapter 4  Common Teamcenter tasks

c. Click one of the following buttons to execute the search: User, Groups, or Address List.

d. Select the users, groups, or address lists that you want to receive the message, and click the To or CC buttons.

Tip  You can remove recipients from the lists by selecting the user and clicking the Remove button (–). In addition, you can create a new address list by clicking the Launch Address List button and following the instructions described in Create an address list.

e. Click OK.

4. In the New Envelope dialog box, type the subject of the message in the Subject box.

5. Type your message in the Message box.

Tip  To include the contents of a text dataset in the body of your message, select the dataset in the attachment list and click .

6. (Optional) Click the Add button to the right of the Attachments section to copy items from the clipboard as attachments.

Note  Attachments are Teamcenter objects and are only valid when sending Teamcenter mail. Teamcenter objects cannot be sent as attachments of external mail messages.

7. Click Send to send the message.

Receiving and reading mail

An envelope is delivered to the mailbox of each user whose name appears in the To: or CC: list of sent mail.

To read your mail in the rich client, open your Mailbox folder and click the envelope to display the contents in the Viewer pane.

Address lists

Address lists can contain any combination of valid Teamcenter users and groups. In addition, external e-mail addresses and other Teamcenter address lists can be used as entries in address lists.

You can create address lists when selecting mail recipients by clicking the Launch Address List Dialog button located beneath the search results pane in the Select Recipients dialog box.
1 **Search**

Finds recipients by searching for users, groups, or address lists. Results display in the search results pane.

2 **Search results pane**

Lists recipients found by the search.

3 **Launch Address List Dialog**

Launches the Address List dialog box and lets you create an address list.

**Note**
When an address list containing inactive users is involved in a workflow, notification e-mails generated by the workflow are sent to all address list members except the inactive users.

**Create an address list**

1. Choose Tools→Address List.

2. Type the name of the address list in the text box under the Address List pane, and click the Add button.

3. Type the names of the members or select the members, users and/or groups, that you want to add to the address list. The members that you add to the address list display in the Member(s) pane.
   - Type the name of the user or group and click the Add button.
   - Perform the following steps to select members to add to the address list:
     a. Place the cursor in the New Member box, and click the Organization button.
     b. In the Organization Selection dialog box, select the Include Sub-Groups option to add all of the members of a chosen group.
     c. Expand the tree, select the groups and/or users, and click OK.

The system displays the name of the user and/or group in the Member(s) pane and the Organization Selection dialog box closes.

4. Click Close.
Modify an address list

1. Choose Tools→Address List.

2. Select the address list that you want to modify.

3. Type the names of the members or select the members, users and/or groups, that you want to add to the address list. The members that you add to the address list display in the Member(s) pane.
   - Type the name of the user or group and click the Add button.
   - Perform the following steps to select members to add to the address list:
     a. Place the cursor in the New Member box, and click the Organization button.
     b. In the Organization Selection dialog box, select the Include Sub-Groups option to add all of the members of a chosen group.
     c. Expand the tree, select the groups and/or users, and click OK.
        The system displays the name of the user and/or group in the Member(s) pane and the Organization Selection dialog box closes.

4. Click Close.

5. To remove a user or group from the address list, select the member in the Member(s) list and click the Remove button.
   The system displays a confirmation message.

6. Click Yes to delete the selected member from the address list, click No to cancel the delete operation, or click Close to cancel the operation and close the dialog box.

Delete an address list

1. Choose Tools→Address List.

2. In the Address List, select the name of the address list that you want to delete and click the Remove button.
   The system displays a confirmation message.

3. Click Yes to delete the selected address list, click No to cancel the delete operation, or click Close to cancel the operation and close the dialog box.
Appendix

A  Glossary
Appendix

A  Glossary

A

absolute occurrence
Relationship between a parent assembly and an item one or more levels down in the structure. The parent assembly is the context in which the absolute occurrence exists. When you select the context assembly and view the structure, you can define data on the absolute occurrence that overrides the data stored on the parent. Compare to occurrence.

access control entry (ACE)
In Access Manager, each pairing in the access control list of an accessor with the granted privileges.

access control list (ACL)
Access Manager component that contains a list of accessors and, for each accessor, the privileges granted, denied, and not set.

Access Manager (AM)
Teamcenter application that enables the system administrator to grant users access to Teamcenter objects.

accessor
Access Manager component that grants or denies privileges to clusters of users who share certain common traits (for example, perform the same function or work on the same project).

ACE
See access control entry (ACE).

ACL
See access control list (ACL).

ad hoc process modification
Functionality that allows users to add tasks to, or delete tasks from, an active workflow process.

Appearance Configuration
Teamcenter application used to configure the use of appearance:

• Defining the appearance sets for which the site tracks appearances.

• Configuring the mapping of occurrence notes into appearance attributes.
assembly
Compound object that is assembled from other objects and may add additional information to their interpretation.

- In the context of an assembly, other assemblies are called subassemblies, while noncompound objects are called components.

- A single-level compound object that is distinct from a multilevel product structure or bill of materials, which is a hierarchy of assemblies. Assembly data is stored in a BOM view revision.

B

baseline
Collection of items and the relationships between the items that is established to ensure their continued existence. It enables their configuration to be reconstructed and audited. Baselines are often created to preserve the state of a design at a particular checkpoint. You can baseline precise or imprecise structures.

BOM
Bill of materials.

- 100% BOM
  The as sold product configuration, for example, the configuration of a car to be built and shipped to the dealer.

- 120% BOM
  Partial overlay of selected variant conditions. You cannot build the product from a 120% BOM.

- 150% BOM
  Overlays of all possible variant configurations. You cannot build the product from a 150% BOM.

See also design bill of materials and manufacturing bill of materials.

BOM view
Teamcenter object used to manage product structure information for an item.

BOM view revision (BVR)
Workspace object that stores the single-level assembly structure of an item revision. Access can be controlled on the structure (BOM view revision) independently of other data. BOM view revisions are meaningful only in the context of the item revisions for which they are created.

bulk data
Physical information represented in the database by a data item. Examples of bulk data are file system items, paper documents, and microfiche. The Teamcenter database describes the bulk data. The bulk data resides elsewhere, for example, in a file system or in a filing cabinet. See also data item.

BVR
See BOM view revision (BVR).
C

change
Temporary or permanent change to a configuration, design requirement, or documentation.

change notification
Notice to vendors, manufacturing, marketing, and other entities describing part or all of the implemented change to a single change order. A change notification can also provide information about the effectivity of the change order.

change order
Teamcenter object that references the problem, originating change requests, solutions, and related information. A change order contains sufficient information to incorporate the change.

classification
Process of categorizing objects according to similarity in characteristics. While the objects in one class share the same characteristics, the values of these characteristics may differ. For example, drill bits all share the length and diameter characteristics, but drill bit objects differ in length and diameter.

Classification
Teamcenter application that utilizes a classification hierarchy to categorize product data.

Classification Administration
Teamcenter application that enables a system administrator to define the groups, classes, subclasses, and views that form the Classification hierarchy.

ClearCase Integration
Teamcenter integration to the IBM Rational ClearCase software configuration management tool.

Command Suppression
Teamcenter application that enables the system administrator to control the display of menu and toolbar commands within Teamcenter applications. Command Suppression allows suppressing the display of commands for an entire group hierarchy or a specific role within the hierarchy, for entire groups of users, and for users who are assigned a role within a group. It also allows suppressing the display of specific commands on a designated menu or the display of entire menus.

component
- Objects used to build up an assembly or subassembly.
- Part in a product structure defined in Teamcenter. A component is the lowest level part in the product structure: it cannot be broken down into subparts.

D

data item
Teamcenter object representing bulk data defined and manipulated by application products, for example, papers that reside in a filing cabinet, directories and files that reside in a file system, Microsoft Excel spreadsheets, and CAD model and drawing
Appendix A  Glossary

files. Metadata for the data item resides in the Teamcenter database. See also bulk data and metadata.

dataset
Teamcenter workspace object used to manage data files created by other software applications. Each dataset can manage multiple operating system files, and each dataset references a dataset tool object and a dataset business object.

dataset tool
Teamcenter object that is the tool used to create or modify a dataset.

derived default
Default value that depends on a condition (for example, radio = stereo IF car type = GLX). Compare with fixed default.

design bill of materials
List of components and subassemblies used to define an assembly structure, and the representation of the assembly structure. Compare with manufacturing bill of materials.

DesignContext
Teamcenter application that enables users to quickly focus on a particular work part and any parts affected within the context of a change to that part. Users can select a product item and configure revisions of components, configure variants of the assembly, review the set of components, retrieve the components, and initialize their display in a CAD application or a visualization application.

E

effectivity
Identification of the valid use of an aspect of product data tracked by unit, date, or intent. You can specify a start definition, end definition, or both for a particular effectivity. There are three types of effectivities:

• Unit effectivity specifies the range of item units or serial numbers.

• Date effectivity specifies the range of dates. This is also known as an incorporation point.

• Intent effectivity specifies a purpose, target, or milestone, for example, Production, Prototype, or Carryover.

effectivity rule
Rule used to set effective dates on released products and processes with a released status.

Embedded Software Solutions
Optional extension to Structure Manager and My Teamcenter that allows you to manage embedded software binaries as part of the product structure.

dend item
Top-level node of an assembly that can represent a product or a factory structure.

dend item effectivity
Date or unit number suggesting when the released configuration is used for production of the specified end item.
**envelope**
Teamcenter workspace object that represents a mail message sent by a Teamcenter user. Envelopes can be used to send workspace object references as well as text messages.

**F**

**feature**
Physical or geometric object associated with a product, component, or part. Alternatively, a logical attribute of a product, component, or part. Examples: a weld point, a signal, or a geometric pattern. A feature may be represented by a generic design element (GDE) in a BOM. See also *generic design element*.

**fixed default**
Default value for an option (for example, engine = 1200). A fixed default is attached to an item revision but is global to the BOM loaded in a Structure Manager window. Compare with *derived default*.

**folder**
Graphical representation of an aggregation of objects, such as a group, class, or subclass. For easy distinction in the class hierarchy, each of these aggregations has a different type of folder icon associated with it: a group folder icon, a class folder icon, or a subclass folder icon.

**form**
Teamcenter workspace object used to display product information (properties) in a predefined template. Forms are often used to create an electronic facsimile of a hardcopy form in Teamcenter. See also *master form*.

**G**

**GDE**
See *generic design element*.

**generic design element**
BOM item that cannot have different revisions. See also *feature*.

**Global Services Foundation**
Web application that enables your enterprise to access information stored in virtually any type of electronic data source that manages your enterprise data.

Running on a standard commercial Web application server, the server components of Global Services Foundation enable communication among the data sources and between users and the data sources. All components of Global Services Foundation use standard Web technology: Extensible Markup Language (XML), Extensible Stylesheet Language (XSL), and the Java programming language. Users access Global Services Foundation from a commercial Web browser using the standard technologies of Web browsers, primarily support for HyperText Markup Language (HTML) forms and small Java applets.

**group (Organization)**
Organizational grouping of users at a site. Users can belong to multiple groups and must be assigned to a default group.
group preference
Teamcenter preference applying to an entire group.

imprecise assembly
Single-level assembly that has items as the components. The revision is determined by the revision rule settings. Compare with precise assembly.

incremental change
Engineering change that collects several individual changes to components or attachments in a structure, allowing them to be released simultaneously. An incremental change is released and effectivity is applied to it by attaching an appropriate release status.

item
Workspace object generally used to represent a product, part, or component. Items can contain other workspace objects including other items and object folders.

item relation
Description of an association between a Teamcenter item and a piece of information that describes or is related to the item.

item revision
Workspace object generally used to manage revisions to items.

item revision relation
Description of an association between a Teamcenter item revision and a piece of information that describes or is related to the item revision.

Lifecycle Visualization
Visualization components available in the rich client, the thin client, and as a stand-alone application. A scalable solution for the viewing and analysis of 2D and 3D product data, Lifecycle Visualization is available in a number of configurations to meet the requirements of different organizations.

List of Values (LOV)
Pick list of values accessed by end users from a menu at the end of a data field. LOVs ensure consistent data entries in the rich client.

LOV
See List of Values (LOV).

manufacturing bill of materials
Defines how the product is manufactured, rather than how it is designed. Compare with design bill of materials.

manufacturing process
Collection of manufacturing subprocesses, operations, and activities that make up a process plan. Processes can have both sequential and parallel ordering. They are associated with a product and a work area.
**Manufacturing Process Planner**
Teamcenter manufacturing process management application that enables a user to design a plan detailing how to manufacture a product.

**master form**
Teamcenter workspace object used to display product information (properties) in a predefined template. Master forms are used to display product information in a standardized format.

**Mechatronics**
Integration of mechanical engineering with electronics and intelligent computer control in the design and manufacture of products and processes.

**metadata**
Object description in the Teamcenter database.

**Multi-Site Collaboration**
Teamcenter capability that allows the exchange of data objects among several Teamcenter databases. Transfer of objects among databases is controlled by daemon processes running on designated servers. Objects are replicated by exporting them from their original database and importing them into the requesting database. Configuration of Multi-Site Collaboration is optional.

**Multi-Site Collaboration network**
Network of independent Teamcenter sites that are within the same enterprise and share data using Multi-Site Collaboration.

**Multi-Structure Manager**
Teamcenter application that enables users to view and manipulate data in a specific context.

**My Teamcenter**
In the Teamcenter rich client and thin client, application that is the main access point for managing product information. My Teamcenter provides the functionality for creating objects in the Teamcenter database, querying the database for objects, checking in and checking out objects, and managing tasks. Users can also open objects, automatically launching the related application.

Each user has a personal My Teamcenter window that displays product information as graphical objects. Although users share product information across the enterprise, they organize this information individually in personal workspaces.

**N**

**named reference**
File types that are managed by a dataset.Datasets are the only workspace objects that use named references.

**navigation pane**
Rich client framework component that displays buttons of the applications available for use in the rich client. Clicking the application button launches the application.
Appendix A  Glossary

O

object-based protection
Use of access control lists to create exceptions to rules-based protection on an object-by-object basis. Object access control lists are most useful for either granting wider access or limiting access to a specific object.

occurrence
Hierarchical structure relationship between the immediate parent assembly and its child component item or item revision in a precise assembly. Sometimes called relative occurrence.

Organization
Teamcenter application that enables a system administrator to create and manage critical Teamcenter files and database entries. It is the point of access for creating a company’s virtual organization and for performing system administration activities such as volume creation, maintenance, and site administration. Organization enables creation and management of person, user, role, and group definitions; definition of the hierarchical structure of the Teamcenter organization; management of data volumes; and establishment and maintenance of Teamcenter sites.

owner
User that owns an object, initially the user who created it. Ownership can be transferred from the owner to another user. An object owner usually has privileges that are not granted to other users (for example, the privilege to delete the object).

owning group
Group that owns an object, usually the group of the user creating the object. Because users commonly share data with other members of a group, additional privileges may be granted to the owning group (for example, the privilege to write to the object).

owning site
Multi-Site Collaboration site where the master object resides. The owning site is the only site where the object can be modified.

P

PLM XML
Siemens PLM Software format for facilitating product life cycle interoperability using XML. PLM XML is open and based on standard W3C XML schemas. Representing a variety of product data both explicitly and via references, PLM XML provides a lightweight, extensible, and flexible mechanism for transporting high-content product data over the Internet.

precise assembly
Single-level assembly that has item revisions as the components. The item revision is configured by a precise entry in a revision rule. Compare with imprecise assembly.

preference
Configuration variable stored in a Teamcenter database and read when a Teamcenter session is initiated. Preferences allow administrators and users to configure many aspects of a session, such as user logon names and the columns displayed by default in a properties table.
preference protection scope
Hierarchical range for which a Teamcenter preference can be set. The protection scope of a hierarchical preference can be site, group, role, or user.

product
Item or assembly (hierarchy of components and subassemblies) to be manufactured.

product structure
Hierarchy of assembly parts and component parts with a geometric relationship between them, for example, a bill of materials (BOM). Variant and revision rules define the generic BOM. This BOM can then be loaded to display the configured variant.

program
Basis for identifying a group of objects available to multiple organizations, such as program teams, development teams, suppliers, and customers for a particular piece of work.

Program application
Teamcenter application used to define programs and assign program team members, program team administrators, and privileged team members.

project
Basis for identifying a group of objects available to multiple organizations, such as project teams, development teams, suppliers, and customers for a particular piece of work.

Project
Teamcenter application used to define projects and assign project team members, project team administrators, and privileged team members.

propagation
Process of transferring characteristics of one object to another object.

Q

Query Builder
Teamcenter application that enables a system administrator to create and maintain customized searches for objects in the Teamcenter databases, both local and remote. Saved queries are subject to standard object protection and can be accessed by users through the search feature in My Teamcenter.

query form
Predefined query used in My Teamcenter to quickly search the database without building a custom query. Query forms limit search criteria to boxes displayed in the form. Accessing additional search capabilities requires building a custom query.

R

RDV
See Repeatable Digital Validation.

relative occurrence
See occurrence.
Appendix A  Glossary

Repeatable Digital Validation
Combination of software and processes that enables on-demand digital mockups for use throughout the product development lifecycle. Repeatable Digital Validation services are required for using QPL-based DesignContext.

revision rule
Parameter set by the user that determines which revision of an item is used to configure product context.

rich client
Java-based user interface to Teamcenter installed on user workstations. The rich client accesses Teamcenter databases using a remote or local server. Compare to thin client.

role
Function-oriented cluster of users that models skills and/or responsibilities. The same roles are typically found in many groups. In Access Manager, role is an accessor used to grant privileges to all users with the same skills and/or responsibilities regardless of project.

role in group
Specific role in a specific group. In Access Manager, role in group is an accessor used to grant privileges to all users with the same skills and/or responsibilities in the same group.

role preference
Teamcenter preference applying to an entire role.

rules-based protection
Conditions or rules that control who can or cannot access objects. These rules are global (that is, they affect the entire Teamcenter site) and are enforced by the Access Manager. These rules are defined by a system administrator.

rule tree
Access Manager component the system administrator uses to grant users access to Teamcenter objects. It is a tree of rules and access permissions that when processed determines the access that each user has to a specified object.

S

Security Services
Services that eliminate prompts for logon credentials when users switch Teamcenter products within a user session. Authentication is performed by an external identity service provider, such as lightweight directory access protocol (LDAP), instead of the Teamcenter product. At a site that deploys multiple Teamcenter products and Security Services, users log on once to access all participating Teamcenter products.

single sign-on
Mechanism that allows a user to log on once to multiple services. Following a single sign-on to Teamcenter, the user is connected to multiple services without logging on to each service.

site
Individual installation of Teamcenter comprising a single Teamcenter database, all users accessing that database, and additional resources such as hardware,
networking capabilities, and third-party software applications (tools) required to implement Teamcenter at that site.

**site preference**  
Teamcenter preference that applies to the entire site.

**STEP AP212**  
Standard for the Exchange of Product Model Data (STEP) for the Industrial Automation Systems and Integration – Product Data Representation and Exchange international standard (ISO 10303). This standard provides a framework through which industries can exchange and share product information within and between enterprises. AP212 is an application of this standard and describes the information necessary to customize electrotechnical products.

**structure**  
Representation of multiple objects and their interdependencies. For example, a classification structure represents classes and their inheritance dependencies, and an assembly structure represents how components and subassemblies are associated to build up an assembly. The structure can be viewed in several applications, including Structure Manager, Manufacturing Process Planner, Part Planner, Multi-Structure Manager, and Resource Manager.

In Resource Manager, most structures are hierarchical. For example, they acquire the form of a tree where each node can have only one parent but multiple siblings and children.

**Structure Manager**  
Teamcenter application that enables creation of generic product structures that can be configured to show the product structure that is in production, effective on a certain date, used by a particular customer, and so forth. Structure Manager enables creation and modification of a product structure and its associated occurrence data, display of a product structure in a multilevel indented format, and viewing graphics tightly coupled to the structure for easy identification of a component by location in the structure or in the embedded viewer.

**Subscription Manager**  
Tool used to find, delete, and modify active subscriptions.

**Subscription Monitor**  
Teamcenter application that enables a system administrator to query subscriptions created in the database, to monitor and delete subscription events and actions, and to generate statistical reports in either text or bar chart format regarding subscriptions, events, and actions.

**supersedure**  
Manually created relation that graphically displays deleted components and the components that replace them. A supersedure is always created in the context of a parent assembly. Therefore, a single component can be used in more than one supersedure if it is used in different parent assemblies. A supersedure can be created for changes of part number or of quantity, but not for changes in a part revision.

**system administrator**  
Teamcenter user who is a member of the system administration group.
Glossary

T

task (workflow)
Fundamental building block used to construct a process. Each task defines a set of actions, rules, and resources used to accomplish that task.

Teamcenter manufacturing process management
Teamcenter manufacturing process design and management system. Teamcenter manufacturing process management comprises several user applications, for example, Plant Designer, Manufacturing Process Planner, Part Planner, Report Generator, and Resource Manager.

thin client
Teamcenter user interface that provides a streamlined browser-based view of product information stored in a Teamcenter database. The thin client is configured in the Web tier, which creates and serves its Web pages to the client. Compare to rich client.

U

user
Definition that is the mechanism by which Teamcenter identifies and interacts with each user. User definitions contain a name (derived from the person definition), user ID, operating system name, and password.

user preference
Teamcenter preference applying to a specific user.

V

variant condition
• Rules applicable to one component in a product structure.
• Condition set on an occurrence to specify the option values required to configure that occurrence (for example, Load IF engine = 1200).

variant rule
Collection of option values used in determining the variant of the BOM to be configured (for example, car type = GLS, engine = 1200, gearbox = manual).

W

work context
Object containing user, group, role, and project requirements for a particular task. Work contexts streamline the definition of the correct user settings required to perform tasks. For example, a user typically assigned three types of tasks can create three work contexts reflecting the required group/role settings. Rather than logging out and logging back in with the required group/role settings, right-clicking a task displays the user’s defined work contexts. Selecting the appropriate work context automatically changes the user’s group/role settings. Work contexts can also define the current project, if project functionality is used at the site.
**workflow**
Automation of the concept that all work flows through one or more business processes to accomplish an objective. Using workflow, documents, information, and tasks are passed between participants during the completion of a particular process.

**Workflow Designer**
Teamcenter application that enables administrators to graphically design workflow process templates, incorporating company business practices and procedures into the templates. Teamcenter users initiate workflow processes using these templates.

**Workflow Viewer**
Teamcenter application that enables users to view the progress of a workflow process. Users are not required to be participating members of the process being viewed. Depending on preference settings, Workflow Viewer also allows ad hoc process modification. See also *ad hoc process modification*. 
Index

Numerics/Symbols
4G Designer ........................................... 2-6
4G Designer-MBOM Reconciliation .......... 2-6

A
Access control entry (ACE) ................. 4-30
Access control list (ACL) ................. 4-30
Access Manager ............................. 2-7
ACE (access control entry) ............ 4-30
ACL (access control list) .......... 4-30
ADA, see Authorized data access
ADA License ..................................... 2-7
Address lists ................................. 4-13, 4-48
  Adding members .......................... 4-48
  Deleting .................................... 4-48
  Removing members ..................... 4-48
Adhoc Design Context ....................... 2-27
Aerospace and Defense ...................... 3-17
Aliases ......................................... 4-13
Alternate identifiers ....................... 4-13
Appearance Configuration .................. 2-7
Application banner .......................... 2-3
Application interface objects .......... 4-44
Application pane ............................. 2-3
  Rich client .................................. 2-3
Applications
Adhoc Design Context ....................... 2-27
Classification ............................... 2-27
Configuring display of .................... 2-21
Design Context .............................. 2-27
Issue Manager .............................. 2-28
Manufacturing Process Planner .......... 2-27
My Teamcenter ............................... 2-27
Opening ....................................... 2-26
Schedule Manager ............................ 2-27
Structure Manager ............................ 2-27
Systems Engineering ....................... 2-27
As-Built Manager ............................ 2-7
Attributes ..................................... 2-31
Audience ....................................... 1-1
Authorized data access
  Intellectual property ..................... 4-29
  International traffic in arms regulation .......... 4-29

Automotive Edition ......................... 3-17

B
Back and forward buttons ................... 2-2
Basic concepts ................................ 3-1, 3-11
  Change management ...................... 3-1, 3-11
  Manufacturing process management .......... 3-4
Multi-Site Collaboration ................. 3-22
Product structure configuration .......... 3-3
Product visualization .................... 3-10
Repeatable Digital Validation .......... 3-12
Systems Engineering ....................... 3-2
Workflow ...................................... 3-4
BOM view revisions ......................... 4-13
BOM views ..................................... 4-13
Business Modeler IDE ....................... 2-31
  Attributes .................................. 2-31
  Business objects ........................... 2-31
  Classes .................................... 2-31
  Lists of values ............................ 2-31
  Options .................................... 2-31
  Rules ....................................... 2-31
  Business objects ........................... 2-31

C
CAE Manager ..................................... 2-8
CAE Manager (Legacy) ..................... 2-8
CAE Structure Designer ..................... 2-8
CAE Structure Editor, see CAE Manager (Legacy)
  Cancelling checkout requests ............. 4-27
  Change management ...................... 3-4
    Tasks .................................... 4-38
    Use case ................................ 4-38
  Change Manager ........................... 2-8
  Change Manager application .......... 4-38
  Change objects ............................ 4-13-4-14
  Check in an object ....................... 4-26
  Check out an object ...................... 4-24
  Check-Out and Edit button .............. 4-20
  Checkin and checkout, data .......... 4-22
  Checkout
Canceling ............................ 4-27
Defining checkout directory .......... 4-23
Differences between implicit and explicit .......................... 4-23
Explicit ................................. 4-22
Implicit ................................. 4-23
Owner .................................. 4-24
Transferring ............................ 4-27
Checkout history .......................... 4-28
Checkout status
  Notification list ........................ 4-28
  Providing notification of .............. 4-28
Classes .................................. 2-31
Classification ............................ 2-8, 2-27, 3-11, 4-38
Classification Administration .............. 2-9
Classification Guide ...................... 4-38
Classifying parts .......................... 3-11
Classifying parts and components .......... 4-38
Client for Office, Teamcenter interface .................................. 2-31
Clipboard button
  Description ................................ 2-4
Collaboration Context, see Multi-Structure Manager
  Collaboration contexts ...................... 4-14
Command Suppression .......................... 2-9
Component pane ............................. 2-25
Configure Applications button .......... 2-21
Configure Applications menu ............. 2-21
Configuring table panes ..................... 2-22
Configuring Teamcenter ...................... 1-2
Configuring view tables ...................... 2-22
Consumer Packaged Goods ................. 3-16
Content Management ...................... 2-9
Continue on error option .................. 4-41
Creating a Teamcenter shortcut .......... 1-4
Creating address lists .................... 4-48
Customizing
  Implicit checkout ....................... 4-24

D

Dashboard .................................. 2-9
  Reporting and Analytics .................. 4-46
Data
  Checkin and checkout .................... 4-22
  Data Exchange ........................... 3-20
Data objects ................................ 4-10
  Address list ................................ 4-10
Alias ...................................... 4-13
Alternate identifiers ....................... 4-13
BOM view .................................. 4-13
BOM view revision .......................... 4-13
BOM views .................................. 4-13
Change ..................................... 4-14
Collaboration context ...................... 4-14
Dataset .................................... 4-11
Dataset relations .......................... 4-12
Design element ............................. 4-13
Envelope ................................... 4-13
Folder ...................................... 4-11
Forms ....................................... 4-12
Item ......................................... 4-11
Item revision ................................ 4-11
Master form ................................ 4-12
Partition .................................... 4-14
Relation properties ........................ 4-11
Relations .................................... 4-11
Structure context .......................... 4-14
Subset ...................................... 4-13
Workset ..................................... 4-13
Data pane .................................... 2-26
Data sharing ................................ 3-22
Database Utilities .......................... 2-10
Defining
  Checkout directory ....................... 4-23
Deleting address lists ..................... 4-48
Deleting objects ........................... 4-17
Design Context ............................. 2-27
DesignContext .............................. 2-10
Differences between implicit and explicit checkout ...................... 4-23
Dimensional Planning and Validation .......... 3-19
Document management
  Document behavior ....................... 3-5
DPV Measurements .......................... 2-9
Drag and drop data ......................... 4-18
E

ECAD design integration ...................... 3-19
Electronic Design Automation .............. 3-19
Enabling Teamcenter ........................ 1-2
Envelopes ................................... 4-13
Explicit checkout .......................... 4-22
Explore dialog box ......................... 4-25–4-26
Explore Selected Components option ........ 4-25–4-26
Export and import data ..................... 3-20
Export files on checkout .................... 4-23
Exporting
  STEP format ................................ 4-43
  Teamcenter objects ......................... 4-43
Exporting data
  Application interface mode ................ 4-44
  PLM XML format ........................... 4-44
### Index

<table>
<thead>
<tr>
<th>F</th>
<th>Factory Structure Editor, see Plant Designer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favorites</td>
<td>2-21</td>
</tr>
<tr>
<td>Rich client</td>
<td>2-21, 4-19</td>
</tr>
<tr>
<td>Thin client</td>
<td>2-30, 4-19</td>
</tr>
<tr>
<td>Feedback toolbar for help</td>
<td>4-6</td>
</tr>
<tr>
<td>Folder</td>
<td></td>
</tr>
<tr>
<td>Home, Newstuff and Mailbox folders</td>
<td>4-14</td>
</tr>
<tr>
<td>Working with</td>
<td>4-14</td>
</tr>
<tr>
<td>Forms</td>
<td>4-12</td>
</tr>
<tr>
<td>G</td>
<td>Generate import report option</td>
</tr>
<tr>
<td>Getting Started</td>
<td>2-10</td>
</tr>
<tr>
<td>Getting Started button</td>
<td></td>
</tr>
<tr>
<td>Rich client</td>
<td>2-3</td>
</tr>
<tr>
<td>Getting Started with Manufacturing</td>
<td>4-35</td>
</tr>
<tr>
<td>Getting Started with Mechatronics Process Management</td>
<td></td>
</tr>
<tr>
<td>Getting Started with Product Structure</td>
<td>4-34</td>
</tr>
<tr>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>Rich client logon</td>
<td>1-4</td>
</tr>
<tr>
<td>H</td>
<td>Help</td>
</tr>
<tr>
<td>Current application</td>
<td>4-4</td>
</tr>
<tr>
<td>PDF collection</td>
<td>4-6</td>
</tr>
<tr>
<td>Rich client</td>
<td>4-3</td>
</tr>
<tr>
<td>Thin client</td>
<td>4-3</td>
</tr>
<tr>
<td>Help collection</td>
<td></td>
</tr>
<tr>
<td>Feedback toolbar</td>
<td>4-6</td>
</tr>
<tr>
<td>Navigating</td>
<td>4-4</td>
</tr>
<tr>
<td>Navigation toolbar</td>
<td>4-5</td>
</tr>
<tr>
<td>Search toolbar</td>
<td>4-6</td>
</tr>
<tr>
<td>Help, viewing</td>
<td>4-1</td>
</tr>
<tr>
<td>History links</td>
<td>2-21</td>
</tr>
<tr>
<td>Home folder</td>
<td>4-15</td>
</tr>
<tr>
<td>HTML online help</td>
<td>4-2</td>
</tr>
<tr>
<td>I</td>
<td>I Want To links</td>
</tr>
<tr>
<td>Rich client</td>
<td>2-21</td>
</tr>
<tr>
<td>Implicit checkout</td>
<td>4-23</td>
</tr>
<tr>
<td>Customizing</td>
<td>4-24</td>
</tr>
<tr>
<td>Importing</td>
<td></td>
</tr>
<tr>
<td>Continue on error option</td>
<td>4-41</td>
</tr>
<tr>
<td>Generate import report option</td>
<td>4-41</td>
</tr>
<tr>
<td>Objects</td>
<td>4-41</td>
</tr>
<tr>
<td>PLM XML files</td>
<td>4-42</td>
</tr>
<tr>
<td>Preview import report option</td>
<td>4-41</td>
</tr>
<tr>
<td>STEP files</td>
<td>4-41</td>
</tr>
<tr>
<td>Industry solutions</td>
<td>3-16</td>
</tr>
<tr>
<td>Aerospace and Defense</td>
<td>3-17</td>
</tr>
<tr>
<td>Automotive Edition</td>
<td>3-17</td>
</tr>
<tr>
<td>Consumer Packaged Goods</td>
<td>3-16</td>
</tr>
<tr>
<td>Interfaces</td>
<td>2-1</td>
</tr>
<tr>
<td>Business Modeler IDE</td>
<td>2-31</td>
</tr>
<tr>
<td>Client for Office</td>
<td>2-31</td>
</tr>
<tr>
<td>Rich client</td>
<td>2-2</td>
</tr>
<tr>
<td>Thin client</td>
<td>2-25</td>
</tr>
<tr>
<td>Introduction to the rich client</td>
<td>2-1</td>
</tr>
<tr>
<td>iPad</td>
<td></td>
</tr>
<tr>
<td>iBooks mobile application</td>
<td>4-7</td>
</tr>
<tr>
<td>Viewing Teamcenter PDF documentation</td>
<td>4-7</td>
</tr>
<tr>
<td>Issue Manager</td>
<td>2-10, 2-28</td>
</tr>
<tr>
<td>ITAR, see Authorized data access</td>
<td></td>
</tr>
<tr>
<td>Item relations</td>
<td>4-11</td>
</tr>
<tr>
<td>Item revision relations</td>
<td>4-11</td>
</tr>
<tr>
<td>Item revisions</td>
<td>4-11</td>
</tr>
<tr>
<td>Items</td>
<td>4-11</td>
</tr>
<tr>
<td>L</td>
<td>Launch Pad</td>
</tr>
<tr>
<td>Layout</td>
<td></td>
</tr>
<tr>
<td>Saving</td>
<td>2-19</td>
</tr>
<tr>
<td>Lifecycle Viewer</td>
<td>2-11</td>
</tr>
<tr>
<td>Lists of values</td>
<td>2-31</td>
</tr>
<tr>
<td>Logon, Rich client</td>
<td>1-4</td>
</tr>
<tr>
<td>LogonTeamcenter</td>
<td>1-2</td>
</tr>
<tr>
<td>M</td>
<td>Mail</td>
</tr>
<tr>
<td>Address lists</td>
<td></td>
</tr>
<tr>
<td>Adding members</td>
<td>4-48</td>
</tr>
<tr>
<td>Removing members</td>
<td>4-48</td>
</tr>
<tr>
<td>Creating address lists</td>
<td>4-48</td>
</tr>
<tr>
<td>Modifying address lists</td>
<td>4-48</td>
</tr>
<tr>
<td>Sending</td>
<td>4-47</td>
</tr>
<tr>
<td>Using address lists</td>
<td>4-48</td>
</tr>
<tr>
<td>Mailbox</td>
<td></td>
</tr>
<tr>
<td>folder</td>
<td>4-15</td>
</tr>
<tr>
<td>Managing changes</td>
<td>4-38</td>
</tr>
<tr>
<td>Managing manufacturing data</td>
<td>4-35</td>
</tr>
<tr>
<td>Managing mechatronics data</td>
<td>4-35</td>
</tr>
<tr>
<td>Managing product structures</td>
<td>4-33</td>
</tr>
<tr>
<td>Revision rules</td>
<td>4-33</td>
</tr>
<tr>
<td>Tasks</td>
<td>4-34</td>
</tr>
<tr>
<td>Use case</td>
<td>4-33</td>
</tr>
<tr>
<td>Manufacturing process management</td>
<td>3-4</td>
</tr>
<tr>
<td>Manufacturing Process Planner</td>
<td>2-12, 2-27</td>
</tr>
<tr>
<td>Manufacturing Structure Editor, see Manufacturing Process Planner</td>
<td></td>
</tr>
</tbody>
</table>
Manufacturing tasks ........................... 4-35
Master forms ................................. 4-12
Materials Management ...................... 3-18
Menu bar ................................. 2-2, 2-25
  Rich client .............................. 2-2
  Thin client .............................. 2-25
Moving data .............................. 4-17–4-18
Multi-Site Collaboration ................. 3-22
Multi-Structure Manager ................. 2-12
My Teamcenter ......................... 2-12, 2-27
  Open .................................. 2-18
  Purpose ................................ 2-1

N
Navigation pane ......................... 2-3, 2-25
  Rich client .............................. 2-3
Navigation toolbar for help .............. 4-5
Newstuff folder ......................... 4-15

O
Object
  Check in ................................ 4-26
  Check out ................................ 4-24
Object-based protection .................. 4-30
Objects
  Deleting .................................. 4-17
  Importing ................................ 4-41
  Moving .................................. 4-17
Online help .................................. 4-2
  Installing ................................ 4-1
Open
  My Teamcenter .......................... 2-18
Open items ......................... 2-21
Options .................................. 2-31
Organization .............................. 2-13
Owner
  Checkout ................................ 4-24

P
Part Planner .............................. 2-13
Password
  Rich client logon ....................... 1-4
PDF online help .......................... 4-2
Perspectives
  4G Designer .......................... 2-6
  4G Designer-MBOM Reconciliation .. 2-6
  Access Manager ....................... 2-7
  ADA License .......................... 2-7
  Appearance Configuration .......... 2-7
  As-Built Manager ..................... 2-7
  CAE Manager .......................... 2-8
  CAE Manager (Legacy) ............... 2-8
  CAE Structure Designer ............. 2-8
  Change Manager ...................... 2-8
  Classification ........................ 2-8
  Classification Administration ...... 2-9
  Closing ................................ 2-19
  Command Suppression ............... 2-9
  Content Management ................. 2-9
  Dashboard ............................. 2-9
  Database Utilities .................... 2-10
  DesignContext ........................ 2-10
  DPV Measurements .................... 2-9
  Getting Started ...................... 2-10
  In general ............................ 2-5
  Issue Manager ......................... 2-10
  Launch Pad ............................ 2-10
  Lifecycle Viewer ...................... 2-11
  Manufacturing Process Planner .... 2-12
  Multi-Structure Manager .......... 2-12
  My Teamcenter ......................... 2-12
  Opening ................................ 2-18
  Organization .......................... 2-13
  Part Planner .......................... 2-13
  Plant Designer ......................... 2-13
  Platform Designer .................... 2-13
  PLM XML/TC XML Export Import
    Administration ....................... 2-13
  Product Configurator ................. 2-13
  Project ................................ 2-14
  Query Builder ........................ 2-14
  Registry Editor ....................... 2-14
  Relation Browser ..................... 2-14
  Report Builder ......................... 2-14
  Report Generator ..................... 2-14
  Requirements Manager ............... 2-15
  Reset .................................. 2-19
  Resource Manager ..................... 2-15
  Saving .................................. 2-19
  Schedule Manager ..................... 2-15
  Service Manager ....................... 2-15
  Service Planner ....................... 2-15
  Service Request Manager ............ 2-15
  Service Scheduler ..................... 2-16
  Setup Wizard .......................... 2-16
  Software Parameter Manager ......... 2-16
  Specification Manager ............... 2-16
  Structure Manager .................... 2-16
  Subscription Monitor ................ 2-17
  Switch between open perspectives .. 2-19
  Systems Engineering .................. 2-17
  Validation Manager ................... 2-17
  Volume Management .................... 2-17
  Web Browser ........................... 2-18
  Workflow Designer .................... 2-18
<table>
<thead>
<tr>
<th>Workflow Viewer</th>
<th>2-18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plant Designer</td>
<td>2-13</td>
</tr>
<tr>
<td>Platform Designer</td>
<td>2-13</td>
</tr>
<tr>
<td>PLM XML export and import</td>
<td>3-22</td>
</tr>
<tr>
<td>PLM XML file import</td>
<td>4-42</td>
</tr>
<tr>
<td>PLM XML/TC XML Export Import Administration</td>
<td>2-13</td>
</tr>
<tr>
<td>Preferences</td>
<td>1-6</td>
</tr>
<tr>
<td>TC_Auto_Checkout</td>
<td>4-24</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>1-2</td>
</tr>
<tr>
<td>Prerequisites for Teamcenter</td>
<td>1-2</td>
</tr>
<tr>
<td>Preview import report option</td>
<td>4-41</td>
</tr>
<tr>
<td>Primary application buttons</td>
<td>2-3, 2-21</td>
</tr>
<tr>
<td>Rich client</td>
<td>2-3</td>
</tr>
<tr>
<td>Primary perspective buttons</td>
<td>2-21</td>
</tr>
<tr>
<td>Product Configurator</td>
<td>2-13</td>
</tr>
<tr>
<td>Product structure configuration</td>
<td>3-3</td>
</tr>
<tr>
<td>Product Structure Editor, see Structure Manager</td>
<td></td>
</tr>
<tr>
<td>Product visualization</td>
<td>3-10</td>
</tr>
<tr>
<td>Project</td>
<td>2-14, 4-20</td>
</tr>
<tr>
<td>Properties dialog box</td>
<td>4-20</td>
</tr>
<tr>
<td>Properties on Relation dialog box</td>
<td>4-21</td>
</tr>
</tbody>
</table>

**Q**

<table>
<thead>
<tr>
<th>Query Builder</th>
<th>2-14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick links</td>
<td>2-21</td>
</tr>
<tr>
<td>Rich client</td>
<td>2-21</td>
</tr>
<tr>
<td>Quick Open search</td>
<td>2-21</td>
</tr>
<tr>
<td>Rich client</td>
<td>2-21</td>
</tr>
<tr>
<td>Quick search</td>
<td>2-23</td>
</tr>
<tr>
<td>Rich client</td>
<td>2-3</td>
</tr>
</tbody>
</table>

**R**

<table>
<thead>
<tr>
<th>RDV</th>
<th>4-34</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registry Editor</td>
<td>2-14</td>
</tr>
<tr>
<td>Relation Browser</td>
<td>2-14</td>
</tr>
<tr>
<td>Relations</td>
<td>4-11</td>
</tr>
<tr>
<td>Item</td>
<td>4-11</td>
</tr>
<tr>
<td>Item revision</td>
<td>4-11</td>
</tr>
<tr>
<td>Repeatable Digital Validation</td>
<td>3-12, 4-34</td>
</tr>
<tr>
<td>Tasks</td>
<td>4-35</td>
</tr>
<tr>
<td>Use case</td>
<td>4-34</td>
</tr>
<tr>
<td>Report Builder</td>
<td>2-14, 4-45</td>
</tr>
<tr>
<td>Report Builder Guide</td>
<td>4-46</td>
</tr>
<tr>
<td>Report Generator</td>
<td>2-14</td>
</tr>
<tr>
<td>Reporting and Analytics</td>
<td></td>
</tr>
<tr>
<td>Dashboard</td>
<td>4-46</td>
</tr>
<tr>
<td>Reports</td>
<td>4-45</td>
</tr>
<tr>
<td>Requirements Manager</td>
<td>2-15</td>
</tr>
<tr>
<td>Resource Manager</td>
<td>2-15</td>
</tr>
<tr>
<td>Revision rules</td>
<td>4-33</td>
</tr>
<tr>
<td>Rich client</td>
<td></td>
</tr>
<tr>
<td>Application banner</td>
<td>2-3</td>
</tr>
<tr>
<td>Application pane</td>
<td>2-3</td>
</tr>
<tr>
<td>Back and forward buttons</td>
<td>2-2</td>
</tr>
<tr>
<td>Clipboard button</td>
<td>2-4</td>
</tr>
<tr>
<td>Configure Applications button</td>
<td>2-21</td>
</tr>
<tr>
<td>Favorites</td>
<td>2-21, 4-19</td>
</tr>
<tr>
<td>Getting Started button</td>
<td>2-3</td>
</tr>
<tr>
<td>History links</td>
<td>2-21</td>
</tr>
<tr>
<td>I Want To links</td>
<td>2-21</td>
</tr>
<tr>
<td>Menu bar</td>
<td>2-2</td>
</tr>
<tr>
<td>Navigation pane</td>
<td>2-3</td>
</tr>
<tr>
<td>Open items</td>
<td>2-21</td>
</tr>
<tr>
<td>Primary application buttons</td>
<td>2-3, 2-21</td>
</tr>
<tr>
<td>Purpose</td>
<td>2-1</td>
</tr>
<tr>
<td>Quick links</td>
<td>2-21</td>
</tr>
<tr>
<td>Quick Open search</td>
<td>2-21</td>
</tr>
<tr>
<td>Search field</td>
<td>2-3</td>
</tr>
<tr>
<td>Secondary application buttons</td>
<td>2-3, 2-21</td>
</tr>
<tr>
<td>Server condition symbol</td>
<td>2-5</td>
</tr>
<tr>
<td>Starting</td>
<td>1-4</td>
</tr>
<tr>
<td>Teamcenter logon</td>
<td>1-4</td>
</tr>
<tr>
<td>Toolbar</td>
<td>2-2</td>
</tr>
<tr>
<td>User interface condition symbol</td>
<td>2-5</td>
</tr>
<tr>
<td>Rich client interface</td>
<td>2-2</td>
</tr>
<tr>
<td>Rich client perspectives</td>
<td></td>
</tr>
<tr>
<td>Closing</td>
<td>2-19</td>
</tr>
<tr>
<td>Opening</td>
<td>2-18</td>
</tr>
<tr>
<td>Reset</td>
<td>2-19</td>
</tr>
<tr>
<td>Saving</td>
<td>2-19</td>
</tr>
<tr>
<td>Rich client perspectives and views</td>
<td>2-5</td>
</tr>
<tr>
<td>Role</td>
<td></td>
</tr>
<tr>
<td>Rich client logon</td>
<td>1-4</td>
</tr>
<tr>
<td>Rules</td>
<td>2-31</td>
</tr>
<tr>
<td>Definition</td>
<td>4-29</td>
</tr>
<tr>
<td>Rules-based protection</td>
<td>4-29</td>
</tr>
</tbody>
</table>

**S**

<table>
<thead>
<tr>
<th>Schedule Manager</th>
<th>2-15, 2-27</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>4-15</td>
</tr>
<tr>
<td>PDF collection</td>
<td>4-6</td>
</tr>
<tr>
<td>Search field</td>
<td>2-3</td>
</tr>
<tr>
<td>Search toolbar for help</td>
<td>4-6</td>
</tr>
<tr>
<td>Secondary application buttons</td>
<td>2-3, 2-21</td>
</tr>
<tr>
<td>Selecting related components</td>
<td>4-25-4-26</td>
</tr>
<tr>
<td>Server</td>
<td></td>
</tr>
<tr>
<td>Rich client logon</td>
<td>1-4</td>
</tr>
<tr>
<td>Server condition symbol</td>
<td>2-5</td>
</tr>
<tr>
<td>Service Manager</td>
<td>2-15</td>
</tr>
<tr>
<td>Service Planner</td>
<td>2-15</td>
</tr>
<tr>
<td>Service Request Manager</td>
<td>2-15</td>
</tr>
<tr>
<td>Service Scheduler</td>
<td>2-16</td>
</tr>
</tbody>
</table>
### Sessions, perspectives, and applications
- Setup Wizard .......................... 2-16
- Smart navigator ........................ 4-20
- Software Parameter Manager ............ 2-16
- Specification Manager .................. 2-16
- Starting rich client sessions ............. 1-4
- Starting Teamcenter ..................... 1-2
- Starting thin client sessions ............. 1-5
- STEP files, importing .................... 4-31
- Structure contexts ...................... 4-14
- Structure Manager ...................... 2-16, 2-27, 4-33
- StructureMap Builder, see CAE Structure
  Designer
- Subscription Monitor .................. 2-17
- Substance Compliance .................. 3-18
- Synchronizing data ..................... 3-20
- Systems Engineering .................... 2-17, 2-27, 3-2

### T
- Table panes ............................ Table
  Configuring .......................... 2-22
- Tables ................................. Configuring data display .......... 2-22
- Tasks ................................. Change management ................. 4-38
  Classification ......................... 4-38
  Product structure management .......... 4-34
  Repeatable Digital Validation .......... 4-35
  Workflow .............................. 4-39
- TC_Auto_Checkout preference .......... 4-24
- Teamcenter ............................ Logon .............................. 1-2
  Online help ............................ 4-1
  PDF documentation ..................... 4-6
- Teamcenter EDA ........................ ECAD design integration ........ 3-19
  ECAD part library integration .......... 3-19
  Integrations .......................... 3-19
- Teamcenter help ........................ 4-2
- Teamcenter interfaces .................. 2-1
  Rich client ........................... 2-2
  Thin client ............................ 2-25
- Teamcenter lifecycle visualization .... 4-36
- Teamcenter mechatronics process
  management ............................ 4-35
- Teamcenter overview ................... 3-1
- Teamcenter prerequisites ................. 1-2
- Teamcenter sessions .................... 1-2
  Starting rich client .................... 1-4

### Starting thin client ................... 1-5
- Thin client ............................. 1-5
  - Component pane ....................... 2-25
  - Data pane ............................ 2-25
  - Favorites ........................... 2-25, 4-19
  - Menu bar ............................. 2-25
  - Navigation pane ...................... 2-25
  - Opening ............................. 2-25
  - Toolbar ............................. 2-25
  - Thin client interface ................. 2-25
  - Thin Client window ................... 2-25
  - Toolbar ............................. 2-22, 2-25
  - Toolbar, customizing ................. 2-22
  - Transferring checkout ................ 4-27

### U
- Use cases ............................. 4-38
  - Change management ................... 4-38
  - Product structure management ........ 4-33
  - Repeatable Digital Validation ........ 4-34
- User ID ............................... 1-4
  - Rich client logon .................... 1-4
  - User interface condition symbol ..... 2-5
  - User interface elements .............. 2-24

### V
- Validation Manager .................... 2-17
- View tables ............................ 2-22
- Viewing ............................... 2-22
  - Checkout history ...................... 4-28
  - Viewing Teamcenter PDF documentation on
    the iPad ............................ 4-7
  - Visualization tasks .................... 4-36
  - Visualizing product data .............. 4-36
  - Volume Management ................... 2-17

### W
- Web Browser ........................... 2-18
- Workflow ............................... 4-39
  - Tasks ................................. 4-39
  - Using address lists ................... 4-48
- Workflow Designer ..................... 2-18
- Workflow templates ..................... 4-40
  - Exporting ............................ 4-40
  - Importing ............................ 4-40
  - Workflow Viewer ...................... 2-18